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License Agreement
"Valued Technology"

This License Agreement is your proof of license. Please treat it as valuable property.This is a legal
agreement between you (either an individual or entity) the end-user of this product, and
Automation Direct. If you do not agree to the terms of this Agreement, promptly return the
package and any accompanying items to Automation Direct for a full refund.

LookoutDirect SOFTWARE LICENSE

1. GRANT OF LICENSE - This LookoutDirect License Agreement ("License") permits you to
use one copy of the specified version of the LookoutDirect software product ("Software") on
any single computer, provided the Software is in use on only one computer at any time. If you
have multiple Licenses for the Software, then at any time you may have as many copies of the
Software in use as you have Licenses. The Software is deemed "in use" on a computer when it
is loaded into the temporary memory (i.e. RAM) or installed into the permanent memory (i.e.
hard disk, CD--ROM or other storage device) of that computer, except that a copy may be
installed on a network server for the sole purpose of distribution to other computers that are not
currently "in use". If the anticipated number of Software users will exceed the number of
applicable Licenses, then you must have a reasonable mechanismor process in place to assure
that the number of persons using the Software concurrently does not exceed the number of
Licenses. If the Software is permanently installed on the hard disk or other storage device of a
computer (other than a network server) and oneperson uses that computer more than80%of the
timeit is in use, then that person may also use the software on a single portable computer or a
single computer at home.
2. COPYRIGHT -The Software is owned by Automation Direct or its suppliers and is
protected by United States copyright laws and international treaty provisions. Therefore, you
must treat the Software like any other copyrighted material (e.g., a book or musical recording)
except that you may:
a. Make one backup copy of the Software solely for backup or archival purposes.

b. Transfer the Software to a single hard disk provided you keep the original and the backup
solely for archival purposes. You may not copy any written materials that may accompany the
Software.
3. OTHER RESTRICTIONS-This LookoutDirect License Agreement is your proof of license
toexercise therights grantedherein andmust beretained by you. You may not rent or lease the
Software, but you may transfer your rights under this LookoutDirect License Agreement on a
permanent basis provided that you transfer this License Agreement, the Software, and all
accompanying written materials and retain no copies. The recipient must also agree to
unequivocally abide by the terms contained in this License Agreement. You may not reverse
engineer, decompile, or disassemble the Software. Any transfer of the Software must include the
most recent update and all prior versions. If the Software is acquired within the United States,
you may not export the Software outside of the United States without first complying with all
applicable USexport laws and regulations. You acknowledge that the Software will not function
without a certain hardware key. This hardware key will be furnished to you by Automation
Direct and you agree that such hardware key is to be used solely with the Software provided.
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DISTRIBUTION LIMITATIONS

If you have acquired the development/runtime package, you may distribute process files created
with the Software, provided that: 

1. each recipient of your process file has a valid license for a separate runtime copy of the
Software;

2. you include the following copyright notice, either on--screen in your process file's About Box
or written documentation, with each distributed copy of your

3. process file: "Copyright E [year] Automation Direct by Koyo, Inc. (Based on materials of
National Instruments Corporation). All Rights Reserved";

4. you do not use Automation Direct's or National Instruments' ("NI") names, logos, or
trademarks to market your process file without written permission; and

5. you agree to indemnify, hold harmless, and defend Automation Direct and NI (including
their officers, directors, employees, and agents) and their suppliers fromand against any claims.

LIMITED WARRANTY

1. Automation Direct warrants the Software will perform substantially in accordance with the
written materials for a period of ninety (90) days from the date of receipt.

2. Automation Direct warrants that any hardware accompanying the Software will be free
fromdefects in materials and workmanshipunder normal use andservice for a period of one (1)
year from the date of receipt.

NO OTHER WARRANTIES. EXCEPT AS EXPRESSLY SET FORTH ABOVE, THE
SOFTWARE IS PROVIDED"AS IS" WITHOUT WARRANTYOF ANY KIND, AND NO
OTHER WARRANTIES, EITHER EXPRESSED OR IMPLIED ARE MADE WITH
RESPECT TO THE SOFTWARE, INCLUDING BUT NOT LIMITED TO ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, TITLE OR NON--INFRINGEMENT, OR ANY OTHER

WARRANTIES THAT MAY ARISE FROM USAGE OR TRADE OR COURSE OF
DEALING. Automation Direct AND ITS SUPPLIERS DO NOT WARRANT,
GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OF OR
THE RESULTS OF THE USE OF THE SOFTWARE IN TERMS OF CORRECTNESS,
ACCURACY, RELIABILITY, OR OTHERWISE AND DO NOT WARRANT THAT THE
OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE.
Automation Direct AND ITS SUPPLIERS EXPRESSLY DISCLAIM ANY WARRANTIES
NOT STATED HEREIN.

Customer Remedies -Automation Direct's entire liability and your exclusive remedy shall be at
Automation Direct's option. Automation Direct will either refund the price paid, or repair or
replace the Software or hardware that does not meet Automation Direct's Limited Warranty.
You must return the product to Automation Direct with a copy of your purchase receipt. This
Limited Warranty is void if failure of the Software or hardware has resulted from accident,
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abuse, or misapplication. Any replacement Software will be warranted for the remainder of the
original warranty period or thirty (30) days, whichever is longer.
No Other Warranties - Automation Direct DISCLAIMS ALL OTHER WARRANTIES,
EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE, WITH RESPECT TO THE SOFTWARE, AND ANY ACCOMPANYING
WRITTEN MATERIALS OR HARDWARE. THIS LIMITED WARRANTY GIVES YOU
SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS, WHICH VARY FROM STATE
TO STATE.
No Liability for Consequential Damages - In no event shall Automation Direct or its suppliers
be liable for any damages whatsoever (including, without limitation, damages for loss of
business profits, business interruption, loss of business information, or other pecuniary loss)
arising out of the use of or inability to use this Automation Direct product, even if Automation
Direct or its suppliers have been advised of possibility of such damages.

U.S. GOVERNMENT RESTRICTED RIGHTS

The Software and documentation are provided with RESTRICTED RIGHTS. Use,
duplication, or disclosure by the Government is subject to restrictions as set forth in
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at
DFARS 252.227--7013 or subparagraphs (c) (1) (2) of the Commercial Computer Software --
Restricted Rights at 48 CFR  52.227--19 as applicable. Contractor/manufacturer is Automation
Direct by Koyo, Inc. / 3505 Hutchinson Road, Cumming, GA 30040 (under license from
National Instruments Corporation, 11500 N. Mopac Expressway, Austin, Texas 78759--3504).

This agreement is governed by the laws of the State of Georgia.

WARNING

(1) THE SOFTWARE IS NOT DESIGNED WITH COMPONENTS AND TESTING
FOR A LEVEL OF RELIABILITY SUITABLE FOR USE IN OR INCONNECTION
WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN ANY LIFE
SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE
EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.
(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF
OPERATION OF THE SOFTWARE CAN BE IMPAIRED BY ADVERSE FACTORS,
INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER
SUPPLY, COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING
SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS ANDDEVELOPMENT
SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS,
SOFTWARE AND HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS
OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES,
TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR
SOFTWARE), UNANTICIPATED USES OR MISUSES, OR ERRORS ON THE PART
OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS
THESE ARE HEREAFTER COLLECTIVELY TERMED "SYSTEM FAILURES"). ANY
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APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF HARM
TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND
DEATH) SHOULD NOT BE RELIANT SOLELY UPON ONE FORM OF
ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST
TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES,
INCLUDING BUT NOT LIMITED TO BACK--UP OR SHUT DOWN MECHANISMS.
BECAUSE EACH END--USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM
UTILIZED TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION
DESIGNER MAY USE THE SOFTWARE IN COMBINATION WITH OTHER
PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY
PLCDIRECT OR ITS SUPPLIERS, THE USER OR APPLICATION DESIGNER IS
ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE
SUITABILITY OF THE SOFTWARE WHENEVER THE SOFTWARE IS
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT
LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF
SUCH SYSTEM OR APPLICATION.

Lookout is a registered trademark of National Instruments Corporation.
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Acuerdo de Licencia (Traducción orientativa: Legalmente vale el original en inglés)

Este acuerdo de licencia es la prueba de su licencia. Trátelo por favor como propiedad. Este es un acuerdo
legal entre usted (un individuo o entidad) el usuario final de este producto, y AUTOMATIONDIRECT. Si
usted no acepta las condiciones de este acuerdo, devuelva el paquete y cualquier artículo de
acompañamiento a AUTOMATIONDIRECT para un reembolso completo.

LICENCIA del SOFTWARE de LookoutDirect 
1.CONCESIÓN DE LA LICENCIA - este acuerdo de licencia de LookoutDirect ("licencia") permite que
usted use una copia de la versión especificada del producto de software LookoutDirect ("software") en una
computadora solamente, de tal forma que el software esté en uso solamente una computadora en cualquier
momento. Si usted tiene múltiples licencias para el software, en cualquier momento usted puede usar
tantas copias de software pues ya tiene las licencias. El software se considera "en uso" en una computadora
cuando se carga en la memoria temporal (es decir RAM) o está instalado en la memoria permanente (es
decir el disco duro, el CD- ROM u otro aparato de almacenaje) de esa computadora, excepto una copia
que se puede instalar en un servidor de red para  único propósito de distribución a otras computadoras que
no estén actualmente "en uso". Si el número anticipado de usuarios del software excede el número de
licencias aplicables, usted debe tener un proceso razonable para asegurarse que el número de personas que
usan el software no excede correspondientemente el número de licencias. Si el software está instalado
permanentemente en el disco duro u otro aparato de almacenaje de una computadora (con excepción de
un servidor de red) y una persona usa la computadora más del 80%  del tiempo que está en uso, entonces
esa persona puede también utilizar el software en una sola computadora portátil o una sola computadora
en su casa.

2.PROPIEDAD INTELECTUAL - El software perteece a AUTOMATIONDIRECT o sus proveedores y es
protegido por leyes de derechos de copia de Estados Unidos y provisiones de tratados internacionales. Por
lo tanto, usted debe tratar el software como cualquier otro material con derechos de copia (e.g., un libro o
una grabación musical) excepto que puede :
a. Hacer una copia de reserva del software solamente para propósitos de respaldo o archivo.
b. Transferir el software a un solo disco duro dado que mantenga el original y el respaldo solamente para
los propósitos de archivo. Usted no puede copiar ningun material escrito que acompañe el software.

3. OTRAS RESTRICCIONES- Este acuerdo de licencia de LookoutDirect es su prueba de los derechos
para ejecutar la licencia que es garantizada y retenida por usted. Usted no puede alquilar o arrendar el
software, pero usted puede transferir sus derechos según las condiciones de este acuerdo de licencia de
LookoutDirect en base permanente a condición de que usted transfiera este acuerdo de licencia, el software,
y todos los materiales escritos de acompañamiento y no conserve ninguna copia. El recipiente debe
también concordar de seguir inequívocamente las condiciones contenidas en este acuerdo de licencia.
Usted no puede hacer ingeniería inversa, decompilar, o desmontar el software. Cualquier transferencia del
software debe incluir la actualización más reciente y todas las versiones anteriores. Si el software se adquiere
dentro de los Estados Unidos, usted no puede exportar el software fuera de los Estados Unidos sin estar de
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acuerdo con todas las leyes y reglamentos aplicables de exportar en USA. Usted reconoce que el software
no funcionará sin cierta llave de hardware. Esta llave de hardware será suministrada a usted por
AUTOMATIONDIRECT y usted conviene que tal llave de hardware debe ser utilizada solamente con el
software suministrado.

LIMITACIONES DE DISTRIBUCIÓN 

Si usted ha adquirido el paquete de devenvolvimiento, usted puede distribuir los archivos de proceso
creados con el software, a condición de que:

1.  cada recipiente del archivo de proceso tenga una licencia válida para una copia runtime separada del
software;

2. usted incluya el siguiente aviso de derechos de copia, ya sea en la pantalla en el About Box del archivo
de proceso  o documentación escrita, con cada copia distribuida de su 

3. archivo de proceso: "del copyright E [ año ]AutomationDirect by Koyo, Inc. (basado en los materiales
de National Instruments Corporation).Todos los derechos reservados ";

4. usted no utiliza nombres, insignias, o  marcas registradas de AUTOMATIONDIRECT o National
Instruments ("NI") para hacer marketing de  su archivo de proceso sin permiso escrito; y 

5. usted acuerda indemnizar, considerar inofensivo, y defender AUTOMATIONDIRECT y NI (incluyendo sus
representantes, directores, empleados, y agentes) y sus suministradores contra cualquier demanda.

GARANTÍA LIMITADA 

1. AUTOMATIONDIRECT garantiza  que el software funcionará substancialmente de acuerdo con los
materiales escritos por un período de noventa (90) días a partir de la fecha del recibo.
2. AUTOMATIONDIRECT garantiza que cualquier hardware que acompaña el software estará libre de defecto
en materiales y el  servicio normal de uso por un período de un (1) año a partir de la fecha del recibo.
NINGUNA OTRAS GARANTÍAS. A MENOS QUE COMO FUE EXPRESAMENTE
ESTABLECIDO MAS ARRIBA, EL SOFTWARE ESTA SUMINISTRADO "COMO ESTÁ" SIN
GARANTIA DE NINGUN  TIPO, Y NINGUNAS OTRAS GARANTÍAS, O EXPRESADAS O
IMPLICADAS SEAN HECHAS CON RESPECTO AL SOFTWARE, INCLUYENDO PERO NO
LIMITADO A CUALQUIERA GARANTÍAS IMPLICADAS DE MERCADOLOGIA, DE LA
APTITUD PARA UN PROPÓSITO PARTICULAR, DEL TÍTULO O NO -- INFRACCIÓN, O
CUALQUIER OTRA GARANTÍAS QUE PUEDA PRESENTARSE CON EL USO O DE
COMERCIO O DEL CURSO DE REPARTIR. AUTOMATIONDIRECT Y SUS PROVEEDORES NO
AUTORIZAN, NO GARANTIZAN, NI HACEN NINGUNA REPRESENTACIONES CON
RESPECTO AL USO DE O  LOS RESULTADOS DEL USO DEL SOFTWARE EN TÉRMINOS DE
CORRECCIÓN, EXACTITUD, CONFIABILIDAD, O DE OTRA MANERA Y NO GARANTIZAN
QUE LA OPERACIÓN DEL SOFTWARE SERÁ ININTERRUMPIDA O LIBRE DE ERRORES .
AUTOMATIONDIRECT Y SUS PROVEEDORES EXPRESAMENTE NIEGAN CUALQUIER
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GARANTÍA NO INDICADA AQUÍ.
Remedios del cliente - la responsabilidad  de AUTOMATIONDIRECT y su remedio exclusivo será a la opción
DE AUTOMATIONDIRECT.  AUTOMATIONDIRECT reembolsará  el precio pagado, o reparará o substituirá el
software o el hardware que no cumplan con la garantía limitada directa de AUTOMATIONDIRECT. Usted
debe devolver el producto a AUTOMATIONDIRECT con una copia de su recibo de compra. Esta garantía
limitada es nula si la falla del software o del hardware ha resultado de accidente, de abuso, o de una
aplicación errada. Cualquier software de reemplazo será autorizado para el resto del período original de la
garantía o de treinta (30) días, cualquiera sea más grande.
Ninguna otras Garantías  - AUTOMATIONDIRECT NIEGA EL RESTO DE LAS GARANTÍAS,
EXPRESADAS O IMPLICADAS, INCLUYENDO PERO NO LIMITADAS A LAS GARANTÍAS
IMPLICADAS DE MERCADOLOGIA Y DE LA APTITUD PARA UN PROPÓSITO PARTICULAR,
CON RESPECTO AL SOFTWARE, Y A CUALQUIER MATERIAL O HARDWARE ESCRITOS DE
ACOMPAÑAMIENTO. ESTA GARANTÍA LIMITADA LE DA DERECHOS LEGALES
ESPECÍFICOS .USTED PUEDE TENER OTROS, QUE VARÍAN DE ESTADO A ESTADO.

Ninguna responsabilidad por daños consecuentes - en ningún evento AUTOMATIONDIRECT o sus
proveedores serán responsables por cualquier daño (incluyendo, sin limitación, daños por pérdida de
lucros, interrupción de negocio, pérdida de información de negocio, u otra pérdida pecuniaria)
presentándose con el uso de o de la inhabilidad de utilizar este producto de AUTOMATIONDIRECT, incluso
si  AUTOMATIONDIRECT o sus proveedores han sido aconsejados de la posibilidad de tales daños.

LOS DERECHOS RESTRINGIDOS DEL GOBIERNO DE ESTADOS UNIDOS 

El software y la documentación se suministran con DERECHOS RESTRINGIDOS. El uso, la
duplicación, o el acceso por el gobierno está conforme a restricciones según lo dispuesto en el subpárrafo
(c) (1) (ii) de los derechos en cláusula Técnica de Datos y del Software en DFARS 252.227 -- 7013 o
subpárrafos (c) (1) (2) del software comercial -- las derechas restrictas en 48 CFR 52.227 -- 19 como sean
aplicables. El fabricante es AUTOMATIONDIRECT by Koyo, 3505 Hutchinson Road, Cumming, GA 30040
(bajo licencia de National Instruments Corporation, 11500 N. Mopac Expressway, Austin, Tejas 78759 -
- 3504).
Este acuerdo es gobernado por las leyes del estado de Georgia.

ADVERTENCIA 

(1) El SOFTWARE NO SE DISEÑA CON COMPONENTES Y PRUEBAS PARA UN NIVEL  DE
CONFIABILIDAD CONVENIENTE PARA USO EN IMPLANTES QUIRÚRGICOS O
COMPONENTES CRÍTICOS EN NINGUN SISTEMA DE AYUDA DE VIDA CUYA FALLA
DE EJECUCION PUEDA RAZONABLEMENTE CREERSE QUE CAUSA UNA LESIÓN
SIGNIFICATIVA A UN SER HUMANO.

(2) EN CUALQUIER USO, INCLUYENDO EL SUSODICHO, LA CONFIABILIDAD DE LA
OPERACIÓN DEL SOFTWARE SE PUEDE DETERIORAR POR  FACTORES ADVERSOS,

vii

Advertencia



INCLUYENDO PERO NO LIMITADOS A FLUCTUACIONES EN LA FUENTE DE
CORRIENTE ELÉCTRICA, MALFUNCIONAMIENTO DEL HARDWARE, APTITUD DE
COMPUTADORAS O SISTEMAS OPERATIVOS DE COMPUTADORAS, LA APTITUD DEL
SOFTWARE DE LOS RECOPILADORES Y DESARROLLO USADO PARA DESARROLLAR
UNA APLICACION, ERRORES DE  INSTALACIÓN, PROBLEMAS DE COMPATIBILIDAD
DEL SOFTWARE Y DEL HARDWARE, MALFUNCIONAMIENTOS O FALLAS DE LOS
APARATOS ELECTRÓNICOS DE  SUPERVISIÓN O DE CONTROL, FALLAS TRANSI-
TORIAS DE SISTEMAS ELECTRÓNICOS (HARDWARE Y/O SOFTWARE), APLICACIONES
O USOS ERRÓNEOS INESPERADOS, O ERRORES DE PARTE DEL USUARIO O DEL
DISEÑADOR DE APLICACIONES (LOS FACTORES ADVERSOS TALES COMO ÉSTOS DE
AQUÍ EN ADELANTE COLECTIVAMENTE SE LLAMAN LAS "FALLAS DEL SISTEMA").
NINGÚN USO DONDE UNA FALLA DEL SISTEMA CREARÍA UN RIESGO DE DAÑO A
LAS PERSONAS (RIESGO INCLUYENDO LESIÓN CORPORAL Y MUERTE ) O A LA
PROPIEDAD, NO DEBE CONFIARSE SOLAMENTE EN UNA FORMA DE SISTEMA
ELECTRÓNICO DEBIDO Al RIESGO DE LA FALLA DEL SISTEMA. PARA EVITAR DAÑO,
LESIÓN, O MUERTE, EL USUARIO O EL DISEÑADOR DE LA APLICACION DEBE
TOMAR MEDIDAS RAZONABLEMENTE PRUDENTES PARA PROTEGER CONTRA
FALLAS DEL SISTEMA, INCLUYENDO PERO NO LIMITADOS PARA MOVER HACIA
ATRÁS -- O PARA APAGAR MECANISMOS. YA QUE CADA SISTEMA DEL USUARIO SE
MODIFICA PARA APLICACIONES PARTICULARES Y ES DIFERENTE DE ;AS
PLATAFORMAS DE PRUEBA UTILIZADAS Y PORQUE UN USUARIO O UN DISEÑADOR
DE APLICACION PUEDE UTILIZAR EL SOFTWARE CONJUNTAMENTE CON OTROS
PRODUCTOS DE UNA MANERA NO EVALUADA O NO COMTEMPLADA POR LOS
PROVEEDORES DE AUTOMATIONDIRECT , EL USUARIO O EL DISEÑADOR DE LA
APLICACION  ES EN ÚLTIMA INSTANCIA RESPONSABLE DE VERIFICAR Y DE HACER
VALIDO LA CONVENIENCIA DEL SOFTWARE SIEMPRE QUE EL SOFTWARE SE
INCORPORE EN  UN SISTEMA O  UNA APLICACION, INCLUYENDO, SIN LIMITACIÓN,
EL NIVEL APROPIADO DE DISEÑO, DEL PROCESO Y DE SEGURIDAD de TAL SISTEMA
O APLICACION.

Lookout es una marca registrada de National Instruments Corporation.
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Incluya por favor el número y la edición del manual, mostrados abajo, al
comunicarse con Apoyo Técnico con respecto a esta publicación.

Número del Manual : LD4-GSG-SP

Edición: 1a. edición en español

Fecha de edición: 07/05

Nota del traductor;

La traducción ha sido hecha con el propósito de atender una vasta clientela que no puede leer inglés, por la
experiencia en las llamadas de apoyo técnico. Se ha mantenido el formato, la paginación y los dibujos lo más
posible como la versión en inglés, aunque a veces ha sido necesario moverse una página por razones de espacio.
Muchas de las palabras se han dejado en inglés, ya que es muy común usarlas en el lenguaje técnico y también.
y más importante, otras informaciones están solamente en inglés. En el apéndice B, Glosario, se definen algunas
de estas palabras. 

Historia de publicaciones 

Edición Fecha Descripción de cambios

Primera Edición 10/01 Edición original en inglés

Revisión A 12/01 Información corregida en el capítulo 3 en la inserción de objetos

1a. edición SP 07/05 Traducido por Luis Miranda, Ing. Electricista miembro del grupo de Apoyo Técnico
de Automation Direct; cambios y actualizaciones menores en algunos capítulos
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Introducción

Propósito de este manual 
Este manual contiene instrucciones de instalación y una introducción a las propiedades y a las
funciones de LookoutDirect. Incluye información de carácter general para ayudar a conocer los
elementos importantes de LookoutDirect y algunos ejercicios de enseñanza que le muestran  los
fundamentos de diseño de un proceso en LookoutDirect.

Convenciones de este documento 

Documentación Relacionada 
Manual de Desarrollo de LookoutDirect

Suministra información en detalle de las funciones de LookoutDirect incluyendo los
servicios posibles.

Manual de  Referencia de Objetos de LookoutDirect 

Contiene una descripción detallada de todo el sistema de LookoutDirect y los objetos drivers.
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>
Indica la trayectoria para las selecciones jerarquizadas del menú y del comando.
Ejemplo:  START>Programs> xxx

Indica una sugerencia que proporciona una información útil relacionada con el
proceso actual o el asunto.
Indica una información complementaria importante pertinente al proceso actual o
al asunto.

Denota una ADVERTENCIA. Al no seguir la instrucción suministrada en la
ADVERTENCIA podría haber una pérdida de datos o de una interrupción a
un proceso crítico que es controlado o supervisado por LookoutDirect.

texto en
negrilla 

Denota el nombre de los cuadros de diálogo, de los artículos de la hoja de
propiedades, de las funciones y de los comandos de menú que usted selecciona
como parte de un procedimiento.

itálico
Denota referencias a los cuadros de diálogo, a los artículos de la hoja de
propiedades, a las funciones para aplicaciones y a los comandos de menú que
no son parte del proceso actual o a conceptos  claves.

Courier

Denota los caracteres que usted entra con el teclado, ejemplos de sintaxis y
codificación. La fuente Courier también se utiliza para expresar nombres
propios de lectores de disco, de las trayectorias, de los directorios de programas,
de los subprogramas, de las subrutinas, de los nombres de aparato, de las
funciones, de las operaciones, de las variables, de los nombres de archivo y de
extensiones.



El Manual de Referencia de Objetos se puede encontrar en el directorio de documentación del
CD-ROM  de LookoutDirect en el formato de documento portable (pdf). Para ver este archivo,
usted debe tener  Adobe Acrobat  instalado. Si usted no lo tiene instalado, puede instalarlo  del
directorio de Adobe en el sitio de Internet   www.adobe.com.

Instalación 

Usos del programa de desarrollo y el runtime
El software LookoutDirect está disponible en modo de desarrollo y la versión runtime. 

PC-LKD-DEV contiene tanto el modo de desarrollo de LookoutDirect y una licencia para el
uso runtime

PC-LKD -RTE contiene solamente una única licencia para uso runtime. La versión runtime se
puede utilizar solamente para hacer funcionar los archivos de proceso compilados que se han
desarrollado usando PC-LKD-DEV.

Contenido del Paquete 
El paquete suministrado debe contener los siguientes artículos:

CD-ROM 
Llave de hardware 
Este manual en inglés
Manual de desarrollo en inglés 
Manual de Referencia de Objetos en inglés 
Tarjeta de Registro

Si a usted le está faltando cualquiera de los artículos enumerados arriba, contacte  su
suministrador.

Sobre la llave del hardware
Para hacer funcionar LookoutDirect, usted debe instalar la llave de hardware suministrada  en
el puerto USB (después de la versión 4.51.19) de la PC que tiene instalado LookoutDirect
(versión de desarrollo o de runtime). Las llaves de hardware suministradas con la versión de
desarrollo y runtime no son intercambiables. Cada llave de hardware corresponde al número de
la licencia del software que se ha entregado. La llave USB para la versión de desarrollo y runtime
es verde y la llave para la version  runtime es roja. 
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Requisitos del sistema  
Sistemas de desarrollo

Pentium 133 MHz o más rápido 
Windows 95/98/NT/2000/XP
32 MB de RAM 
Espacio disponible del disco duro 100 MB
Accionamiento de CD-ROM 
Monitor colorido de  640 x 480 

Sistema Runtime 
Pentium 133 MHz o más rápido 
Windows 95/98/NT 
32 MB de RAM 
Espacio de disco duro disponible de  100 MB 
CD-ROM (opcional si usted tiene una red) 
Monitor colorido de  640 x 480 o monitor LCD.

Instalando LookoutDirect 
Para instalar este programa:

1. Insiera el CD del  producto en su aparato lector de CD-ROM.
Si es permitido autorun en su sistema, aparecerá la ventana DirectSOFT32  y usted puede
saltar al paso 4.

2. Del menú START (comienzo), seleccione RUN (funcionamiento).

3. Teclee  X:\setup.bat substituya "X" con la designación de la letra de su accionamiento
CD-ROM, y luego haga clic en OK.

4. De la ventana de DirectSoft32, seleccione Install software.

5. En el diálogo de Password (contraseña), entre la clave de 16 dígitos del producto que
corresponde a su licencia de software. La clave del producto se puede encontrar detrás de la
caja del CD del producto. La clave del producto es sensible a mayúsculas o minúsculas y
requiere guiones. El botón OK se hace disponible cuando usted entra una clave válida del
producto.

6. Haga clic en OK.

Aparece el cuadro de diálogo del password (contraseña).

7. Presione la teclas  CTRL + V para copiar la clave del producto, que usted entró
previamente, en la caja de texto de password (contraseña). El botón OK se hace disponible
cuando usted entra una clave válida del producto.

8. Haga clic en Continue.

Aparece la ventana de configuración de LookoutDirect y el diálogo de Welcome (bienvenida). 
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9. Siga las instrucciones de configuración de LookoutDirect que aparecen en la pantalla.

Si aparece el mensaje siguiente, agregue la  linea  Hardwarekey = 3 en el archivo

Lookout.INI como mostrado en la figura de  abajo y luego salve el archivo. Reinicie
LookoutDirect. 

Cuando la configuración de LookoutDirect esté completa, aparece el mago de instalación de
NI (National Instruments). Las insignias de NI se usan para instalar los componentes de
terceros que están licenciados a AutomationDirect.

10.Siga las instrucciones del mago de instalación de las insignias de NI.

Cuando la instalación de las insignias de NI esté completada, la pantalla de instalación de
LookoutDirect vuelve a la pantalla. 

11.Seleccione  una de las opciones:

|i) Ver el archivo Readme o  

ii)Iniciar LookoutDirect.
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Agregue la línea aquí
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Configuración de opciones del sistema 
Una vez que LookoutDirect esté instalado, haga las configuraciones del sistema. El acceso a las
configuraciones del sistema se basa en el nivel de seguridad asignado a cada proceso por el
administrador. Entre en contacto con su administrador del sistema de la red para ayuda si usted
no tiene acceso o realiza cambios a una configuración del  sistema.

1. Seleccione Options> System.
Aparece el cuadro de diálogo System Options. Algunas configuraciones pueden ser
diferentes en su computadora.

2. Selecione la opción  que usted desea y luego haga clic en OK.

Nota: ·Solamente usuarios que entran con un nivel de seguridad  9 o mayor  pueden cambiar las
opciones del sistema.

Configuración del nombre de la computadora
El campo de computadora muestra el nombre de la red de la computadora que usted está
trabajando. Si este campo está en blanco, y usted pretende utilizar la capacidad de creación de una
red en LookoutDirect , usted necesita comprobar sus configuraciones de red para cerciorarse de que
su computadora esté nombrada correctamente para las operaciones de red.
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Configuraciones de la base de datos Citadel
Los campos de la base de datos de Citadel colocan el destino por defecto para los datos de
Citadel registrados por Lookout Direct. Todos los procesos que funcionan bajo una instancia de
LookoutDirect utilizan esta trayectoria de datos para entrar datos de registro al Citadel, a menos
que usted elimine esta configuración cuando usted crea el proceso.
Usted configuró la trayectoria por defecto y la computadora por defecto por separado. Utilice
el nombre completo de la trayectoria para configuración de la trayectoria por defecto, y el
nombre de computadora completamente cualificado para la configuración de la computadora
por defecto.

Configuraciones del teclado virtual
LookoutDirect tiene un teclado virtual al que usted puede tener acceso cuando esté en modo
RUN haciendo clic en un control que acepte texto o entrada numérica. Usted puede configurar
si se llama este teclado apretando el botón derecho o el izquierdo del mouse en el campo del
Virtual keyboard Pop up (Llamada del teclado virtual) en el cuadro de diálogo de opciones del
sistema.

Configuración del registro de alarmas
Si usted tiene una impresora conectada directamente con su computadora, se puede hacer que
todas las alarmas sean impresas cuando ocurren. 
Configure los registros de alarmas (Log Alarms) en el cuadro de diálogo System Options
(opciones del sistema) al puerto de comunicaciones con el cual su impresora está conectada. 

Vea el capítulo 9, Alarms, en el Manual de Desarrollo de LookoutDirect para más información
sobre las propiedades de registro de alarmas y de eventos de LookoutDirect. Usted puede
también capturar un puerto de impresora de red en computadoras con Windows
98/95/2000/XP. Consulte la documentación del sistema operativo para más informaciones
sobre este procedimiento

Configuraciones del nivel de seguridad
Usted puede configurar límites locales en cómo funciona LookoutDirect cuando entran
usuarios con diversos niveles de seguridad. 

Utilice la caja de verificación If security leve is below (si el nivel de seguridad está mas bajo):
en el cuadro de diálogo de opciones del sistema para configurar estos límites. 

Vea el capítulo 6, Seguridad, en el Manual de Desarrollo de LookoutDirect para detalles completos
de las propiedades de seguridad de LookoutDirect.

Las flechas de navegación 
Seleccione Show panel navigation arrows in status bar (Muestre las flechas de navegación en
la barra de estado) si usted desea usar flechas de navegación del panel. Estas flechas, situadas a
la derecha de la barra de estado, activan paneles de control en la orden en la cual usted tuvo
acceso por último. 

Esta característica es más conveniente cuando usted tiene una gran cantidad de paneles de
control en un proceso y necesita completar un ciclo a través de un subconjunto de ellos varias
veces en un corto período.



Configuración de partida de archivos de proceso
Si su computadora opera LookoutDirect 24 horas al día, usted debe estar seguro de que el
sistema pueda reanudar la operación automáticamente y comenzar a ejecutar sus procesos
nuevemente si se apaga la energía al sistema y se enciende más tarde.

Nota  Para que los configuraciones de partida del archivo trabajen, LookoutDirect se debe configurar en
Windows como STARTUP.  Vea la documentación de Windows para más información sobre activar
archivos de startup.

1. Seleccione Options> STARTUP".

Aparece el diálogo Startup process files (Archivos  de proceso para partida).

2. Haga clic en Add.

Aparece  el cuadro de diálogo Add Startup files (Agregue archivos para la partida).

3. Navegue y luego seleccione los archivos de proceso que usted desea hacer funcionar cuando
la energía se restaura al sistema con LookoutDirect.

Usted puede agregar tantos archivos del proceso cuanto desee. Los archivos se abrirán en la
orden en la cual se entran en el cuadro de diálogo Startup process files.

Para corregir un nombre de la trayectoria a un archivo, destaque el nombre del archivo y haga
clic en el botón de Edit (modificación).
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Cómo trabaja LookoutDirect
Este capítulo explica los fundamentos de cómo trabaja LookoutDirect, incluyendo las
descripciones de objetos, miembros de datos, conexiones, procesos, y servicios.

LookoutDirect es una interface de operador (HMI o Human Machine Interface) poderosa pero
al mismo tiempo fácil de usar y un paquete de software de supervisión de control y de
adquisición de datos (SCADA) para automatización industrial.

Este tipo de software es diseñado para que un operador opere un sistema desde una
computadora PC que está conectada a uno o varios PLCs que realmente hacen funcionar un
proceso. Este programa suministra las siguientes funciones, entre muchas otras funciones: 

- Comandos para partida y parada de motores desde la pantalla de la PC.

-  Administración de alarmas de proceso y/o del sistema de control

-  Adquisición de datos y exhibición de valores en tiempo real
-  Administración de usuarios con diversos niveles de autorización de operaciones.

-  Registro gráfico de datos históricos.

-  Recolección de datos para archivo e historia de procesos.

Los proyectos típicos de LookoutDirect incluyen  supervisión de procesos continuos y control
supervisorio, fabricación discreta, aplicaciones de hornadas y sistemas remotos de telemetría.

LookoutDirect funciona con el sistema Windows y se comunica con entradas y salidas de
campo con controladores lógicos programables (PLCs), con unidades terminales remotas
(RTUs) y con otros aparatos. 

LookoutDirect es un paquete configurable de objetos y eventos, que no requiere ninguna
programación o codificación. En vez de eso, usted usa LookoutDirect para crear
representaciones gráficas, en una pantalla de una computadora, de aparatos reales tales como
interruptores, instrumentos, registradores de tendencias, botones, perillas, potenciómetros,
medidores y después conecta sus imágenes a aparatos reales de campo usando PLCs, RTUs,
tableros de adquisición de datos u otros aparatos de E/S.

LookoutDirect tiene muchas funciones incluídas tales como control de proceso estadístico
(SPC), gerenciamiento de recetas, lenguaje SQL, seguridad incorporada, registro de datos
flexible, operando múltiples procesos en una computadora, animación sofisticada, alarmas
complejas, ayuda de telemetría por radio y por teléfono, registro de intervención de eventos y
configuraciones de referencias, apoyo a multimedia, compatibilidad de pantallas táctiles,
creación de una red (procesos múltiples incluyendo cliente y servidor que funcionan en una o
varias computadoras), intercambio dinámico de datos (DDE y NetDDE) y aun más.
Con LookoutDirect usted puede desarrollar una aplicación totalmente en línea, sin apagar el
proceso durante el desarrollo o modificación del desarrollo. Usted no tiene que compilar o
descargar una base de datos cada vez que usted hace una modificación, ni usted tiene que
intercambiar programas. Usted incluso no tiene que hacer funcionar programas separados de
desarrollo y de configuración. En vez de eso, usted puede agregar, borrar y modificar paneles de
control, lógica, gráficos, PLCs, RTUs, E/S, y otros aparatos del campo sin interrupir su proceso.
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Ya que LookoutDirect está orientado a objetos y se activa con eventos, usted puede utilizar
LookoutDirect con otros programas en el ambiente múltiple de Microsoft Windows. Por
ejemplo, mientras LookoutDirect controla y supervisa un proceso, usted puede utilizar una
hoja de cálculo para analizar los valores de producción de caudales promedios cada hora, luego
comenzar un procesador de texto para generar un memorándum, copia la hoja de cálculo en la
nota y la envía a una impresora laser.
El resto de este capítulo describe componentes de la arquitectura de LookoutDirect y cómo
trabajan juntos. Esto le ayudará a entender completamente cómo utilizar LookoutDirect para
todos las aplicaciones de procesos continuos, discretos, o de hornada.

Arquitectura 
Una vez que usted entienda los componentes básicos de LookoutDirect y los conceptos
fundamentales con respecto a la estructura orientada a objetos y eventos, se hace mucho más
fácil usar el programa.

LookoutDirect consiste sobre todo en objetos y sus miembros de datos, conexiones, y servicios. 

Desarrollar una aplicación en LookoutDirect es fundamentalmente crear, configurar y  conectar
objetos. 

Los objetos son representaciones en software de todos los componentes conectados físicamente,
tales como potenciómetros, a aparatos de campo tales como PLCs y a RTUs con las
computadoras en que LookoutDirect está funcionando. 

Usted entonces hace conexiones entre los objetos de software.  LookoutDirect, y los servicios de
LookoutDirect manejan las conexiones entre su computadora y varios PLCs u otros
controladores; entre su computadora y varios sensores, entre su computadora y otras
computadoras y entre su computadora y la base de datos de LookoutDirect, Citadel.

Agregue a esto la idea de procesos de cliente y servidor y  usted estará listo para entender la
estructura básica de todos los usos de LookoutDirect.

Qué es un objeto?
Un objeto es LookoutDirect  es una unidad de software diseñada para hacer algo específico en
la aplicación  de interface de operador o SCADA. 

Los objetos son representaciones de los componentes conectados físicamente, tales como
potenciómetros, temporizadores, sensores, interruptores de límite, registradores gráficos,
conectados a PLCs y a RTUs con las computadoras en que LookoutDirect está funcionando.

Lo que cada objeto hace es genéricamente referido como su funcionalidad. Cada objeto tiene un
conjunto de parámetros, que básicamente definen y configuran el objeto, y  miembros de datos,
que actúan como entradas y salidas,  que se puede asociar a una base de datos y a un conjunto
de parámetros.

El diagrama en la página siguente trata de mostrar la funcionalidad , los miembros de datos y
los parámetros de un objeto.
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Figura 2-1.  Los objetos contienen miembros de datos, parámetros y funcionalidad  

Piense en un objeto como un modelo en software de algo físico. Por ejemplo, un potenciómetro
es algo físico. Usted puede ajustarle la resistencia con la perilla hacia arriba y hacia abajo
produciendo una variación en resistencia entre un valor de 0 a 100%. En LookoutDirect un
objeto POT (potenciómetro) representa el potenciómetro físico. Usted puede ajustarlo
también.

Los parámetros definen los límites de la funcionalidad del objeto. Por ejemplo, los parámetros
definen los valores mínimos y máximos del potenciómetro, el tamaño del intervalo más
pequeño de configuración y de otros elementos de la funcionalidad del potenciómetro.

Los miembros de datos del objeto contienen información sobre el estado actual del objeto, tal
como el valor, si el control es visible u invisible, etcétera. La base de datos puede almacenar la
información del miembro de datos dependiendo de lo que usted desea registrado, en qué nivel
de detalle.

Parámetros

Miembros
de datos
lógicos

Base de datos

Miembros
de datos de
texto

Miembros
de datos
numéricos

Valores de
texto

Valores
lógicos

Valores
numéricos

Nombre

Funcionalidad



Funcionalidad  y clases de objetos de LookoutDirect
Un objeto de LookoutDirect es una instancia específica de una clase de objeto de LookoutDirect.

Se puede pensar en una clase de objeto como la forma generalizada de un objeto. Cuando usted
crea un objeto, se está tomando la forma general descrita por una clase de objeto, la está
definiendo con parámetros específicos, le está dando un nombre, y lo está poniendo para
trabajar como objeto del software. 

Usted puede crear tantos objetos como usted quiera, de cada clase de objeto de LookoutDirect,
cada uno configurado específicamente para realizar la tarea que usted necesita para ese objeto
particular.

Por ejemplo, LookoutDirect tiene las clases de objeto Pot y Switch (interruptor), de las cuales
usted puede ser que cree 20 potenciómetros y 30 interruptores. En este caso, usted estaría
creando un total de 50 objetos usando solamente dos clases de objetos.
Hay diversas clases de objetos para realizar diversas funciones, o tareas. Por ejemplo, la clase de
objeto Pot (potenciómetro) funciona diferente de la clase de objeto Switch (interruptor). Ésta
es la funcionalidad construida en cada clase de objeto.

Las clases globales de objetos son una clase especial de clase de objetos. Cada una contiene datos
globales del sistema tales como el número de alarmas actualmente activas. Usted no puede
crear, modificar o suprimir un objeto global, pero usted puede utilizar a sus miembros de datos
de la misma forma que  usted utilizaría a cualquier otro miembro de datos de objetos.

Cuando usted crea o abre un archivo de proceso de LookoutDirect, LookoutDirect crea
automáticamente tres objetos globales: $Alarm, $Keyboard y $System.

La funcionalidad es la manera que una clase de objetos trabaja, que funciona, o realiza una tarea.

La funcionalidad es un concepto general que se aplica de la misma forma a todos los objetos en
una clase dada de objeto. Los parámetros, sin embargo, pueden ser únicos, y definen la
funcionalidad específica de un objeto individual.

Las definiciones de la clase de objetos, encontrados en el Manual de Referencia de Objetos  de
LookoutDirect, aclaran la funcionalidad de cada clase de objeto.

Parámetros de objetos
Los parámetros de un objeto definen sus características. LookoutDirect usa parámetros de
objetos para completar la definición de la funcionalidad del objeto. Por ejemplo, Data Rate
(frecuencia de datos),  Parity bits (bits de paridad), y   STOP bits (Bits de  parada) son algunos
de los parámetros que definen cómo trabaja un objeto de Modbus. Otros ejemplos incluyen
Control security level (nivel de seguridad del control) de un objeto interruptor;  Minimum
(Mínimo), Maximum (máximo), y Resolution (resolución) de un objeto potenciómetro ;y
Data (datos) de un objeto Average (promedio).

Cada clase de objetos tiene un sistema de parámetros que usted debe completar o seleccionar al
crear un nuevo objeto. Muchos parámetros son expresiones, lo que significa que usted puede
cambiar parámetros por programa. Otros requieren valores constantes. Algunos le piden escoger
configuraciones específicas.
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Los parámetros que aceptan expresiones aparecen como campos amarillos de la entrada de
datos. Estos parámetros pueden recibir señales (es decir, son escribibles). Vea el capítulo 1,
Expresiones, del Manual de Desarrollo de LookoutDirect, para una información más detallada
sobre expresiones.
Todos los parámetros para cualquier clase dada son visibles en el diálogo de la definición del
objeto. Para mayor información sobre cómo crear este objeto, vea la sección Creando y
administrando  puentes de comunicaciones en el capítulo 4.

Figura2-2.  Figura de diálogo de definición del Potenciómetro  

Miembros de datos y base de datos de objetos
Cada objeto tiene su propia base de datos incorporada. Las partes individuales de esta base de
datos autónoma se llaman los miembros de  datos.  Algunas clases de objetos tienen una base de
datos muy limitada, mientras que otras tienen bases de datos extensas. 

La base de datos de un objeto que representa un PLC podría tener centenares de miembros de
datos; pero una base de datos del objeto Switch (interruptor) tiene solamente seis miembros de
datos. Usted no tiene que construir la base de datos; los miembros de datos están
automáticamente disponibles cuando usted crea el objeto.

En el caso de un Switch (interruptor), el valor implícito del objeto es una parte de la base de
datos autónoma. Los miembros de datos pueden ya sea generar (escribir) señales, recibir (leer)
señales, o hacer ambas acciones.
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Cada miembro de datos contiene un sólo valor que puede ser uno de tres tipos: numérico, lógico, o texto.
LookoutDirect es flexible , sin embargo, de modo que usted puede conectar un tipo miembro de datos con otro, y
LookoutDirect  no generará un mensaje de error. Vea la sección de Polimorfismo de Datos de este capítulo para más
información sobre cómo LookoutDirect interpreta datos de diversos tipos.

Los miembros embutidos de cada objeto son referidos como miembros nativos, y pueden ser interpretados  como
miembros de datos para cada objeto incorporados por defecto o miembros de datos automáticos. Usted puede
agregar y modificar la base de datos para satisfacer sus necesidades específicas, uniendo unos o más alias a un
miembro dado de datos, cada uno con un  sistema diferente de alarmas asociado, de registro, o de características de
escala.

Cada clase de objetos tiene una explicación de su base de datos en su documentación  de la clase, a que usted puede
tener acceso haciendo clic en el botón HELP (ayuda) en el diálogo usado para crear o para modificar un objeto. Lo
que sigue es un ejemplo de la explicación de la base de datos de la clase del objeto Switch (interruptor).

Tabla 2-1.  Miembros de Datos tipo Switch 

Miembros
de datos

Tipo Leer Escribir Descripción 

(implícito) lógico sí no Estado del switch

Permiso
(Enable)

lógico no sí

Si es TRUE (por defecto), permite DDE. Si es
FALSO, DDE se desactiva. El valor original de
fábrica es ON. Esta entrada no hace caso para s
objetos de switch  que no sean DDE

Reset lógico no sí
Mientras este valor sea igual a TRUE, el control será
colocado en el valor en resetvalue.

resetvalue numérico sí sí
Configura el valor que un control tomará cuando el
miembro de datos de reset haga la transición de FALSO
a TRUE.

value numérico sí sí
El valor actual del control.Si usted tiene este control
remotamente, value es el valor corriente del estasdo
de la fuente..

visible lógico no sí
Cuando es FALSO, el objeto interruptor no se puede
ver en el panel de exhibición. Cuando es TRUE, el
interruptor se puede ver y controlar.



Miembros  de datos lógicos
Los miembros lógicos de datos contienen un valor que representa un estado binario u ON/OFF
Un interruptor de una lámpara es un aparato lógico -él está OFF u ON.

Los miembros lógicos de datos son usados típicamente para controlar aparatos que pueden ser
activados o desactivados, para indicar que una parte del equipo está funcionando o para indicar
si un interruptor límite está abierto o cerrado.

El objeto Switch (interruptor) genera una señal lógica que está ON cuando el interruptor está
ON y OFF cuando el interruptor está OFF.  De la misma forma, el objeto Pushbutton (botón)
genera un valor lógico que esté ON mientras que se presiona el botón. El objeto Pulse genera
una señal lógica que se activa en intervalos predefinidos, creando un pulso lógico.

Las señales lógicas que algunos objetos generan se pueden mostrar gráficamente en un panel de
control. Vea el capítulo 2, Gráficos, del Manual de Desarrollo de LookoutDirect, para más
información sobre gráficos.

LookoutDirect reconoce las siguientes constantes lógicas como expresiones:

Constantes lógicas que representan un estado ON: yes, true, on 
· Constantes lógicas que representan un estado  OFF:  no, false,  off
LookoutDirect no es sensible a minúsculas o mayúsculas, de modo que variaciones del caso tales
como on, ON, u oN todos serán interpretados como ON.

Vea la sección del Polimorfismo de Datos de este capítulo para la información sobre cómo
LookoutDirect interpreta datos lógicos o de texto cuando se pasa a un miembro numérico de
datos.

Miembros  de datos numéricos
Un Miembro numérico de datos es un número real de coma flotante que representa valores
análogos tales como nivel de un tanque, presión, caudal, voltaje y temperatura. 

Los miembros numéricos de  datos también representan tiempo, como período o como tiempo
absoluto (es decir, un tiempo particular de día/semana/mes/año).

El objeto Pot  (potenciómetro) genera una señal numérica compatible con las señales numéricas
que supervisan y controlan las entradas y las salidas análogas de un PLC.  

Las señales numéricas están en el rango de  [ - 1,7 ×10 275 hasta  1,7 ×10 275]. (Nota del
traductor: Observe que la notación de la coma es hecha en LookoutDirect con un punto y no una
coma de acuerdo a la convención de Estados Unidos)

Vea la sección de Polimorfismo de datos de este capítulo para mayor información sobre cómo
LookoutDirect interpreta datos lógicos o de texto cuando se pasa a un miembro numérico de
datos.
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Las constantes numéricas se entran usando los dígitos decimales (0 - 9), el signo menos (-), el
símbolo de exponente (E o e), y el separador de formato de tiempo (:). 

Algunos ejemplos de constantes numéricas serían como sigue:
0

-123.779999 

1.E7 (15.000.000 

-3.7E-3 (-0.0037) 

23356636.234579 

Las señales de tiempo o Time son almacenadas por LookoutDirect como valores numéricos que
representen días y fracciones de un día. Por ejemplo, usted entra una hora como 1:00:00.
LookoutDirect interpreta el número a la derecha de los dos puntos más a la derecha (:) como
segundos, el número a la derecha de los segundos dos puntos como minutos, el número
siguiente como horas, y el número a la izquierda de los terceros dos puntos como días. Si no hay
dos puntos  en la entrada, el período se asume para ser dado en días.

Cuando el sistema operativo cambia la hora por temporada de invierno o verano, LookoutDirect
corrige  el tiempo universal en relación con el cambio de modo que no haya discontinuidad o
pérdida de datos en la base de datos Citadel.

Tabla 2-2.  Ejemplos de constantes de tiempo de LookoutDirect 
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Tiempo Interpretación de LookoutDirect

0:23 23 segundos, o 0.0002662 días 

75:00 75 minutos, segundos 0, o 0.05208 días

12:00:05:01 12 días, 0 horas, 5 minutos, 1 segundos, o 12.003484 días

199:: 199 horas, 0 minutos, segundos 0, o 8.2917 días 

0:10.023 10.023 segundos, o 0.0001160 días 

12.75 12.75 días 

17:64:22.5 
número inválido:porque se especifican las horas, los minutos
deben ser menor o igual a  59 
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Usted puede entrar una hora como 1:00:00, pero LookoutDirect almacena el número como 0.04167 (o
1/24 de un día). Los días son representados por la porción del número entero del número.  El número cero
representa el 1º. de Enero de 1900. Usted puede también encontrar útil saber que un segundo =
0.000011574  y un minuto = 0.000694444.

Sugerencia: si usted muestra una señal numérica en un panel de control, LookoutDirect
dispone de una gran lista de formatos numéricos para escojer. Usted puede configurar el
formato cuando usted crea el objeto, o haciendo clic en el boton derecho del mouse en el
objeto y seleccionando Display properties (características del visor). 

Los diversos formatos posibles se enumeran en las siguientes tablas.

Tabla 2-3.  Ejemplos de formato numérico General 

Tabla 2-4.  Ejemplos de formato numérico de Ceros 

Formato numérico Valor Mostrado como 

(General) 123.8 Mostrado como 123.78

(General) 123.789 Mostrado como 123.789

Nota: El formato general muestra el valor en la forma más compacta posible

Formato numérico Valor Mostrado como 

000000000 123.789 000000124

00000000 123.789 00000124

0000000 123.789 0000124

000000 123.789 000124

00000 123.789 00124

0000 123.789 0124

000 123.789 124

00 123.789 124

0 123.789 124
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Tabla 2-5.  Ejemplos de formato de números fraccionarios con ceros a la derecha

Tabla 2-6.  Ejemplos de formato de notación exponencial o científica .

Tabla 2-7.  Ejemplos de formato hexadecimal

Formato numérico Valor Mostrado como 

0.0 123.789 123.8

0.00 123.789 123.79

0.000 123.789 123.789

0.0000 123.789 123.7890

0.00000 123.789 123.78900

0.000000 123.789 123.789000

0.0000000 123.789 123.7890000

0.00000000 123.789 123.78900000

Formato numérico Valor Mostrado como 

0E0 123.789 1E+2

0.0E+0 123.789 1.2E+2

0.00E+0 123.789 1.24E+2

0.000E+0 123.789 1.238E+2

0.0000E+0 123.789 1.2379E+2

0.00000E+0 123.789 1.23789E+2

0.000000E+0 123.789 1.237890E+2

0.0000000E+0 123.789 1.2378900E+2

0.00000000E+0 123.789 1.23789000E+2

Formato numérico Valor Mostrado como 

0x0 123.789 0x7

0x00 123.789 0x7

0x000 123.789 0x07

0x0000 123.789 0x007

0x00000 123.789 0x0007

0x000000 123.789 0x00007

0x0000000 123.789 0x000007

0x00000000 123.789 0x0000007
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Usted puede también usar señales numéricas para representar épocas absolutas y períodos. Ya
que las fechas y los tiempos son representados por valores numéricos, usted puede sumar, restar
e incluir fechas y tiempos en expresiones, tal como cualquier otra señal numérica.
Un período representa una duración. Los períodos se indican en horas, minutos, segundos, y
fracciones de segundos. Los formatos numéricos que representan períodos son caracterizados
por mayúsculas (es decir, H más bien que h).

Tabla 2-8.  Ejemplos de exhibición del Período 

Las fechas y tiempos absolutos indican un momento específico en el tiempo. LookoutDirect
almacena todas las fechas y horas absolutas como señales numéricas. Utiliza el sistema de la fecha
1900  en el cual el número 1 corresponde a la medianoche, el 1º. de Enero de 1900. El número
2 corresponde a la medianoche, e; 2 de  Enero de 1900, etcétera. Por ejemplo, el número
34491.5 representa el mediodía, el  6 de Junio de 1994.

Los formatos numéricos que representan fechas absolutas son caracterizados por letras
minúsculas (por ejemplo, hh:mm en vez de HH:MM).

Tabla 2-9.  Ejemplos de exhibición de fecha y hora absolutos 

Formato de tiempo Valor Mostrado como 

H 0.4789 11 (horas)

H.H 0.4789 11.5 (horasP

H.HH 0.4789 11.49 (horas)

M 0.4789 690 (minutos)

M.M 0.4789 689.6 (minutos)

M.MM 0.4789 689.62 (minutos)

S 0.4789 41377 (segundos)

S.S 0.4789 41377.0 (segundos)

S.SS 0.4789 41377.96 (segundos)

Formato de tiempo Valor Mostrado como 

hh:mm 34668.7889 18:56 (6:56 PM)

hhLmm:ss 34668.7889 18:56:02

mm/dd hh:mm 34668.7889 11/30 18:56

mm/dd hh:mm:ss 34668.7889 11/30 18:56:02

mm/dd/yy 34668.7889 11/30/94

mm/dd/yy hh:mm 34668.7889 11/30/94 18:56

mm/dd/yy hh:mm:ss 34668.7889 11/30/94 18:56:02

dd/mm hh:mm 34668.7889 30/11 18:56

dd/mm hh:mm:ss 34668.7889 30/11 18:56:02
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Miembros de datos de  texto
Los miembros de datos de texto contienen cadenas de caracteres de texto. Estas cadenas de
caracteres consisten en todos los caracteres mostrables ASCII. 

Se puede usar señales de texto para mostrar descripciones de alarmas en el panel de alarmas, para
mostrar etiquetas en un panel de control y en parámetros o expresiones. Se pueden incorporar
señales de texto como constantes, o se puede construirlas con  muchas funciones de texto
disponibles en expresiones. 

Asegúrese de incluir constantes de texto dentro de cremillas ("") al usarlas dentro de expresiones.

Algunos ejemplos de las constantes de texto serían los siguientes:
"Temperatura del Agua:"
"" (secuencia de texto vacía) 
"Nivel bajo tanque polímero 2" 
"rpm" 

Vea la sección de Polimorfismo de Datos en este capítulo para información sobre cómo
LookoutDirect interpreta datos lógicos o numéricos cuando se pasa a un miembro de datos de
texto.

Miembros de datos (implícitos)
Muchas clases de objeto tienen un miembro (implícito) de  datos. Este valor implícito·puede ser
lógico, numérico, o texto, dependiendo de la clase del objeto, y sigue las mismas reglas que se
aplican al  resto de los miembros de datos. 

El miembro implícito representa lo que considera LookoutDirect ser el miembro lo más
comúnmente posible usado de datos de esa clase de objeto. En muchos casos, es el único
miembro de datos de una clase. Le ahorra tiempo y reduce la cantidad de mecanografia
requerida  para designar a un miembro de datos.

Por ejemplo, LookoutDirect podría hacer que usted especifique la señal numérica generada por
un objeto potenciómetro al colocar Pot1.numeric donde Pot1 es el nombre y numeric
es el valor actual del potenciómetro.  

En vez de eso, usted entra  Pot1 y LookoutDirect sabe que usted se está refiriendo al valor
implícito del potenciómetro  Si usted examina la definición de Pot en la ayuda online de
LookoutDirect, usted verá que el miembro (implicito) de datos es el valor corriente del
potenciómetro.



Manual de cómo comenzar LookOutDirect2–14

Capítulo 2: Como trabaja LookoutDirect

1

2

3

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D

Polimorfismo de datos 
Los datos polimórficos son datos cuyo tipo no es definido en forma absoluta.  En LookoutDirect
los datos de un tipo se interpretan apropiadamente cuando están conectados con una entrada
de otro tipo. Se puede también seleccionar el tipo de datos al inserir expresiones, usando la caja
de selección debajo del campo de la expresión, según lo mostrado en la figura siguiente.

Los valores lógicos se muestran como 0 y 1 cuando son interpretados como valores numéricos
y  como ON u OFF cuando están interpretados como valores de texto.

Un valor numérico de 0 quiere decir OFF cuando está considerado como un valor lógico.
Cualquier valor con excepción  de 0 se muestra como ON. Un valor numérico mostrado como
texto muestra los dígitos del número.

Las secuencias de texto mostradas como valores numéricos aparecen  como dígitos si la secuencia
consiste solamente en dígitos en un tamaño válido de representación LookoutDirect, tal como
un número decimal o una expresión científica. La interpretación numérica de texto en un
formato de tiempo, tal como 10:05:30 se interpreta como número (la fracción de un día
representa la cantidad de horas) en notación científica.

Cualquier secuencia de texto que no consista en dígitos en un formato válido de LookoutDirect
se interpreta como 0, a excepción de ON o TRUE,  que se muestra como 1. OFF o  FALSO  son
interpretados como 0, por defecto. Los términos  ON, OFF,TRUE,y Falso no
discriminan entre mayúsculas y minúsculas.

Las secuencias de texto mostradas como valores lógicos se interpretan como 0 o como OFF,
excepto cuando la secuencia de texto consiste en  un 1,  ON, o  TRUE, que se interpretan como
ON. De nuevo, una secuencia de texto que consiste en  0, OFF, o Falso es interpretado como
OFF, por defecto. Las palabras  ON, OFF, TRUE, y Falso no discriminan entre
mayúsculas y minúsculas. 



Una vez que usted haya puesto una expresión en su panel, usted no puede cambiar los datos
adentro de esa expresión. Usted tiene que eliminar (borrar) esa expresión y poner una nueva si
usted desea cambiar el tipos de datos.

Las expresiones usadas como parámetros en objetos de LookoutDirect no permiten que usted
seleccione el tipo de datos porque el objeto interpreta la entrada según el tipo de datos requerido
por ese objeto. Usted puede, sin embargo, usar una salida de un tipo de datos diferente de ése
requerido por un objeto,si la salida se puede interpretar con sentido por el objeto.

Los tipos de datos polimórficos afectan el objeto de DataTable. En versiones anteriores de
LookoutDirect 4.0, la DataTable usa miembros de  datos tales como A1.logical para
configurar el tipo de datos en una célula particular. Algunos programadores de LookoutDirect
utilizaron el DataTable para crear, efectivamente, datos polimórficos.

Los miembros de datos de la DataTable de LookoutDirect versión3 .xx  se mantienen en
LookoutDirect versión 4 por motivos de compatibilidad. Pero no es necesario usar los miembros
de datos tecleados para simular datos polimórficos. Para alcanzar esta compatibilidad, sin
embargo, los datos de DataTable de LookoutDirect todavía son definidos absolutamente. Usted
debe entrar datos numéricos a los Miembros numéricos de  datos de DataTable, datos lógicos a
los miembros lógicos de datos de DataTable, etcétera.

Atributos de calidad de datos
LookoutDirect usa atributos de calidad de datos para registrar cualquier  problema con sus datos.
Si hay una falla de comunicaciones con un aparato, si la conexión de red a la fuente de los datos
es mala, si la fuente de datos es indefinida, si el valor está corrupto o si se presenta un otro
problema, LookoutDirect crea una alarma para divulgar la condición.

Ya que la  alarma puede ser visible solamente en la computadora local, y no en una computadora
que tiene acceso a esos datos de otra localización, LookoutDirect coloca una marca  X roja sobre
el control o la expresión afectada cuando hay un problema de calidad de datos.

Compruebe el panel de alarmas del proceso que entrega el problema de la calidad de datos para
ver si hay detalles sobre el problema. Usted puede también usar las funciones de calidad de datos
para supervisar la calidad de los datos y para informar sobre problemas. Vea la sección de
Funciones de calidad de Datos del capítulo 1, Expresiones, del Manual de Desarrollo de
LookoutDirect.

Usted puede también configurar su computadora para supervisar alarmas de procesos que
funcionan en otras computadoras. Vea el capítulo 9, Alarmas, en el Manual de Desarrollo de
LookoutDirect para tener información sobre cómo hacerlo.
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Conexiones 
Todos los objetos de LookoutDirect que Ud. crea corresponden a objetos físicos tales como
interruptores o  potenciómetros, o sirven como interfase a un cierto objeto físico conectado con
su computadora, tal como un PLC, y RTU, u otra computadora en la red que está conectada
con tales objetos.

Usted puede conectar todos estos objetos en LookoutDirect permitiendo que pasen señales
entre ellos de la misma manera que usted colocaría un cable desde la salida de un temporizador
a un contactor, por ejemplo. Usted puede hacer esto conectando a miembros de la base de datos
uno al otro, o conectando a miembros de la base de datos con los parámetros.

En un sentido más amplio, una forma de entender LookoutDirect es en función de estas
conexiones. La figura siguiente muestra la conexión de un miembro de datos a parámetros y la
conexión de miembro de datos a miembro de datos.

Figura2-3.  Conexiones de ejemplo entre dos objetos 

Por ejemplo, usted puede ser que haga el miembro numérico de datos de un potenciómetro la
fuente para el parámetro High limit (límite superior) de un objeto de alarma. Cuando usted
ajusta el potenciómetro, la alarma  límite superior cambia.

De esta forma LookoutDirect maneja las conexiones entre su computadora y varios PLCs u otros
controladores; entre su computadora y varios sensores; entre su computadora y otras
computadoras; y entre su computadora y la base de datos de LookoutDirect, Citadel.
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Todas las alarmas, generación de informes, graficos de tendencia, análisis de datos, y una base
de datos rápida y flexible están incluidas en el programa LookoutDirect; todo lo que usted debe
hacer es configurar objetos y puntos de datos, luego crea las conexiones, usando los cuadros de
diálogo de LookoutDirect.
Las conexiones de LookoutDirect varían. Algunas controlan hardware directamente
determinando referencias, otras controlan o informan sobre procesos en forma interactiva,
algunas analizan y presentan datos. A toda esta capacidad, LookoutDirect le suma una forma
poderosa pero simple de hacer conexiones de LookoutDirect a través de una red.

El conjunto de conexiones y objetos se llama un proceso.  Ya que LookoutDirect hace funcionar
múltiples procesos, y porque la creación de una red se ha hecho tan simple, usted puede crear
cuantos procesos necesite, pequeños o grandes, para aumentar la eficacia de sus sistemas de
control.

Afortunadamente, usted no necesita preocuparse de crear drivers o bases de datos o pantallas en
LookoutDirect;  todas estas cosas son objetos de LookoutDirect, o contenido en objetos. Todo
lo que debe hacer es poner objetos donde usted los desea, y hace las conexiones necesarias hasta
y desde ellos.

Usted no tiene que preocuparse de sistemas y de lazos complicados de interrogación, o de
sincronización. Ya que LookoutDirect funciona con aciones causadas por eventos, sus
conexiones reaccionan a cambios y a otros eventos cuando suceden, no en una cierta orden
arbitraria construida en sus programas.

Usted puede hacer las clases siguientes de conexiones en LookoutDirect:
Directas-Hechas con el diálogo Edit Connections (Modifique conexiones), estas conexiones
son fijas y trabajan en una dirección solamente. Esta clase de conexión se debe hacer
solamente de un proceso del servidor al hardware instalado en la computadora del servidor,
o entre los objetos contenidos dentro del mismo proceso.
Conexión remota URL-Una conexión URL es un tipo flexible de conexión completamente
recíproca entre un control de LookoutDirect y un miembro de datos de lectura/grabación de
un mienmbro de datos de un objeto de LookoutDirect. 
Cambiando el control se cambia el miembro de datos, como usted esperaría, pero si el valor
de ése miembro de datos cambia por alguna otra causa, el valor de control también cambia. 
Esta clase de conexión es lo que usted usa para conectar un proceso de cliente con un proceso
de servidor, o para conectar dos procesos de clientes a través de un servidor. (vea la sección
siguiente para una explicación de procesos clientes y  servidor.)
Complejas-usted puede hacer conexiones complejas usando variables y pruebas lógicas para
responder dinámicamente a las necesidades y a circunstancias cambiantes. 
Usted puede hacer conexiones complejas directas, y con el objeto de conexión simbólica de
LookoutDirect, también hacer conexiones complejas remotas.
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Procesos de cliente y de servidor 
Los procesos de LookoutDirect son programas que usted crea para realizar una cierta función
específica. LookoutDirect puede hacer funcionar cualquier número de procesos al mismo
tiempo. Usted puede abrir y cerrar un proceso sin perturbar otros procesos que estén
funcionando en ese momento. Sus procesos pueden entregar y analizar datos y controlar la
maquinaria, al mimo toempo que obran recíprocamente con otros procesos de LookoutDirect
que funcionan en su computadora y otras compturadoras, dispersados a través de la red.
Es importante hacer una distinción entre los procesos cliente y servidor durante el diseño y
desarrollo de su interface LookoutDirect.

• Las computadoras que están funcionando con los servidores LookoutDirect se deben
conectar correctamente con el hardware industrial externo de automatización tal como los
PLC DirectLOGIC. Las computadoras que tienen funcionando solamente clientes no se
deben conectar con hardware externo. Es decir, los servidores se conectan directamente con
el hardware; los clientes se conectan remotamente, a través del servidor.

• Los servidores controlan y supervisan; los clientes observan, informan y hacen ajustes a las
referencias o configuraciones  del servidor. Los servidores pueden hacer todas las cosas que
hacen los clientes; los clientes actúan a través de los servidores.

• Las aplicaciones del cliente pueden moverse desde una computadora a otra computadora,
y de esa forma, que no deben tener ninguna dependencia directa para funcionar. Es decir,
nada en una aplicación del cliente debe referirse directamente o depender de la
computadora en que funciona. Usted debe utilizar siempre una conexión remota de la
fuente de un control del cliente a un servidor más bien que a hacer una conexión directa,
de modo que  el control divulgue configuraciones así como cambiarlos.

Como se podría esperar, usted puede tener más de un proceso de cliente tratando de alterar un
valor en un solo proceso del servidor. Cuando sucede ésto, LookoutDirect acepta la entrada
cuando llega, de modo que la primera entrada del cliente que llegue se ejecuta antes de la
siguiente.

Control supervisorio 
Mientras se crean y conectan objetos, se forma una red o un sistema, conteniendo muchos
objetos, todos conectados para realizar una estrategia de supervisión del control.

Es cómo usted diseña su sistema de supervisión, detrás del panel de control, que hace que su
proceso funcione. 

Su sistema lleva las señales de componentes de campo a gráficos de barras y a indicadores
visuales en paneles de control. Activa y desactiva alarmas. Usted puede diseñarlo para tomar
decisiones complejas basadas en  valores de las señales de control de campo y de las referencias
ajustadas a través de los potenciómetros y de los interruptores en los paneles de control. Usted
puede incluir fórmulas complejas de una hoja de cálculo como parte de su diseño de
supervisión.
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Proceso controlado por eventos
Un concepto importante a entender es que LookoutDirect es enteramente controlado por
eventos, no por exploraciones consecutivas de estados , tal como lo hace un PLC.  Para entender
el significado de este diseño se requiere una discusión para explicar cómo los programas con
exploraciones consecutivas estándares trabajan.
Las aplicaciones de programas con barrido o exploraciones consecutivas ejecutan código
secuencialmente de arriba para abajo, y vuelven a ejecutarlo de nuevo desde arriba para ejecutar
el mismo código repetidamente, según lo mostrado en la figura 2-4.

Figura 2-4.  Ejemplo de un programa convencional de sistem con barrido continuo  
En este modelo de programación, una sección dada del código o regla puede ejecutar millones
de veces antes de que el resultado cambie. Esto hace perder tiempo de procesador en la
computadora y retrasa respuestas a eventos frecuentes.

Cuanto más reglas usted agrega a los sistemas con programas de exploraciones consecutivas
estándares, más lento es el tiempo de reacción. También, si se agregan más elementos a la base
de datos central, se degrada la velocidad y el funcionamiento total. Esto es porque muchas bases
de datos centrales utilizan un sistema pasivo de notificación en el cual las reglas de lógica con
programas con exploraciones consecutivas deban explorar una base de datos siempre más
grande para encontrar los  valores apropiados. Cuanto más grande es la base de datos, más
tiempo se toma para encontrar los datos que necesita para resolver su función.

Operaciones de barrido 
El paradigma de un
lazo sin fin
constantemente lee y
escribe valores desde
y hasta la base de
datos central. La lógica
de lazo sin fin
reexamina valores y
reglas, perpetualmente
verificando valores y
reglas.

Driver es una
aplicación
separada 

Notificación
pasiva

Regla 1

Regla 2

Regla 3

Regla 4

Valor lógico

Valor de texto

Valor entero

Valor punto flotante

Driver de protocolo

Base de datos central
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En un fuerte contraste con este modelo de programación, LookoutDirect es enteramente
controlado por eventos.  Cada objeto permanece sin actuar, no hace nada hasta que ocurre un
evento, según lo mostrado en el Figura 2-5.

Figura2-5.  Arquitectura de LookoutDirect controlada por eventos de Objetos 

Un evento es un cambio en un valor de datos. Cuando una señal de entrada cambia, el objeto
se activa, procesando el valor según su funcionalidad. Los objetos envían solamente señales
cuando el resultado de su proceso cambia. Ésto es cómo un evento se propaga a través del
sistema, creando una reacción en cadena que afecta solamente los objetos en la cadena. Esto se
llama notificación activa.

Los objetos individuales se activan solamente cuando son notificados de un evento. Este
paradigma de acción causada por un evento simula muy cerca la sensibilidad de interruptores,
de botones, y de relevadores físicos, y esa es la razón de porqué  LookoutDirect es tan rápido.

Ventajas de la notificación activa
Considere las ventajas de la notificación activa sobre la la notificación pasiva. La notificación
activa es intrínsecamente causada por un evento mientras que la notificación pasiva requiere un
barrido constante para comprobar si hay un cambio en un valor de los datos.

Un buen ejemplo sería dos personas que intentan intercambiar información. Una persona
podría pedir a la otra información, y esa persona respondería. Esto requeriría a una persona
preguntar a la otra en varias ocasiones si cualquier cosa ha cambiado.

Esto es lo que hacen las reglas de operaciones con barrido cuando preguntan constantemente
a la base de datos central.

Alternativamente, una persona podría solamente informar a la otra cuando sucede algo. Esto
es qué sucede cuando usted conecta dos objetos en LookoutDirect.



Manual de cómo comenzar LookOutDirect 2–21

Capítulo 2: Como trabaja LookoutDirect

1

2

3

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D

La adición de objetos en LookoutDirect agrega perceptiblemente menos demanda por tiempo
de procesador que agregando nuevas reglas o el agrandamiento de la base de datos central de
un sistema de barridos de lazo tradicional.
Ya que LookoutDirect es enteramente activado por eventos, la orden en la cual usted crea los
objetos y los conecta no afecta cómo trabaja laestrategia de supervisión.

Servicios de ambiente de LookoutDirect 
Ya que la piedra angular de la tecnología de objetos es el objeto en sí, los objetos necesitan un
ambiente en el cual van a funcionar. Los objetos requieren uso de recursos de sistema tales
como el puerto serial, el disco duro, las funciones de multimedia, y otros más. 

Por ejemplo, múltiples objetos de PLC pueden necesitar usar el mismo puerto de
comunicación en su computadora. En tal caso, LookoutDirect debe suministrar  un servicio
de ambiente - es decir, un mecanismo inteligente que los objetos pueden usar para tener
acceso al puerto de comunicación de una manera ordenada y oportuna.

Un servicio de ambiente, entonces, es una herramienta que LookoutDirect torna disponible
para los objetos, o una función que LookoutDirect realiza fuera de su estructura orientada al
objeto. Cada servicio de ambiente suministra una función especial. Las secciones siguientes
describen servicios de ambiente LookoutDirect.

Servicio de ambiente de comunicación del puerto serial 
Usted puede configurar ciertas clases de objetos de protocolo para representar y para
comunicarse con PLCs y RTUs a través de los puertos seriales de su computadora. Este
servicio de ambiente administra el uso del puerto serial entre los objetos que representan PLCs
y RTUs. 

Por ejemplo, una sola radio de dos vías conectada con un puerto serial en la computadora
puede comunicarse con varias diversas marcas de fábrica de RTUs hacia el campo, y cada
RTU usando un  protocolo diferente. 

Vea el capítulo 4, Comunicaciones Seriales , en el Manual de Desarrollo de LookoutDirect para
más información sobre comunicaciones de configuración.

Servicio de ambiente de base de datos 
Con el servicio de ambiente de base de datos se pueden definir o modificar parámetros de
miembros de datos nativos .

Por ejemplo, la clase de objeto Modbus incluye un miembro nativo de datos llamado
40001. Usted puede dar a este miembro nativo de datos un alias tal como PumpSpeed,y
define la escala asociada a la unidad de ingeniería, alarmas, banda muerta y otros parámetros.
Con LookoutDirect usted puede también importar directamente información de la base de
datos desde paquetes externos, tales como Siemens APT. 

Vea el capítulo 7, Datos y eventos de registro, y el capítulo 8, Lenguaje de interrogación
estructurado, del Manual de Desarrollo de LookoutDirect para más información sobre los
servicios de la base de datos suministrados por LookoutDirect.
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Servicio de ambiente de símbolos gráficos
LookoutDirect tiene una biblioteca extensa de símbolos gráficos estándares. Éstos incluyen
varios switches (interruptores), potenciómetros, botones, gráficos de barras, válvulas, tanques,
bombas, etcétera. Usted puede también crear su propio símbolo gráfico y agregarlo a su
biblioteca de LookoutDirect.
Vea el capítulo 2, Gráficos, del Manual de Desarrollo de LookoutDirect para más información
sobre símbolos gráficos.

Servicio de ambiente de alarmas
El subsistema de alarmas es un mecanismo poderoso y flexible para generar, exhibir, registrar, e
imprimir alarmas. Este subsistema tiene varias partes distintas incluyendo la ventana de alarmas,
parámetros de objetos como grupo de alarmas y prioridad de alarmas, filtros de alarmas,
parámetros de exhibición y configuraciones de impresión.

LookoutDirect archiva permanentemente alarmas al disco duro. Usted puede imprimir
fácilmente esta historia de alarmas. 
Vea el capítulo 9, Alarmas , del Manual de Desarrollo de LookoutDirect para más información.

Servicio de ambiente de Multimedia
LookoutDirect también suministra  un servicio de ambiente de multimedia que se puede utilizar
para ejecutar archivos de sonidos. Vea la descripción online de ayuda del objeto Playwave para
más información sobre el uso de esta característica.

Servicio de ambiente de seguridad
LookoutDirect tiene un sistema altamente sofisticado y comprensivo de seguridad para uso
local y de la red. Usted puede configurar seguridad de control, de las pantallas y  verificación de
acciones. Usted puede determinar selectivamente qué operadores tienen control de qué objetos,
que pantallas pueden ver los operadores, qué paneles de control pueden ver, y qué objetos
aparecen a los operadores para la verificación de comandos.

Vea el capítulo 6, Seguridad, del Manual de Desarrollo de LookoutDirect para más información
sobre seguridad.

Servicio de ambiente de Registros Históricos
Con el servicio de ambiente de registros usted puede almacenar información en tiempo real del
sistema al disco duro en archivos ASCII delimitados por coma, o en una base de datos especial
de LookoutDirect llamada Citadel.

El registrador de eventos Event Logger de  LookoutDirect no pierde de vista quién hizo qué, y
cuando lo hizo. LookoutDirect registra los comandos del operador, desde cerrar un archivo de
proceso a accionar un interruptor o a ajustar un potenciómetro. Junto con cada evento,
LookoutDirect registra el nombre de la cuenta (el operador), la fecha y la hora del evento,
nombre del objeto ajustado, y las configuraciones del objeto antes y después de la acción .

Vea el capítulo 7,  Datos de registro y eventos, del Manual de Desarrollo de LookoutDirect para más
información sobre servicios de ambient de registro.



Servicio de Ambiente ODBC
Debido al servicio de ambiente de LookoutDirect de conectividad de base de datos (ODBC),
usted puede usar otras aplicaciones, tales como Acces de Microsoft,  para preguntar datos a la base
de datos histórica de  LookoutDirect.

Vea el capítulo 8, Lenguaje de Interrogación Estructurado, del Manual de Desarrollo de
LookoutDirect para más información sobre servicios de ambiente  ODBC.

Servicio de ambiente  DDE 
LookoutDirect puede envíar sus valores de proceso corrientes a otras aplicaciones, y puede
recibir valores en tiempo real de otras aplicaciones. El sistema LookoutDirect actúa como un
cliente DDE y servidor DDE. 
Vea el capítulo 5, Intercambio de Datos Dinámico, del Manual de Desarrollo de LookoutDirect
para más información sobre DDE.

Servicio de ambiente de creación de una red
LookoutDirect suministra un servicio completo de ambiente para redes servidor-cliente con el
uso de TCP/IP.  Con este servicio de ambiente, usted puede supervisar y controlar sus procesos
desde múltiples estaciones de trabajo en una red. 

Vea el capítulo 4, Establecimiento de una red, del Manual de Desarrollo de LookoutDirect para más
información sobre la creación de una red. de computadoras con LookoutDirect.

Servicio de ambiente de Redundancia 
Utilice el servicio de ambiente de redundancia de LookoutDirect para configurar dos
computadoras para redundancia, suministrando transferencia automática  y control y
supervisión si una de las computadoras falla. 

Vea el capítulo 10, Redundancia, del Manual de Desarrollo de LookoutDirect para más
información sobre configuración de redundancia de la computadora.

Servicios de Windows  de LookoutDirect
LookoutDirect requiere tres servicios de retaguardia que funcionen en Windows fuera de la
aplicación de LookoutDirect, para funcionar en su computadora mientras LookoutDirect esté
funcionando: Servidor de Citadel, Clasified ADS y Time Synchronization (sincronización de
tiempo).
En su gerenciamento de tareas (Task Manager) de Windows NT, estos servicios aparecen como
Classifieds, TimeService, y CitadelService. Bajo Windows NT, estos servicios funcionan
automáticamente como servicios de NT. Si usted necesita interactuar  con estos servicios, utilice
la utilidad de los servicios NT, encontrado en Start>Settings>Control Panel>Services.

En Windows 98/95, LookoutDirect instala un Services Manager (administrador de servicios)
durante la instalación, denotada por un icono pequeño de un faro en un extremo de su barra  de
tareas de Windows, según lo mostrado en la ilustración siguiente.
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Cuando usted hace clic derecho en este icono usted verá el menú siguiente.

Usted puede comenzar o parar cualesquiera de los servicios de Windows de LookoutDirect
usando esta herramienta.
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Como comenzar con LookoutDirect
Este capítulo contiene los tres siguientes cursos guiados. Cada curso está diseñado para dar al
lector una  exposición práctica a LookoutDirect.

Curso de funciones básicas - introduce los fundamentos del ciclo de desarrollo de un proceso
con LookoutDirect. Usted usará las funciones más comunes de LookoutDirect para crear un
proceso que funcione localmente en su PC sin necesidad de una conexión entre la PC con
LookoutDirect y un PLC.

Curso de PLC conectado - suministra una demostración inmediata de comunicaciones
bidireccionales entre LookoutDirect y un PLC usando señales numéricas y lógicas. Para
completar este curso, la PC en la cual usted está haciendo funcionar LookoutDirect se debe
conectar correctamente con un controlador programable DirectLogic. 

Vea al apéndice B para más información sobre como establecer comunicaciones.

Curso de funciones avanzadas - le muestra cómo crear funcionalidad dentro de
LookoutDirect que usted puede usar para realzar y manejar los procesos que usted crea.

Para beneficiarse completamente de los cursos, le recomendamos que usted termine cada curso
en la orden dada. Antes de comenzar los cursos, asegúrese de que esté instalada la llave de
hardware provista para LookoutDirect. 

Sin la llave de hardware, la funcionalidad de LookoutDirect estará limitada a una hora de uso y
a diez puntos de entradas y salidas. 

Vea el capítulo 1, Sobre la llave de hardware, para más información sobre como usar la llave de
hardware.

Después de terminar los tres cursos, usted sentirá que usted está listo para comenzar a crear  su
propio proceso. 

Si usted quiere una información más profunda sobre LookoutDirect, lea el capítulo 4,
Fundamentos de LookoutDirect: Windows, herramientas, archivos, y nombres de trayectoria y el
capítulo 5, Usando LookoutDirect.
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Curso de funciones básicas 
En este curso, usted creará un proceso que contenga funciones simples asociadas a una planta
de tratamiento de aguas. El archivo de proceso terminado creado por este curso, con nombres
de archivo en inglés, se puede encontrar en 

C:\DirectSoft32\Projects\Examples\LookoutDirect\WaterWorks.l4p.

Usted puede encontrar útil tener el ejemplo del proceso abierto mientras se completa este curso.

Comenzando un nuevo proceso
Usted comenzará el ciclo de desarrollo de un proceso comenzando LookoutDirect, colocando un
nombre a su proceso, y creando su primer panel de control.

Nota: La primera vez que se comienza una versión de desarrollo de LookoutDirect, la cuenta del
administrador no tiene ninguna contraseña. En cualquier momento que la cuenta del administrador no tiene
contraseña, LookoutDirect se abre como administrador activo, sin requerir ninguna conexión. Esto es una
conveniencia para cuando se creen procesos de LookoutDirect, pero es mejor asignar una contraseña a la
cuenta del administrador antes de permitir a otros que no deban tener privilegios de administrador de usar
su copia de LookoutDirect. Vea como crear una cuenta más adelante en esta sección, para más información.

1. Haga clic en Start>Programs (Comienzo>Programas). Seleccione DirectSOFT32>
LookoutDirect Tools, y después haga clic en  LookoutDirect.

Aparece la pantalla principal de LookoutDirect. Cuando usted comienza un nuevo proceso,
LookoutDirect se abre en el modo de modificación (Edit mode).

2. Seleccione File>New.

Aparece el cuadro de diálogo Create Process.

3. En el cuadro Process Name, teclee  Tratamientoagua. Éste es el nombre del proceso de
ejemplo.

4. Teclee OK.
·   Aparece el cuadro de diálogo New Control Panel. Note que el panel de alarmas aparece en

el fondo de la pantalla principal.
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5. En el campoo Name, teclee PNLprincipal.
Éste es el nombre del objeto del panel de control. 

En la caja de Title (título), teclee  Principal. Éste es el título que aparecerá en la parte
superior del panel de control. El panel de control que usted creó sirve como plataforma en la
cual usted construirá y organizará el proceso.

Deje las propiedades restantes del cuadro de diálogo como están. Usted tendrá la oportunidad
de cambiar la manera que el control se vé más adelante en este curso.

Sugerencia Comience el nombre de cada objeto que usted crea con la abreviatura de dos o tres
letras para el tipo de objeto. Por ejemplo, la abreviatura  PNL se utiliza arriba para señalar  el
objeto panel. Si consistentemente usa esta convención de nombrar el obejto, usted podrá
localizar rápidamente objetos en el árbol de proceso del directorio que usted utilizará a través de
los tres cursos.

6. Teclee OK.

Aparece el nuevo panel de control Principal. Maximice el panel de control. Observe
que el título del panel de control se mueve a la barra del título de la ventana.

7.  Seleccione  Alarms>Display Options y configure el estilo de la ventana a Bottom y  la altura
de la ventana a 5  líneas.

Esto establece la localización y la cantidad de líneas de la ventana de alarmas.

Nota  Si la PC en la cual usted está creando un proceso no tiene la misma resolución del monitor que la  PC(s)
en el cual el proceso estará funcionado, configure la resolución del monitor de la PC de desarrollo a la misma
resolución del monitor de proceso a la resolución más baja en la cual usted espera que el proceso sea
mostrado .



Agregando un objeto  
Agregar objetos es la ación básica de construir un proceso en LookoutDirect. En esta parte, usted
comenzará agregando un objeto potenciómetro al nuevo panel de control. El potenciómetro será usado
para controlar el nivel de agua en un tanque simulado.

1. Seleccione Object >Object Explorer.

Aparece el cuadro de diálogo de Object Explorer . Note que el nombre de proceso Tratamientoagua
aparece en la estructura de archivos.  Arrastre el Object Explorer al lado derecho del panel de control
para mantenerlo apartado del panel de control.

Nota: ·El Object Explorer suministra una localización única, conveniente, desde donde usted puede tener
acceso y modificar el objeto que usted agrega a sus procesos de LookoutDirect. Vea al capítulo 4, Como
comenzar con LookoutDirect, Object Explorer para mas información de como usar el explorador del objetos.

2. Haga clic con el botón derecho en tratamientoagua, y seleccione New object. Aparece el
cuadro de diálogo Select object class.
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Haga clic con el botón derecho aquí para
obtener el cuadro de diálogo Select
Object Class 



3. Haga clic doble en la carpeta de Control, y después navege  la lista de objetos y destaque el
objeto Pot (potenciómetro).

La información de cualquier objeto que usted destaque (antes de seleccionar), en este caso el
objeto  potenciómetro, aparece a la derecha del cuadro de diálogo.

Nota  Desmarcando el cuadro de verificación de Categorize, situada en la parte superior  del cuadro de diálogo
Select Object Class, cambia el directorio del objeto desde un formato de carpeta a un formato continuo de
lista. Cuando está mostrado en un formato de lista, los objetos pueden ser encontrados tecleando la primera
letra del nombre del objeto. Cuando esté más familiarizado con los nombres de una cantidad de objetos,
usted encontrará esto útil para localizarlos de este modo.

4. Teclee OK.

Aparece la caja de diálogo Select location for new Object. El cuadro de diálogo muestra la
estructura de su red en un formato de árbol de directorios. En este ejemplo el nombre de su
computadora y del proceso tratamientoagua debería estar visible en el árbol del directorio.

5. Seleccione tratamientoagua, y después haga clic en OK.

Aparece el cuadro de diálogo de propiedades para el nuevo objeto potenciómetro.

6. Complete las propiedades del cuadro de diálogo.

Tag (Etiqueta) : POTNivelsim
Éste es el nombre del nuevo objeto potenciómetro.Observe que comenzamos el nombre del
nuevo objeto con la abreviatura de las tres letras de Potenciómetro.
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Mínimum y máximum: 0  y  50 respectivamente.

Para este objeto, los valores mínimo y máximo que usted entra representan el rango del
potenciómetro.

·  Resolución:  0.1
7. Deje las propiedades restantes del cuadro de diálogo como están y haga clic en OK.

8. Seleccione el nuevo objeto del árbol del explorador de objetos, y después arrástrelo y suéltelo
sobre el panel.

Aparece un cuadro de diálogo que contiene el gráfico que se puede utilizar para representar
el nuevo objeto del potenciómetro.

9. Seleccione el accionador vertical de potenciómetro y después haga clic en OK.

El nuevo objeto potenciómetro aparece en el panel de control.

Pruebe el potenciómetro nuevo con  Ctrl  +  espacio para salir o entrar del modo
Edit y luego haga clic y arrastre el accionador hacia arriba y hacia abajo con el puntero del
mouse. Vuelva al modo Edit cuando haya terminado.



Creando y trabajando con expresiones 
Ya que el objeto potenciómetro POTNivelsim tiene un rango numérico asociado, usted
puede representar visualmente el rango usando una expresión. Para este ejemplo, se creará una
expresión gráfica en la forma de un gráfico de barras y una expresión numérica en la forma de
un indicador digital.

1. Haga clic en Insert>Expresion.

Aparece el cuadro de diálogo Insert Expresion. El cuadro de diálogo Insert Expresion le
proporciona un método conveniente para localizar objetos y sus miembros de datos y para
copiarlos en una sola expresión.

2. Amplíe el árbol del directorio de la red en su PC haciendo clic en el símbolo + al lado
derecho del archivo tratamientoagua hasta que la lista de objetos en el proceso
tratamientoagua sea revelado y luego seleccione PotNivelsim.

Sugerencia Al hacer el proceso tratamientoagua la raíz del árbol del directorio, usted puede
evitar de tener que ampliar el árbol varias ocasiones, cada vez que desea seleccionar un objeto.
Para hacer el proceso tratamientoagua la raíz del árbol, haga clic en el botón derecho en
tratamientoagua y seleccione Make Root.

3.  Deje las propiedades restantes del cuadro de diálogo como están y haga clic en Paste (copie!).
POTNivelsim aparece en el campo amarillo de la expresión.

4.  Haga clic en OK.

Aparece el cuadro de diálogo Display numeric signal. Aparece este cuadro de diálogo
particular porque la propiedad tipo de exhibición, seleccionada por defecto en el cuadro de
diálogo Insert Expression, fue configurado como numérico. LookoutDirect le permite
seleccionar las propiedades de exhibición de las señales numéricas.

5. Termine el cuadro de diálogo Display numeric signal. 

Display Style (Estilo de la Exhibición):  Barra (para arriba) 

Bar Color (Color de la barra):  azul obscuro 

Mínimo y máximo: 0  y  50  respectivamente.

Observe que estos valores corresponden al rango que usted seleccionó previamente para el
objeto POTNivelsim.
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6. Deje las propiedades restantes del cuadro de diálogo como están y haga clic en OK.  El gráfico de barras
aparece en el panel de control.

Creando un indicador digital 
1. Seleccione el gráfico de barra, mantenga la tecla SHIFT (tecla de mayúsculas) apretada, y

luego arrastre el gráfico de barras en cualquier dirección y suéltelas.

Se crea una copia del gráfico de barras. Duplicar objetos de este modo es una manera
conveniente de crear nuevos objetos.

2. Haga clic en el botón derecho en el gráfico de barras duplicado y luego seleccione Display
Properties (propiedades de exhibición).

3. En la caja de grupo  Display style (estilo de exhibición), haga clic en Digital y después haga
clic en OK.

El formato de representación de la expresión duplicada cambia de un gráfico de barras a una
lectura digital. La lectura se exhibirá inicialmente como "####". Aumente la caja de
presentación de la lectura, arrastrando una esquina, para exhibir correctamente el valor
numérico y cambie el font a 20 y el formato numérico a 0.0.

4  Mueva el nuevo indicador digital a la derecha del gráfico de barras.

Salga fuera del modo de Edit, y después mueva el accionador del potenciómetro hacia arriba y
hacia abajo con el puntero del mouse para ver la función gráfica de ambas expresiones.  

La barra y el número cambiará de acuerdo a la posición del accionador del potenciómetro.
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Salvando el  proceso
Como con cualquier aplicación, es una buena idea salvar a menudo el proceso creado. 

1. Seleccione  File > Save.

Aparece el diálogo Select process to Save con el proceso tratamientoagua, el único abierto,
destacado.

2.Haga clic en OK y después haga clic en Save para salvar el proceso en el nombre de
tratamientoagua.l4p.

Conectando Objetos 
Anteriormente  en este curso, usted creó el objeto POTNivelsim y mostró gráficamente su valor
en un punto fijo en el tiempo usando un gráfico de barras. En esta parte del curso, usted creará
un objeto hypertrend que supervise el estado del objeto y mostrará POTNivelsim, en tiempo
real, su valor en la forma de una línea de gráfico en un registrador simulado.

Para comenzar, usted creará un objeto hypertrend, y después le asigna la señal del objeto
POTNivelsim al hypertrend. Para permitir al hypertrend exhibir la actividad del objeto
POTNivelsim, usted activará el registro en tiempo real de la señal POTNivelsim a una base de
datos histórica.

Cree el objeto Hypertrend 
1. En el Object Explorer, haga clic en el botón derecho en tratamientoagua y luego seleccione

New Object (nuevo objeto).
2. Localice y seleccione el objeto HyperTrend desde el árbol del directorio, debajo de Display

y  después haga clic en OK.

3. Seleccione el proceso tratamientoagua y haga clic en OK. 

Aparece el cuadro de diálogo Create HyperTrend.

4. En la caja de texto Name, teclee  HT tanque.

5. Haga clic en Add Group.

Aparece el cuadro de diálogo Add Group. La función del grupo le  permite que organice y que
exhiba lógicamente señales múltiples al mismo tiempo. En este ejemplo sin embargo, usted
agregará solamente una señal al grupo.

6. En la caja de texto Name, teclee  HT tanque, seleccione el azul obscuro como el Grid
color (color de la rejilla), y después haga clic en OK.

Agregue una señal al registrador gráfico Hypertrend 
1. Haga clic en Add Item en el cuadro de diálogo Create Hypertrend..

Aparece el cuadro de diálogo Add
Item. Las propiedades de este cuadro
de diálogo definen el origen de la señal
que usted está agregando al grupo
Nivel_agua_Tanque.
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2. Haga clic  el botón derecho en el campo verde
URL =.

Aparece el cuadro de diálogo URL Editor. El
cuadro de diálogo URL Editor se utiliza para
localizar rápidamente el origen de una señal
remota.

3. Amplíe el árbol del directorio, seleccione  el
objeto POTNivelsim, y haga clic en Paste.

El URL para  el objeto POTNivelsim se copia
en el campo verde del URL.

4. Haga clic en OK.

Aparece el origen, o el URL, de la señal POTNivelsim en el URL field del cuadro de diálogo
Add Item.

5. Seleccione rojo como el color para Line Color (color de línea), y después haga clic en OK.

El nuevo artículo se agrega al grupo de WaterTankTrend en el cuadro de diálogo Create
HyperTrend.

6.Haga clic en OK, y después seleccione el nuevo objeto del árbol del Object Explorer
(explorador de objetos) y arrástrelo y suéltelo sobre el panel.

Aparece un cuadro de diálogo que contiene los gráficos que se pueden utilizar para representar
el nuevo objeto.

7. Seleccione el gráfico deseado y haga clic en OK.

El nuevo registrador gráfico virtual  aparece en el panel de control.

8  Arrastre el nuevo registrador a la izquierda, y después modifique el tamaño arrastrando una
de las esquinas.  Ud. debe tener un panel como el mostrado en la próxima figura.
Los objetos que usted ha agregado al panel de control pueden parecer  ahora fuera de
proporción o mal arreglados. Usted limpiará el panel de control más adelante en este curso.
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Active la base de datos histórica
Si usted sale fuera del modo Edit  (Ctrl + Shift) y ajusta el nivel del objeto POTNivelsim,
usted notará que una línea del grafico no aparece en la carta hypertrend.  Para que la línea del
gráfico aparezca, usted debe primero activar el registro de datos en tiempo real del objeto
POTNivelsim a una base de datos histórica.

1. Vaya de nuevo al modo Edit y luego haga clic del botón derecho en el objeto POTNivelsim
en el explorador de objetos.

Aparece el cuadro de diálogo de Edit Object database (Modificación de la base de datos de
objetos).

2. Haga clic doble en el objeto POTNivelsim y luego en Edit Database .

Aparece el cuadro de diálogo de la base de datos. El título del cuadro de diálogo refleja el
nombre del objeto que usted está modificando.

3. En la caja de grupo Filter Group, teclee  0.1 para el desvío.

4. Haga clic en Log to historical database para marcar el cuadro(registro de base de datos
histórica). 
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5. Haga clic en Save, y después Quit.

Para probar el nuevo objeto hypertrend, salga del modo Edit y mueva el accionador del
potenciómetro hacia arriba y hacia abajo. Cuando mueve el accionador, aparece una línea roja
del gráfico que representa la señal del objeto POTNivelsim como línea de gráfico en el
registrador gráfico.

Creando interacciones útiles entre objetos
Para agregar un grado de automatización al proceso, usted ahora creará un segundo objeto
potenciómetro, esta vez en la forma de un selector de tres posiciones  manual-OFF-automático
(HOA); un objeto neutralzone que supervisará una banda muerta predeterminada del objeto
POTNivelsim y una expresión lógica que tomará la forma de un símbolo gráfico de una bomba
roja o verde y que tendrá como sus variables, miembros de datos de objetos del selector HOA
y del neutralzone. 
Juntos, estos objetos crearán una funcionalidad tal que encenderá automáticamente la bomba
(según lo simulado por nuestra expresión lógica) solamente cuando el interruptor HOA esté en
la posición automática y el POTNivelsim (nuestro nivel simulado del tanque de agua) esté entre
40 y 46.

Cree el selector Manual-OFF-Automático 
1.Utilice el explorador de objetos para agregar un nuevo objeto potenciómetro al proceso

tratamientoagua.

Después de que usted seleccione el proceso tratamientoagua como la localización para el
nuevo objeto, aparece el cuadro de diálogo New Potentiometer (nuevo potenciómetro).

2. Complete el cuadro de diálogo del New Potentiometer:

Name (nombre) : POTHOA 
Mínimo: 1 
Éste es el extremo inferior del rango del potenciómetro.
Máximo:  3 
Éste es el alto extremo del rango del potenciómetro.
Resolución:  1 

Utilizamos uno como la resolución del potenciómetro puesto que queremos que el rango del
potenciómetro sea dividido en segmentos en tres partes: manual, OFF, y automático.

Deje las propiedades de cuadro de diálogo como están.
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3. Haga clic en OK.

4. Seleccione el nuevo objeto del árbol del explorador de objetos, y después arrástrelo sobre el
panel.
Aparece el cuadro de diálogo Insert (POTHOA). 

5. Seleccione el gráfico knob (perilla), y después haga clic en OK.

6. Arrastre la perilla a un área abierta en el panel de control.
Salga fuera del modo Edit y pruebe el nuevo selector de tres posiciones. 

Por ahora, dejaremos las posiciones del interruptor sin rótulos. Más adelante en el curso
agregaremos las placas de identificación descriptivas para ayudar a identificar cada posición del
interruptor.

Cree el objeto Neutralzone 
1. Utilice el explorador de objetos para agregar un nuevo objeto Neutralzone al proceso

tratamientoagua.

Después de que usted seleccione el proceso tratamientoagua como la localización para el nuevo
objeto, aparece el cuadro de diálogo Create Neutralzone.

2. Termine el cuadro de diálogo Create Neutralzone.
Nombre: NZPumpAuto 
Éste es el nombre del nuevo objeto.
Señal: POTNivelsim
Esto señala que es el valor del objeto POTNivelsim que se está asignando una zona neutra
(banda muerta).

Sugerencia si nuestro proceso del ejemplo es complejo, y usted no está seguro de la localización
o nombre exacto del objeto POTNivelsim, usted podría hacer clic en el botón derecho en en la
caja de texto amarilla para  exhibir Expression Editor (Editor de  expresión).

Usando el editor de expresión, usted podría localizar el objeto POTNivelsim (señal) y después
utilizar la función Paste.
High límit (limite superior): 46 

Low Limit (Límite bajo):      40
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3. Haga clic en OK

Cree la expresión lógica
1. Seleccione Insert>Expression.

Aparece el cuadro de diálogo Expression Editor (redactor de expresión).

2. En la caja de texto amarilla de la expresión, teclee 

·               POTHOA = 1 or (POTHOA = 3 and NZPumpAuto.below).
Esta expresión coloca una condición tal que la bomba funcionará solamente si el selector
HOA está en la posición 1 o  en la posición tres (automático)  y  el nivel del tanque está dentro
de la banda muerta (Neutralzone).

3. Haga clic en OK.

Aparece el cuadro de diálogo Display logical signal (Muestre la señal lógica) porque el tipo
de exhibición por defecto para una expresión es una señal lógica. De este cuadro de diálogo
se puede seleccionar cómo quiera que sea mostrado el resultado lógico de la expresión.

4. Haga clic en  Custom, y después haga clic en  la caja gráfica ON.

Aparece el diálogo Select Graphic.
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5.Navegue a la carpeta Pumps (bombas) y luego haga clic doble en el gráfico de la bomba verde
Pmp_3gn.wmf.

El gráfico de la bomba aparece en  el cuadro de diálogo Display logical signal  como  el gráfico
ON. 

6. Haga clic en la caja de grupo gráfica  OFF y luego haga clic doble en el gráfico de la bomba
roja  Pmp_3rd.wmf.

Ahora se puede seleccionar ambas cajas de grupo gráficas ON y OFF .

7. Haga clic en OK.

Aparece el gráfico verde de la bomba  en el panel de control.

8. Arrastre la bomba a la derecha del panel de control.

Para probar la nueva funcionalidad, salga del modo Edit y arrastre el accionador en el selector
POTHOA con el puntero del mouse desde la posición izquierda (posición 1 o manual) a la
posición del mediodía  (posición  2 u OFF) para ver el cambio gráfico de la bomba del verde
al rojo. 

Ahora arrastre el accionador a la posición a la derecha (posición 3 o automática), y después
deslice el potenciómetro POTNivelsim hacia arriba y hacia abajo. El gráfico de la bomba debe
hacerse verde cuando el POTNivelsim está entre 40 y 46.

Manual de cómo comenzar LookOutDirect3–16

Capítulo 3:  Como comenzar con LookoutDirect

1

2

3

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D



Manual de cómo comenzar LookOutDirect 3–17

Capítulo 3:  Como comenzar con LookoutDirect

1

2

3

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D

Completando el panel de control 
Ahora que se ha creado la funcionalidad para el proceso tratamientoagua, el panel de control
debe parecerse a la ilustración siguiente.

Para hacer el panel de control intuitivo y fácil de usar, ahora se ajustará el tamaño y se
arreglarán los objetos y se agregarán varios gráficos, placas de legenda y  escalas.

Ajustando el tamaño y arreglando objetos en el panel  de control 

1. Asegúrese de que usted esté en el modo Edit y luego seleccione el registrador gráfico
HyperTrend y ajuste el  tamaño de modo que tome aproximadamente la mitad del panel de
control.

2. Arrastre el registrador gráfico al lado izquierdo del panel de control.

3. Seleccione, ajuste el tamaño, y arregle cada uno de los objetos restantes hasta que su panel de
control parezca similar a la ilustración  que sigue.



Agregando símbolos gráficos 
1. Seleccione Insert>Graphic, abra la carpeta Tanks, y haga clic doble en el gráfico
Tank1_A.wmf.
El gráfico del tanque aparece en el panel de control.  El gráfico del tanque servirá como
plantilla sobre el gráfico de barras que da el aspecto de que el nivel del agua sube y baja en el
tanque.

2. Ajuste el tamaño del gráfico de barras y el tanque hasta que la porción azul del gráfico de
barras llene el tanque en su punto más ancho. Usted puede necesitar salir al modo Edit y
ajustar  el potenciómetro POTNivelsim para comprobar la configuración del tanque sobre el
gráfico de barras.

3.Mueva el indicador digital  del POTNivelsim al centro del tanque.

Cuando complete ésto, su panel de control debe parecer similar a la ilustración siguiente.
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Agregando etiquetas
En este procedimiento usted creará las placas de legenda para etiquetar las tres posiciones del
selector HOA.

1. Seleccione Insert>Text/Plate/Inset.

Aparece el cuadro de diálogo Inset>Text/Plate/Insert. Utilice este cuadro de diálogo para
diseñar etiquetas  y para agregar un fondo al panel de control. Las opciones de diseño
disponibles incluyen  cambiar el estilo de la placa de fondo: tipo, color, y tamaño  y
justificación del texto.

2. En la caja de texto, teclee manual, y después seleccione negro para el color del texto.
Mientras usted teclea, el texto aparece en la ventana de la inspección en el font de texto por
defecto (10 pintas.Arial, en negrilla).

Usted puede experimentar con otros fonts, colores de fondo y  estilos de marco o usted puede
aceptar las configuraciones por defecto.

3. Teclee OK.

4. Arrastre la placa nueva de texto al lado izquierdo del selector HOA.

5. Con  el método de tecla Shift + arrastre, haga dos copias duplicadas  de la placa de texto
manual, y después mueva una de las placas de texto a la parte superior del selector HOA y la
otra a la derecha del selector HOA.

6. Cambie el texto de la placa media del texto a OFF y el texto de la placa derecha a Auto,
haciendo clic derecho en cada placa de texto, seleccionando Display properties
(características de exhibición) y después corrija el contenido de la caja de texto.

7. Para hacer más fácil colocar en la posición deseada el selector HOA  y las placas de texto,
arrastre una caja alrededor de los cuatro objetos y luego seleccione Arrange >Group.
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Agregando escala a objetos 
Realce la utilidad del objeto registrador gráfico hypertrend y del potenciómetro de POTNivelsim
agregando barras de escala.

1. Seleccione Insert>Scale.

·   Aparece el cuadro de diálogo Insert Scale. 

2. Termine el cuadro de diálogo.
Caja de grupo Orientation:  Right side (derecha), estilo Increasing up define la orientación.

·   Mínimo: 0 

·   Máximo: 50 

Mayor unit (Unidad Importante): 10 

Minor Unit (Unidad de menor importancia): 2.5 

3. Deje las otras características como están y haga clic en OK.
4. Arrastre la nueva escala a la derecha del registrador gráfico hypertrend y ajuste el tamaño para

alinear con la parte superior e inferior del registrador.

Para tener más lugar a la derecha del registrador, usted ahora cambiará las propiedades de
exhibición del potenciómetro POTNivelsim de un accionador vertical a un accionador
horizontal y agregará una escala a ella.

5. Haga clic derecho en el potenciómetro POTNivelsim y seleccione Display properties
(características de exhibición).

6. Seleccione el accionador horizontal (Horizontal slider), y después haga clic en OK.

7. Mueva el accionador horizontal para abajo y ajuste el tamaño al ancho del registrador.

8. Duplique la escala usada a la derecha del registrador, cambie las propiedades de exhibición de
la escala a Bottom, increasing right (abajo, aumentando a la derecha), muévalas debajo del
accionador horizontal, y después ajuste el tamaño de la escala para caber el accionador.



Para practicar, termine de complementar el panel de control con lo siguiente:

• agregue placas de texto, sin cualquier texto, detrás del selector HOA y del accionador
horizontal, 

• Coloque un texto de etiqueta del registrador, 

• Ajuste el tamaño y arregle el tanque sobre el grupo del selector HOA

• remueva la placas desde las etiquetas de posición del selector HOA

• mueva del indicador digital del POTNivelsim dentro de la parte superior del gráfico del
tanque, y 

• cree y coloque una placa grande de texto, sin texto, detrás de todos los objetos en el panel
de control usando los comandos suministrados en el menú Arrange (Arregle).

Cuando está acabado, su panel de control debe parecer similar a la ilustración siguiente.

Manual de cómo comenzar LookOutDirect 3–21

Capítulo 3:  Como comenzar con LookoutDirect

1

2

3

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D



Manual de cómo comenzar LookOutDirect3–22

Capítulo 3:  Como comenzar con LookoutDirect

1

2

3

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D

Agregando alarmas 
Para terminar el curso básico, usted ahora agregará funciones de alarmas al proceso
tratamientoagua. Usted creará una alarma simple y una alarma generada por la base de datos. 

Una alarma simple es un objeto de alarmas que se activa solamente cuando se cumple una
condición en un parámetro de alarma específico. 
Una alarma generada por la  base de datos se diferencia de una alarma simple en que puede
utilizar el valor o la condición de uno o más miembros de datos de un objeto existente para sus
parámetros de activación.

Por propósitos de organización se pueden clasificar alarmas en áreas. Estas áreas de alarmas le
permiten a los operadores filtrar grupos de alarmas y reconocer alarmas de acuerdo a areas.
LookoutDirect tiene varias áreas por defecto o tambin se pueden crear áreas 

Cuando se crea una área de alarma, LookoutDirect crea una carpeta en el objeto global $Alarm
para mantener esas alarmas. Una de las áreas es el área LookoutDirect.

Creando una alarma simple
1. Utilice el explorador de objetos para agregar un nuevo objeto Alarm (alarma) al proceso

tratamientoagua.

Aparece  el cuadro de diálogo Create Alarm (crear alarmas) .

2. Complete el cuadro de diálogo.
Nombre: Alarm Man Mode
Alarm Area: Lookoutdirect 
Message: "bomba en modo manual"
Éste es el mensaje que aparecerá en el panel de alarma. Note que el texto del mensaje se debe
incluir entre comillas.
Condition: POTHOA=1
Esta expresión simple especifica que la alarma se debe activar cuando el selector POTHOA
está en la posición manual .

3. Deje las otras características como están y haga clic en OK.

Salga fuera del modo Edit y coloque el interruptor POTHOA en Manual.  La alarma que usted
ha creado se debe activar. Para silenciar esta alarma, haga clic derecho en el panel de alarmas y
seleccione Acknowledge All (reconozca todas las alarmas). Usted puede incorporar un
comentario para la alarma o solamente haga clic en OK.



Creando una alarma generada por la base de datos
1. En explorador de objetos, en el proceso tratamientoagua, Haga clic en el botón derecho en el

objeto POTNivelsim y  luego seleccione Edit database. 

Aparece el diálogo de la base de datos para el objeto POTNivelsim. 

2. Complete las propiedades de la caja de grupo Alarm Conditions (condiciones de alarma). 
• Área:  Lookoutdirect
• HiHi:  48, prioridad  8 
• Hi:  42, prioridad  6
• Lo:  22, prioridad  5 
• LoLo: 10, prioridad  7 
• Deadband:  3 

Estas características especifican que debe activarse una alarma cuando el valor numérico del
objeto POTNivelsim es  48, 42, 22, o 10. 

3. Haga clic en Update y luego Quit.

Salga fuera del modo Edit y mueva el potenciómetro hacia uno y otro lado. Mientras que el
valor numérico del objeto POTNivelsim cambia, cada alarma se activa correspondientemente. 
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Curso de PLC conectado 
Si usted ya ha instalado su PLC y las comunicaciones están establecidas entre el PLC y la PC
donde está funcionando LookoutDirect , este curso demostrará la capacidad de leer y de escribir
datos numéricos con LookoutDirect desde su PLC. Si usted no ha configurado ya su PLC o no
ha establecido comunicaciones entre el PLC y la PC que tiene funcionando LookoutDirect, vea
al Apéndice B.

Los ejemplos en este curso muestran los tipos siguientes de conexión entre LookoutDirect y su
PLC.

• Como usar un interruptor virtual para accionar ON y OFF a una salida discreta del PLC.
• Como escribir un valor numérico a un registro del PLC, y después leer el valor de vuelta y

mostrarlo en la forma de una línea virtual en el registrador gráfico. 

• Como leer una señal discreta desde el PLC y usar una expresión gráfica para mostrar el
estado de la señal con la ayuda de un indicador luminoso y 

• Como usar un contador digital para mostrar el número de barridos desde la última vez que
se energizó el PLC o hubo una transición  del modo Program para Run.

El archivo de proceso del ejemplo usado para este curso se puede encontrar en 

C:\DirectSoft32\Projects\Examples\LookoutDirect\ConnectedTour.l4p.

Vea el curso básico para información sobre cómo crear y manejar objetos usando LookoutDirect.

Accionando una salida discreta del PLC
En este ejemplo, usted creará un objeto driver, y después conectará el objeto a una salida discreta
en su PLC usando una conexión nueva o existente. Para probar la conexión entre el objeto
driver y su PLC, usted creará un objeto switch (interruptor) para accionar  la salida discreta. Para
indicar el estado de la salida en el panel de control, usted creará una expresión lógica en la forma
de un indicador luminoso.

Creando el objeto del driver

1. Cree un nuevo proceso. Utilice ConnectedTour como el nombre de etiqueta y
PNLConnectedTour como el título del panel de control.

2. Seleccione Object>Object Explorer.

Mueva el diálogo “explorador de objetos” a la derecha de la exhibición.

3. Use el explorador de objetos para agregar un nuevo objeto driver DirectLogic al proceso
ConnectedTour.

Aparece el diálogo Create  DirectLogic como en la primera figura de la próxima página.

4. Coloque el nombre del objeto driver como DRConnectedTour, y después haga clic en el botón
de 3 puntos a la derecha de la caja de texto de Comm Link.. (Vea la figura siguiente)

Nota:  cuando usted cree sus propios objetos driver, use el prefijo DR para identificar el objeto como un driver
y nombre la CPU de su PLC como el sufijo de la etiqueta.



Aparece el cuadro de diálogo Select Link (seleccione conexiones).

5. Haga una de las acciones siguientes:.
• Si la caja de lista de Links (conexiones) contiene los puentes de comunicaciones activos

encontrados por el mago de conexiones durante el proceso de instalación, destaque la
conexión que usted desea usar.

• Si no hay una conexión activa disponible, o, si usted no desea usar una de las conexions
activas, haga clic en Add, y luego siga las instrucciones suministradas en el Link Wizard
(mago de conexiones). Haga clic en Finish para cerrar al mago.

6. En el cuadro de diálogo Select Links, haga clic en Select.

Aparece el nombre de la nueva conexión en el campo de texto Comm Link.

7. Haga clic en OK, y después corresponde crear el objeto interruptor. 

Creando el objeto Switch (interruptor)
1. Use el explorador de objetos para agregar el nuevo objeto Switch (interruptor) al proceso

ConnectedTour.

Aparece el cuadro de diálogo New switch (nuevo interruptor).
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2. Coloque el nombre SWsalidadiscreta al interruptor, y después haga clic en OK.

Aparece el cuadro de diálogo Display switch (Muestre un interruptor).

3. Seleccione una de las opciones de interruptor estándares, y después haga clic en OK.
Aparece el interruptor en el panel de control ConnectedTour. 

4.  Continúe con las instrucciones de más abajo. 

Ligando el objeto del interruptor a una salida del PLC 
1. En Object Explorer (explorador de objetos), haga clic el el botón derecho en el objeto

DRConnectedTour y luego seleccione Edit Connections (modifique la conexión).

Aparece el cuadro de diálogo de conexiones para el objeto driver.
2. En la lista Writable Members (miembros escribibles), haga clic doble en el miembro Y0. Si

el miembro Y0 está en uso, seleccione a cualquier otro miembro disponible y escribible de
datos y luego haga clic en el botón Select. (En este caso es Y5)

3. En la caja de grupo Signals (señales), navegue con el árbol del directorio al proceso
ConnectedTour y luego haga clic doble en SWsalidaDiscreta.

Mire en el centro del cuadro de diálogo de conexiones. Note que la conexión entre el objeto del
driver y el interruptor está definida como: 

DRConnectedTour.Y5 = SWsalidadiscreta.

4. Haga clic en Accept, y después Quit..
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Creando un indicador luminoso 
1. Seleccione Insert>Expression,  seleccione SWsalidaDiscreta del árbol del directorio, haga clic

doble en el campo Contents y luego haga clic en OK.

Aparece el cuadro de diálogo exhibición de la señal lógica.

2. Haga clic en Costum, y después haga clic en la caja de grupo ON.

3. Abra la carpeta Indicators y luego haga clic doble  en la luz verde nombrada  Light0G.wmf.

4. Haga clic en la caja de grupo OFF y luego haga clic doble  en la luz roja nombrada
Light0R.wmf.

5. Haga clic en OK

Aparece el indicador luminoso que representa la expresión lógica.

Salga fuera del modo Edit y pruebe la conexión  entre el objeto interruptor de LookoutDirect
y el PLC. 

Cuando el interruptor está encendido, la salida LED en el PLC y el indicador virtual en el
panel de control debe encenderse. Si la conexión no trabajó y ocurrió un error de alarma,
compruebe la conexión desde la PC al PLC. Si la conexión no trabajó y no ocurrió ningún
error de alarma, hay un problema con la configuración de la conexión. 

Repase este procedimiento y confirme que la conexión fue configurada correctamente.
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Escribiendo y leyendo un valor numérico 
En este ejemplo, usted utilizará un objeto potenciómetro, en la forma de una entrada digital,
para escribir un valor numérico al PLC. Para confirmar que los datos se están escribiendo al
PLC, usted creará un objeto hypertrend para leer y para exhibir los valores numéricos enviados
al PLC.

Creando el objeto potenciómetro
1. Cree un nuevo objeto  potenciómetro digital. Utilice los valores siguientes para completar el

cuadro de diálogo nuevo potenciómetro.
• · Name: PotNumRWTest
• Min: 0
• Max: 9999 
•   Resolution: 1

2. Haga clic en OK.

Conectando el objeto potenciómetro con  el PLC
1. En el diálogo explorador de objetos, haga clic derecho en el objeto DRConnectedTour y luego

seleccione Edit connection.

2. En la lista de miembros escribibles, haga clic doble  en V1400-7377. V1400 aparece en la caja
de la selección. 

3. Substituya la selección V1400 por V2000.

Nota:  Se utiliza el registro V2000 puesto que es común a todos los PLCs DirectLogic  .

4. En la caja de grupo Signals (señales), haga clic doble en el objeto PotNumRWTest.
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5. Haga clic en Accept, y después Quit.
Aparece el nuevo potenciómetro digital en el panel de control. 

Creando el objeto Hypertrend
1. Cree un nuevo objeto hypertrend nombrado HyperRWTest.

2. Agregue un grupo al hypertrend. Use los valores siguientes para completar  el cuadro de
diálogo Add Group.
• Name (Nombre): RWTest 
• Major Increments (Incrementos importantes): 10 
• Minor Increments (Incrementos de menor importancia):  1 

3. Agregue un artículo al grupo RWTest. Utilice los valores siguientes para completar el cuadro
de diálogo Add Group (Agregue un grupo).
• Mínimo Numérico: 0 
• Máximo Numérico: 9999 

4. Haga clic en el botón derecho en el campo URL =.

5. En el cuadro de diálogo URL Editor (redactor de URL), destaque DRConnectedTour y luego
haga clic doble  en V1400-7377 en el campo Contents (contenido).

6. En la caja de texto URL, substituya V1400 por V2000, y después haga clic en OK.

7. Haga clic en OK en las cajas de diálogo  Add Item y Create  HyperTrend. Aparece el nuevo
objeto hypertrend en el panel de control.
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8. Active el registro de datos para el nuevo objeto hypertrend. Seleccione Object>Edit Database
y seleccione el objeto DRConnectedTour.

9. En la lista Native members (miembros nativos), haga clic doble  en V1400-1737, substituya
V1400 por V2000, y después actualice el cuadro de diálogo de la base de datos.

• Deviation: 0.
1

• Log to Historical Database (Registro a base de datos histórica):  selected.

10. Haga clic en Update y luego Quit.
Pruebe la conexión entre el potenciómetro y el PLC saliendo del modo Edit, haciendo clic en
el objeto potenciómetro, y entrando un nuevo valor. El objeto hypertrend muestra el cambio al
valor entrado. 

Lectura de una señal discreta
En el ejemplo anterior, usted podía activar una salida discreta de un PLC usando el objeto
interruptor. En este ejemplo, usted leerá una señal discreta del PLC y exhibirá el estado usando
un objeto indicador luminoso.

1. Seleccione Insert>Expression.

2. En el cuadro de diálogo Insert>Expression, haga clic doble en el objeto DRConnectedTour.
3. Corrija el campo amarillo de la expresión de modo que la expresión muestre:  

DRConnectedTour.SP4 y luego haga clic en OK.

Nota:    El relevador especial SP4 se refiere a una función especial de relevador en el controlador DirectLogic
que suministra una señal de pulso con un período de un segundo.

4. En la caja de grupo Standard, seleccione cualquier indicador luminoso y después haga clic
en OK.

La expresión lógica, en la forma de indicador luminoso que usted seleccionó, aparece en el
panel de control y comienza a destellar en un intervalo de un segundo.

Para confirmar que la expresión está exhibiendo la señal del relevador SP4, salga fuera del modo
Edit, apague el PLC, y observe que el indicador para de destellar.



Mostrando el número de barridos
En este ejemplo del curso de PLC conectado, usted creará una expresión numérica que muestre
continuamente el total instantáneo del número de barridos realizados por su controlador
DirectLogic.

1. Seleccione Insert>Expression.
2. En el cuadro de diálogo Insert>Expression, haga clic doble en el objeto DRConnectedTour.

3. Corrija el campo amarillo de la expresión de modo que la expresión muestre:
DRConnectedTour.V7765:B, donde ":B"es el modificador de los datos que especifica la
conversión de datos al formato BCD. 
Vea el apéndice B, Modificadores de datos, para más información de como usar modificadores de
datos.

4. En la lista Display type (tipo de exhibición), seleccione Numeric y luego haga clic en OK.

5. En  el cuadro de diálogo Display Numeric Signal, acepte las configuraciones por defecto y
haga clic en OK.

Aparece la lectura numérica en el panel de control y comienza inmediatamente a exhibir el
número total de barridos.
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Curso de funciones avanzadas 

Muchas de las funciones de LookoutDirect, como paneles de control, funciones de alarmas,
servicios de seguridad, etc. son ellas mismas parte de una clase de objetos y pueden, por lo tanto,
ser modificados para requisitos particulares y crear funciones útiles de administración del
proceso.

Este curso le presentará algunas de las propiedades avanzadas de LookoutDirect que usted puede
utilizar para mejorar  y manejar un proceso.

En este curso usted :

• crea botones que permitirán que usted navegue rápidamente entre los paneles de control, 

• importa un gráfico hecho por Ud. en un panel de control de proceso, 

• establece permisos de seguridad para limitar acceso a todos o una parte del proceso y 

• crea un registro de datos para registrar actividades de proceso a una hoja de cálculo 

Este curso asume que usted entiende los conceptos del proceso de desarrollo introducidos en el
curso básico.

Creando botones de navegación entre paneles 
En situaciones donde LookoutDirect está instalado en un panel con celdas táctiles (touch
screen), donde no hay disponible un mouse de la PC, puede ser necesario suministrar medios
de navegación entre los paneles de control de proceso. 

En este ejemplo usted creará un sistema de botones simples que permitan que usted navegue
entre el panel de control PNLConnectedTour y un panel nuevo que usted creará en este ejemplo. 

La segunda porción de este ejemplo explica cómo crear un "panel pricipal" para su proceso.

La funcionalidad creada en este ejemplo se puede encontrar en el archivo de proceso de
ConnectedTour.l4p en la carpeta de ejemplos.

1. Cree un nuevo objeto de panel nombrado PNLNavTest en el proceso ConnectedTour. Dé a
panel el título Prueba de navegación. 

2. Seleccione el panel de control PNLConnectedTour.

3. Cree un nuevo objeto de botón nombrado PBNavTest.  En la caja Button Text, teclee
Prueba de navegacisn.

4. En explorador de objetos, haga clic en el botón derecho en el objeto PNLNavTest y luego
seleccione Edit connection.

Aparece el cuadro de diálogo Edit Connection.

5. En la lista Writable members (miembros escribibles), haga clic doble en activate y luego haga
clic doble  en PBNavTest en el árbol del directorio del grupo Signals (señales).
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Aparece la conexión lógica que usted acaba de crear entre el panel Prueba de navegación y el
botón  de Prueba de navegación en el centro del cuadro de diálogo.

Nota · Tome un momento para repasar la lista de miembros escribibles para aprender sobre otras acciones
que usted puede generar al corregir una conexión.

6. Haga clic en Accept, y después Quit.

Pruebe el botón nuevo de control entre paneles  saliendo fuera del modo Edit y haciendo clic
en el nuevo botón.

Continúe creando un segundo botón para volver al panel del curso de PLC conectado.

7. Con el panel de prueba de navegación todavía seleccionado, cree un nuevo objeto de botón
nombrado PBNavTestReturn.  Teclee  Return para el texto del botón.

8. En explorador de objetos, haga clic en el botón derecho en el objeto PNLConnectedTour y
luego seleccione Edit Connection. 

9. En la lista de miembros escribibles, haga clic doble en activate y luego haga clic doble  en
PBNavTestReturn en el árbol del directorio del grupo de señales.

Aparece  en el centro del cuadro de diálogo la conexión lógica que usted acaba de crear entre
el panel de control Prueba de navegación y el nuevo botón Return.

Salga fuera del modo Edit y pruebe el nuevo botón Re
tu
rn

. 

Creando un panel Home
Para que los usuarios estén seguros  de que no se pierdan al cambiar entre paneles, usted puede
ser que defina un panel principal como su panel de control de inicio, o panel Home o panel con
el menú pricipal de la computadora.

Usted podría conectar al miembro de datos de activar de su panel Home  a
<$Keyboard.Shift.F1>, o talvez con un objeto botón. 

Si está conectado con la tecla de funcionamiento, en cualquier momento que el usuario presione
< Shift-F1 > (no importa qué panel se esté viendo), aparece el panel Home, lo que hace que  el
operador vuelva a un panel de control familiar.



Puede ser que también se quiera que el panel Home se maximice durante el incio. Si usted ha
creado ya un botón para llamar el panel Home, usted puede conectarlo con el miembro de datos
de maximización.

El punto de exclamación (!) manda a LookoutDirect a utilizar el contrario del valor del botón.
En la partida, el botón no se presiona de modo que su valor es FALSO. Pero ya que usted está
usando el contrario del valor del botón, Panel1.maximize es TRUE en la partida. En cualquier
momento que un usuario presione CallHomePb después de que se haga esta conexión, nada
sucede hasta que el botón sea soltado, y en ese momento aparece el panel.

Importando símbolos gráficos 
Aunque la biblioteca de símbolos gráficos de LookoutDirect es muy grande, usted puede desear
de vez en cuando modificar un panel de control para requisitos particulares de proceso usando
sus propios gráficos. 

Usted puede importar gráficos salvados en el formato metafile(.wmf) o el archivo BITMAP
(.bmp)  de Windows. Para inserir su propio símbolo gráfico, primero salve los símbolos gráficos
en C:\DirectSOFT32\Bin\Graphics, y después insiéralo usando el comando Insert>Graphic.

Creando botones de administración de alarmas
Para reconocer más eficientemente alarmas de proceso, usted puede crear  objetos de botón que
pueden reconocer o silenciar una alarma con un solo clic en el mouse. Normalmente, la acción
de reconocimiento y de silenciar las alarmas requiere un procedimiento de varios pasos que se
debe ejecutar desde el menú de alarmas.

La funcionalidad creada en este ejemplo se puede encontrar en el archivo de proceso
ConnectedTour.l4p en la carpeta de ejemplos.

1. Cree dos nuevos objetos de botón, uno nombrado PBAlarmAck con la Rec Alarma como
texto del botón y el otro PBAlarmSilence nombrado con Silencio como texto del botón.

2. En explorador de objetos, haga clic en el botón derecho en el objeto $Alarm y luego
seleccione  Edit Connection.

Aparece el cuadro de diálogo $Alarm>Connections.

3. En la caja de lista de los miembros escribibles, haga clic doble en Ack y luego, en el árbol del
directorio de las señales, haga clic doble en PBAlarmAck.

Aparece la conexión lógica que suministra la funcion de alarma de reconocimiento automático
en el centro del cuadro de diálogo.

4. Haga clic en Accept.
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5. En la caja de lista de miembros escribibles haga clic doble en Silence, y luego en el árbol del
directorio de las señales, haga clic doble en PBAlarmSilence.

Aparece la conexión lógica que suministra la función de silenciar la alarma en el centro del
cuadro de diálogo.

6. Haga clic en Quit.

Objeto para establecer permiso de seguridad
Para prevenir cambios no autorizados o accidentales a su proceso, usted puede restringir el
acceso a objetos específicos de ciertos niveles del proceso usando permisos de seguridad.
Típicamente, los permisos de seguridad se asignan a objetos del tipo de control tales como
potenciómetros, interruptores, etc., pero pueden también ser asignados al proceso en su
totalidad o a un panel de control dentro del proceso. 

Cuando un usuario, que se registra en el proceso en una cuenta válida que contiene el nivel de
seguridad, trata de tener acceso a un objeto con un permiso de seguridad,  se compara el nivel
de seguridad  del usuario con el del objeto, y se concede o se niega el acceso al objeto.

Creando una cuenta de usuario
Complete el procedimiento siguiente para crear cuentas para cuatro usuarios ficticios. 

1. Seleccione Options > User Manager.

Aparece el cuadro de diálogo User Manager. 

2. Seleccione New User (Nuevo Usuario).

Aparece un  cuadro de diálogo New User (nuevo usuario).

3. Cree el primero de los cuatro usuarios completando el cuadro de diálogoNew User. 

Username : User1

Full Name (Nombre): UserOne
Password (Contraseña): 1111 

Condirm password (Confirme la contraseña): 1111 

Security level (Nivel de seguridad) = 1  

4  Haga clic en OK.

Aparece User1 en la ventana User manager.
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5. Repita el paso 2 hasta el  4 para crear las cuentas para los usuarios nombrados User2, User3
y User4.

Use 2222 como contraseña de User2 y asigne un nivel de seguridad 2. 
Continúe esta secuencia para los otros tres usuarios.

Configurando el nivel de seguridad de un objeto 
1. Abra el archivo de proceso BasicSecurity.L4p situado en la carpeta de ejemplos.

Este proceso contiene un panel de control con cuatro objetos simples.

2. Haga clic en el botón derecho en Switch #1 y seleccione Object Properties. 

3. En el cuadro de diálogo Control security level (nivel de seguridad de control), teclee 1.

4. Modifique las propiedades del objeto para cada uno de los tres interruptores restantes,
configurando su nivel de seguridad  a 2, a 3, y a 4 respectivamente.

Para probar los niveles de la seguridad que usted estableció para los cuatro interruptores, usted
ahora se registrará en LookoutDirect con cada una de las cuentas de usuario que usted creó.

5.  Seleccione  "File> Log On” .
Aparece el diálogo Login.

6. Haga Log in como User1 (password=1111) y luego haga clic en OK.

7. Salga fuera del modo Edit y active el interruptor # 1. Ahora trate de activar cualquiera de los
otros interruptores.

Cuando usted lleva el cursor del mouse al interruptor # 2, 3, o 4, note que el cursor cambia
a un símbolo de prohibición. El símbolo de prohibición indica que la cuenta corriente no
tiene permiso para usar estos controles.



8. Haga el Log in como User2 y luego User3 y finalmente User4; cada vez que usted se abre una
sesión como nuevo usuario, trate de activar los interruptores restantes para ver a cuáles tiene
acceso.

Registro de datos de proceso
Una característica extremadamente valiosa de LookoutDirect es su capacidad de registrar eventos
de proceso para archivar. Usando el objeto de registro Spreadsheet (hoja de cálculo) usted puede
salvar dinámicamente el estado o el valor de cualquier miembro de datos a un archivo de hoja
de cálculo con archivos de formato de valor separado por coma (.CSV).

En este ejemplo, usted creará un objeto de registro en una hoja de cálculo para registrar, en
intervalos de 10 segundos, el valor de dos objetos que usted creó durante el curso conectado.
Para automatizar el proceso del registro de datos, usted creará un objeto botón y  un indicador
para comenzar el proceso de registro.

La funcionalidad creada en este ejemplo se puede encontrar en el archivo de proceso
WaterWorks.l4p en la carpeta de ejemplos.

Creando el objeto hoja de cálculo 
1. Abra el archivo de proceso tratamientoagua en la carpeta de ejemplos y después maximice el

panel de control Overview.

2. Agregue un nuevo objeto Spreadsheet (hoja de cálculo) al proceso tratamientoagua.

Aparece el diálogo Create Spreadsheer storage Object (creación del objeto de almacenaje de
la hoja de cálculo). 

3. Complete las propiedades del cuadro de diálogo.
• Name: SSDataLogging
• File configuration/File name: "ProcessData"
El nombre del archivo completo debe aparecer como ProcessData.csv.
• Interval Logging/Interval (Intervalo): 00:00:10.00 

Esto especifica que los datos serán escritos al archivo de la hoja de cálculo cada 10 segundos.

4. En el grupo Data fields, seleccione New Field (nuevo campo) y luego haga clic en el botón
derecho en la caja de texto amarilla de la expresión.

Aparece el redactor de la expresión.
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5. En el grupo Signals del árbol del directorio, seleccione el objeto POTNivelsim, haga clic doble
en el miembro de datos value (valor) en la caja Contents, y después haga clic en OK.

6. Haga clic en Save.

El valor del potenciómetro del nivel de simulación se agrega a la lista de las zonas de
informaciones que serán incluidas en la hoja de cálculo ProcessData.

7. Repita los pasos 4 a 6, excepto que este caso, agregue el miembro de datos valor del objeto
POTHOA a la caja de lista Data Fields.

8. Haga clic en OK.

Creando un botón para comenzar el registro de datos 
1. Cree un nuevo objeto botón llamado PBStartLogging en el Proceso tratamientoagua. Use

Registre como el texto del botón.

2. Cree un nuevo objeto de control de flip-flop llamado FFStartLogging en el proceso
tratamientoagua. Cuando aparece el diálogo Create flip-flop, haga clic en el botón derecho en
la expresión de texto Input =.

Aparece el redactor de expresión.

3. Haga clic doble  en el objeto PBStartLogging y luego haga clic en OK.

4. Haga clic en OK para cerrar el cuadro de diálogo Create flip-flop.

Aparece el redactor de expresión  otra vez. 

5. Haga clic en OK.

6. Seleccione  un indicador luminoso verde (ON) y rojo (OFF), y después haga clic en OK.

7. Agrupe el botón PBStartLogging y el indicador luminoso flip-flop en la esquina derecha más
baja del panel de control.
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8. Seleccione Object>Object Explorer, haga clic en el botón derecho en el objeto
SSDataLogging, y seleccione Properties.

Aparece el diálogo Revise spreadsheet storage object.

9. Haga clic en el botón derecho en el campo de expresión Logging, haga clic doble  en
FFStartLogging y luego haga clic en OK.

Probando la función de registro de datos
1. Salga fuera del modo Edit y luego haga clic en Start Logging.

2. Mueva el interruptor HOA a Auto (o Hand si ya está en Auto), y después mueva el
accionador de nivel simulado hacia adelante y hacia atrás a través del rango completo del
movimiento.

3. Repita el paso 2 aproximadamente cada 10 segundos, por un minuto. 

4. Haga clic en Start Logging otra vez para parar el registro de datos.

5. Use Microsoft EXCEL u otro programa de hoja de cálculo para abrir el archivo ProcessData.csv
localizado en:  C:\DirectSOFT32\Projects \ [ ] \ [ del Año Mes ]. Note que el archivo contiene
una columna de tiempo más las columnas para los dos miembros de datos que usted seleccionó
cuando usted creó el objeto SSDataLogging.

Nota: El archivo de hoja de cálculo EXCEL debe ser cerrado antes de comenzar a registrar o los datos no se
pueden escribir al archivo.
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Comenzando LookoutDirect
Este capítulo explica cómo comenzar y seguir en LookoutDirect. Describe la pantalla de
LookoutDirect e introduce algunos atajos importantes del mouse y del teclado.

Registrándose en LookoutDirect
LookoutDirect se inicia seleccionando el menú LookoutDirect en Start>Programs.
Cuando usted instala por prtimera vez LookoutDirect la cuenta del administrador no tiene
ninguna contraseña. Cuando la cuenta del administrador no tiene ninguna contraseña,
LookoutDirect se abre sin requerir ninguna conexión. Entran como administrador
automáticamente.

·Nota: El servidor y las versiones run-time del cliente LookoutDirect se abren con la cuenta del usuario
NOBODY (nadie), no importa cualsea la contraseña que se haya configurado para la cuenta del administrador.

Una vez que usted proporcione una contraseña del administrador, LookoutDirect  le pide que
se registre (log in) antes de abrirse, con el cuadro de diálogo siguiente.

Entre la contraseña apropiada en el campo Password (contraseña) y haga clic en OK.
LookoutDirect no es sensible a mayúsculas o minúsculas en este caso.

Nota  Usted configura contraseñas con el User Manager de  LookoutDirect. Mientras la contraseña del
administrador esté vacía (es decir, si usted no inserta una propia), LookoutDirect entra siempre con el
administrador como el usuario, y no requerirá que ninguna persona se registre en  LookoutDirect. Esto puede
ser una gran conveniencia para un programador de procesos LookoutDirect, pero esté seguro de configurar
una contraseña de administrador antes de permitir a otros el acceso a su copia de desarrollo.Vea el capítulo
6, Seguridad, del Manual de Desarrollo de LookoutDirect para más información sobre el User Manager de
LookoutDirect, contraseñas, y seguridad de LookoutDirect en general.

El campo Idle Time determina cuánto tiempo de inactividad que LookoutDirect espera  antes
de salir desde el usuario corriente. Cuando configurado como 0, LookoutDirect deja logged
ON el usuario corriente hasta que ese usuario hace log OFF, un nuevo usuario logs ON, o
LookoutDirect se cierra.

Usted puede alterar contraseñas y crear o corregir cuentas y grupos de usuarios con el User
Manager (administrador de usuario), seleccionando  Options>User Manager.  Vea el capítulo
6, Seguridad, en el Manual de Desarrollo de LookoutDirect para una información más detallada
sobre el User manager y otras consideraciones de seguridad.
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Abriendo un archivo de proceso
1. Si usted tiene disponible un archivo de proceso de LookoutDirect, seleccione el menú

File>Open de la barra de menú de LookoutDirect. Usted puede mirar en  la carpeta  de
ejemplos para comenzar con procesos de muestra.

2. En el campo de datos Filename (nombre del archivo), teclee el nombre de un archivo de
proceso LookoutDirect (tienen  una extensión  de archivo . l4p), o elija un archivo de
proceso de la lista y seleccione OK.

Si usted selecciona un archivo de proceso válido, LookoutDirect abre el archivo y comienza
inmediatamente a ejecutar el proceso.

Cuando se abre un archivo de proceso, LookoutDirect selecciona menús disponibles adicionales
y muestra paneles de control  y la ventana de alarmas.

Usted puede abrir y hacer funcionar tantos archivos de  procesos simultáneamente como quiera
en LookoutDirect y los puede cerrar individualmente o todos juntos. Aunque no hay límite
superior teórico de cuántos archivos de proceso usted puede funcionar en una computadora, en
términos prácticos usted puede comenzar a ver funcionamiento degradado con un gran número
de procesos, dependiendo de sus recursos de hardware y de otras variables. Haciendo funcionar
múltiples instancias de LookoutDirect en una computadora, o distribuyendo procesos de
LookoutDirect en las computadoras en una red pueden aumentar el buen funcionamiento.

La Pantalla de LookoutDirect
LookoutDirect primero aparece en su pantalla como maximizado, tomando la pantalla entera.

LookoutDirect tiene dos modos Edit (de modificación) y RUN (funcionamiento). Usted puede
cambiar el modo entre ellos presionando las teclas <Ctrl-Espacio> en su teclado, o
seleccionando o sacando la selección a Edit mode en el menú de Edit. La ilustración en la página
siguiente muestra una pantalla de LookoutDirect en modo Edit.

Barra de Título
La barra de título en la parte superior de  la ventana de LookoutDirect muestra el nombre del
programa y el nombre del proceso actualmente activo. Si se maximiza un panel de control, el
nombre del panel de control aparece en la barra del título.

Barra de Menú 
La barra de menú muestra los comandos de menú disponibles, que cambian dependiendo de si
LookoutDirect está en modo RUN, modo Edit (de modificación), o está abierto sin ningun
proceso funcionando. Estos comandos pueden o no estar disponibles para el operador,
dependiendo del  nivel de  seguridad del operador.

Barra de estado
La barra de estado está en la parte inferior de la ventana LookoutDirect, según lo mostrado en
la figura 4-1. Cambia cuando sale o entra al modo Edit. Cuando no está en el modo Edit, la
barra de estado es gris y se muestra la hora y la fecha en el extremo izquierdo de la barra. El
nombre de cuenta del operador entrado viene después. Aparece en el centro el nombre de la
compañía según lo entrado durante el registro, y el estado de alarmas está en el extremo derecho
de la barra de estado. 
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Las flechas de navegación del panel de control pueden o pueden no estar visibles, dependiendo
de sus configuraciones de las opciones del sistema.

Cuando se está en el modo Edit la barra de estado se hace amarilla. Las coordenadas X e Y del
objeto actualmente seleccionado (si cualquiera) aparecen en el extremo izquierdo de la barra. La
anchura y la altura del artículo actualmente seleccionado vienen después. Aparece en el centro
el nombre, el nombre de archivo o la expresión del artículo seleccionado, y el estado de alarmas
aparece en el extremo derecho de la barra de estado.

Para entrar y salir del modo Edit, seleccione el modo Edit>Edit Mode, o apriete las teclas
<CTRL-Space >.

Espacio de trabajo de LookoutDirect
El espacio de trabajo de LookoutDirect es el área entre la barra de menú y la barra de estado. El
espacio de trabajo es el área en la cual usted ve y opera los paneles de control. La ventana de
alarmas también aparece dentro del espacio de trabajo. Usted organiza y arregla paneles de
control en esta área del espacio de trabajo.

En la figura 4-1, el espacio de trabajo de LookoutDirect contiene el explorador de objetos de
LookoutDirect (visible solamente cuando usted está  en el modo Edit) y el panel de control de
proceso Reader (lector).
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El espacio de trabajo visible en su pantalla es solamente una ventana en el espacio de trabajo
virtual de LookoutDirect. Si los paneles de control o sus iconos asociados están parcialmente o
totalmente fuera del espacio de trabajo visible, LookoutDirect muestra automáticamente barras
de scroll  horizontales y verticales a lo largo de la derecha y la parte inferior del espacio de trabajo
visible. Si las barras de scroll son visibles, usted puede rodar en el espacio de trabajo virtual para
ver todos sus paneles de control.

Object Explorer (Explorador de objetos)
El explorador de objetos de LookoutDirect es una herramienta útil para crear y corregir sus
procesos de LookoutDirect. Usted puede tener acceso a las funciones de correccion de
LookoutDirect desde esta ventana haciendo clic en el botón derecho en los objetos mostrados
allí (Las opciones cambian  dependiendo de en qué artículo usted haga clic). Usted puede
también crear procesos, objetos, carpetas dentro de procesos y luego organiza objetos
moviéndolos a partir de una localización a otra dentro de un proceso, crea objetos, arrastra
objetos mostrables y muestra expresiones a diversos paneles, y más.
Para usar el explorador de objetos de LookoutDirect, cerciórese de que LookoutDirect tiene un
proceso funcionando y que está en el modo Edit, después seleccione Object>Object Explorer.
La ventana inicial junto con un explorador algo ampliado de objetos se muestra en la ilustración
siguiente.
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Haciendo clic derecho dentro del explorador muestra un menú similar al siguiente.

Como usted puede ver, dependiendo de lo que usted seleccionó en el explorador antes de hacer
clic derecho en él, usted puede:

crear un objeto

modificar un objeto o procésarlo seleccionando Properties 

Colocar un nuevo nombre a un objeto o procéselo seleccionando Properties

borrar un objeto o una carpeta 

corregir conexiones de objetos o una base de datos de objetos 

configurar los permisos para una computadora, proceso, objeto o de seguridad 

hacer una colección de objetos 

Cuando usted crea un objeto mostrable en el explorador de objetos, aparece en la ventana del
explorador pero no en un panel de control. Para poner la parte mostrable de un objeto en un
panel de control, usted puede arrastrarlo y soltarlo. Si no hay componente mostrable al objeto,
LookoutDirect crea una expresión (si es posible).
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Si usted arrastra y suelta un objeto o miembro de datos a partir de un proceso a un panel de
control en otro proceso, LookoutDirect insiere una expresión para exhibir el valor representado.
Usted no puede poner la parte mostrable de un objeto en un panel de control en un proceso
diferente en que el objeto fue creado.

Cuando usted deja el modo Edit, se cierra la ventana del explorador de objetos de
LookoutDirect. El cambiar en Modo Edit restituye la ventana del modo del explorador en la
misma localización y en el mismo tamaño que tenía cuando usted salió del modo Edit.

Usted puede colocar un nuevo nombre a las carpetas y también volver a poner objetos con el
explorador de objetos de LookoutDirect.

LookoutDirect también tiene una herramienta llamada el navegador de conexiones, no mostrada
en la  figura, y usted puede utilizar para buscar las conexiones que usted hace entre los objetos.
Vea  la sección el navegador de conexiones más adelante en este capítulo para más información
sobre el navegador de conexiones.

Paneles de Control
Los paneles de control suministran una zona de visualización para cualquier grupo de
interruptores, perillas, gráficos de barras, indicadores digitales, gráficos de tendencia, y otros
componentes que usted desea utilizar para visualmente supervisar y controlar sus operaciones.
Los paneles pueden ser de tamaño plena pantalla, reducido al mínimo, o cualquier tamaño
entre esos dos. Usted puede mover los paneles alrededor de la pantalla “agarrando” la barra del
título de un panel con el cursor del mouse y arrastrándola a una nueva localización. Los paneles
de control  pueden también "aparecer"( pop-up) cuando ocurre un evento, por ejemplo, cuando
se presiona un botón  o cuando se activa una alarma. No hay límite en la cantidad de paneles
de control que usted puede crear o la cantidad de objetos mostrados en cualquier panel.

Cuando esté en el modo Edit usted puede tener acceso a algunas de las funciones de edición de
LookoutDirect haciendo clic en el botón derecho en un objeto o una expresión en el panel, o
en el panel mismo.

Hay tres tipos de paneles de control: normal, pop-up, y pop-up sin icono. 

Un panel de control normal se puede maximizar, colocar a tamaño normal, o reducir al mínimo
dentro del espacio de trabajo de LookoutDirect.

Un panel de control pop-up puede aparecer como en un estado pop-up o reducido al mínimo.
Cuando se muestra un panel de control pop-up, permanece encima del resto de los paneles hasta
que usted lo reduce al mínimo.

Los paneles de control no tienen un aspecto estándar. Usted puede modificar cada panel de
control para requisitos particulares para su estrategia particular de control con interruptores,
potenciómetros, y otros objetos gráficos. Algunos paneles de control pueden solamente mostrar
información, mientras que otros combinan información de control y de exhibición. 

La información exhibida representa siempre los valores más actuales disponibles a
LookoutDirect a través de la comunicación con sus aparatos de entradas y salidas.

Manual de cómo comenzar LookOutDirect 4-7

Capítulo 4: Fundamentos básicos de LookoutDirect

1

2

4

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D



Con LookoutDirect usted tiene una considerable flexibilidad en cómo usted hace que se vea y
funcione el panel de control. Por ejemplo, usted puede dibujar sus propios interruptores y
substituirlos en lugar de los interruptores estándares. Usted puede hacer fácilmente que un
botón opere al revés de la manera como se espera  normalmente. Usted puede ser que le coloque
atrasos y condiciones en el panel que pueden no ser obvios solamente viendo el panel.

Los paneles de control son ventanas en el proceso que usted utiliza controlar el equipo accionado
interruptores, presionando los botones y dando vueltas a perillas. 

A diferencia de los interruptores y de las perillas verdaderos, usted puede asignar niveles de
seguridad a controles individuales, tan bien como los paneles de control enteros dentro de
LookoutDirect. Usted puede utilizar esta característica para impedir que algunos operadores que
no tienen niveles de seguridad  adecuados para aparatos específicos r=tengan acceso a estos. 

Vea el capítulo 6, Seguridad, del Manual de Desarrollo de LookoutDirect para más información
sobre seguridad.
A diferencia de los interruptores y de las perillas físicas, usted puede exhibir objetos de control
múltiples veces en un proceso dado usando exhibiciones múltiples, en el mismo panel de control
y en diversos paneles de control. Por ejemplo, cuando usted da vuelta a una perilla en una
localización, todas las copias de esa perilla giran al mismo tiempo, en cada localización de ese
control. El mismo objeto de control puede aparecer diferentemente en cada localización. Usted
puede ser que exhiba un potenciómetro como diapositiva horizontal en un panel, un par de
botones de incrementar y decrementar en otro panel, y una perilla en otro panel.
Usted puede tener la misma clase de operación síncrona entre controles en diversos procesos que
funcionan en su computadora, o entre controles que funcionan en procesos en diversas
computadoras en su red. El establecimiento de una red LookoutDirect hace esto posible, con
fuentes de posición y objetos remotos tales como Symbolic Link (conexion simbólica),
explicados posteriormente.

Ventana de Alarmas
Debajo del explorador de objetos de LookoutDirect y del panel de control del lector en la figura
4-1 está la ventana de alarmas. Usted puede elegir cómo se ve la ventana de alarmas
seleccionando Alarms>Display Options.  En la figura de abajo la ventana de alarmas está
configurada para exhibirse en la parte inferior del espacio de trabajo.
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Navegación y acciones de entradas del operador
Hay varios métodos para que los operadores de planta ajusten valores de referencia o cambien
de un panel de control a otro. Éstos incluyen el mouse, el Trackball, el touchscreen, y comandos
activados desde el teclado.

Cuando el cursor se mueve sobre un objeto controlable, el cursor se transforma en una mano,
indicando que usted ahora tiene control del objeto. Los objetos controlables incluyen elementos
tales como interruptores, potenciómetros y botones.
Al usar un teclado, las teclas de flecha mueven el cursor alrededor de la pantalla. La tecla < Tab
> salta el cursor a partir de un objeto controlable a otro, y la barra de < espacio > actúa como el
botón de mouse izquierdo, así que usted puede hacer clic en un objeto controlable sin realmente
usar un mouse.
Usted puede también relcionar teclas de función del teclado (F1, F2, etc.) a los paneles de
control y a otros objetos, así que usted puede cambiar entre los paneles de control o los
comandos de control de edición solamente presionando una tecla de función.

Teclado numérico virtual
Cuando usted está en modo RUN, usted puede hacer clic en un control digital del
potenciómetro y traer un teclado virtual para entrar valores numéricos, con un mouse o una
pantalla sensitiva al tacto.

Teclado alfanumérico virtual
LookoutDirect también tiene un teclado virtual que usted puede utilizar con una pantalla
sensitiva al tacto o un mouse.
Para activar el teclado virtual, seleccione Options>System y después para comprobar haga clic
en Left Mouse click (botón izquierdo del mouse) o en Right Mouse click (botón derecho del
mouse) en la sección del cuadro de diálogo Virtual Keyboard Pops Up.

Cuando esta característica está activada, haciendo clic en un campo de la entrada de datos o
tocando el campo en una pantalla sensitiva al tacto muestra el teclado virtual, según lo mostrado
en la figura siguiente.
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Connection Browser (Navegador de conexiones)
Use el navegador de conexiones para registrar  computadoras de red, navegar rápidamente entre
objetos, seguir las conexiones, identificar a orphans [huérfanos] (objetos inusitados), y organizar
objetos en un proceso.

Para tener acceso al navegador de conexiones, seleccione Object>Connection Browser.  Aparece
el cuadro de diálogo siguiente.

Vea la sección Registrando Computadoras en el capítulo 4, Creación de una red, en el Manual de
Desarrollo de LookoutDirect para información de como usar el browser de conexiones para
colocar las computadoras en red en LookoutDirect.

Para crear y para modificar objetos así como corregir las conexiones y la base de datos  en el
browser de  conexión, haga clic en el botón derecho sobre el objeto que usted desea modificar.

Usted puede también crear carpetas y mover objetos para dentro y para fuera de las carpetas.

Un cierto planeamiento de cómo usted desea arreglar los objetos en cada proceso, combinado
con un conocimiento de cómo trabaja la relatividad de trayectorias en LookoutDirect, puede
protegerle contra la mayoría de inconveniencias a este respecto. Vea el capítulo 5, Usando
LookoutDirect, para más información sobre cómo un cambio en la localización puede afectar
conexiones del objeto.

Para navegar las conexiones en los procesos LookoutDirect, LookoutDirect debe estar en el
modo Edit. Después de abrir el browser, haga clic en el nombre de la computadora local, y
seleccione el proceso que usted desea explorar. Se le presentará entonces una lista de objetos en
ese proceso.

Usted puede utilizar el navegador de conexiones para crear o para colocar el nombre
nuevamente  a carpetas dentro de su proceso, y usted puede mover objetos a partir de una
localización en otra interior un proceso dado, usando la técnica típica de arrastrar y soltar de
Windows.

Usted puede también crear nuevos objetos o corregir objetos existentes, las conexiones, o la base
de datos a través del browser de conexiones. Haga clic en el botón derecho en el browser de
conexiones para obtener el menú para elegir una de estas operaciones.
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Cuando usted selecciona un objeto individual para mostrar conexiones, su pantalla del
navegador muestra algo como la ilustración siguiente.

En este ejemplo, se ha seleccionado el objeto potenciómetro  nombrado Client_Pot1. Se
muestran todos los sitios y conexiones de exhibición, incluyendo la manera que este
potenciómetro es conectado remotamente con un miembro de datos en otro proceso.

Los iconos de los objetos $Alarm y Timer1 se descoloran en aspecto. Esto indica que este
objeto es un huérfano, significando que su salida no está siendo utilizada por ningún otro
objeto.

Haciendo clic en objetos de entradas o de salidas usted puede encontrar cadenas de conexiones
en sus procesos.  Haciendo clic en el botón derecho en un objeto o un parámetro, usted puede
modificar el objeto o el parámetro del navegador de conexiones.

Aunque usted puede explorar a partir de un proceso a otro cuando ambos procesos están
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abiertos en una computadora, usted no puede explorar a través de la red a un proceso que
funciona en otra computadora. El navegador de conexiones mostrará un objeto de red en la
pantalla, pero no puede explorar ese objeto.

LookoutDirect también tiene una herramienta adicional llamada Object Explorer (explorador
de objetos), que usted puede utilizar para seguir las conexiones que existen entre objetos. 

Vea a la sección Explorador de Objetos anteriormente en este capítulo para más información
sobre el explorador de objetos.

Opciones del navegador de conexiones
Usted puede simplificar la visión del navegador de conexiones seleccionando qué elementos son
mostrados en un objeto. Por defecto LookoutDirect está configurado para que sean permitidas
todas las configuraciones.

Haga clic en el botón Options (opciones) para activar el cuadro de diálogo de opciones del
navegador de conexiones, mostrada en la ilustración siguiente.

Si usted desea eliminar los parámetros del objeto (para centrarse en conexiones del miembro de
datos) inhabilite la opción de Show parameters (Muestre parámetros).

Inhabilite Show display objects (Muestre objetos de exhibición) saca todos los componentes de
exhibición desde la vista del browser de conexiones de un panel de control.

Inhabilitando Show constant connections saca todos los valores estáticos conectados con un
miembro del parámetro o datos del objeto. Inhabilitando esta opción puede ayudarle a centrarse
en variables y para cambiar  valores originados en otros objetos.

Seleccione Save settings on exit para salvar las opciones configuradas para el navegador de
conexiones la próxima vez que usted abre el navegador en una sesión de LookoutDirect.

Seleccione Play sound effects (efectos sonoros) permite que el sistema de Windows genere
sonidos de alarmas cuando usted hace una operación ilegal en el navegador de conexiones.
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Archivos de aplicaciones de LookoutDirect
Usando LookoutDirect usted puede desarrollar rápidamente un archivo de proceso completo.
Todo el desarrollo es interactivo. Usted no tiene que programar o compilar. Solamente cree los
objetos y conéctelos según lo que necesite. El ciclo de desarrollo crea cuatro archivos únicos para
cada uso: un archivo de proceso, un archivo del código de fuente, un archivo de estados y un
archivo de seguridad.

Si usted desarrolla un proceso LookoutDirect en una computadora y desea hacerlo funcionar en
otra computadora, usted debe copiar los archivos de proceso (l4p) y de seguridad (lka) a la
computadora nueva para que su proceso funcione correctamente.

Usted puede también copiar los archivos de fuente y de estado, si usted desea, pero
LookoutDirect puede reconstruir estos archivos en la nueva localización en caso de necesidad.

Archivo de proceso 
Un archivo de proceso es un archivo compilado que contiene el proceso LookoutDirect que usted
desea hacer  funcionar. Es actualizado cada vez que usted selecciona el comando File>Save. 

Los archivos de proceso son archivos binarios con  una extensión del nombre de archivo l4p
(proceso de LookoutDirect). Usted no corrige ni modifica directamente archivos de proceso con
un editor de textos. Mas bien, LookoutDirect compila  el archivo l4p objeto por objeto mientras
usted crea cada objeto. Con esta forma de operación usted puede permanecer en línea mientras
crea, actualiza, o modifica su aplicación. 

No hay necesidad de cerrar el proceso. LookoutDirect no detiene la operación mientras usted
agrega o borra controladores, entradas o salidas, gráficos, o modifica su lógica. 

Se recomienda que usted salve el proceso a menudo mientras hace modificaciones, de modo que
usted no pierda cambios en el evento de un apagón.
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Archivo del código fuente
LookoutDirect también actualiza automáticamente un archivo correspondiente del código
fuente cuando usted invoca el comando File>Save. LookoutDirect puede compilar este archivo
para crear un archivo .l4p, para incluir definiciones del objeto, nombres, la configuración de
las entradas y salidas, comunicaciones, lógica de control, la disposición del panel de control y
otros parámetros de objetos.

Los archivos del código fuente tienen una extensión del nombre de archivo .lks (fuente de
LookoutDirect). Éstos son los archivos de texto estándares ASCII que usted puede imprimir o
ver con cualquier procesador de textos o editor de textos. Usted puede utilizar esta información
para el propósito de eliminar errores y de documentación.

Nota  Ya que el formato binario de archivos de  proceso de LookoutDirect ambos pasados y futuros pueden
cambiar por razones de eficiencia, usted debe siempre mantener con un respaldo los  archivos  fuente  lks.
Éste es el archivo que usted compila para abrir un proceso creado en una versión más antigua de
LookoutDirect con cualquier nueva versión de LookoutDirect emitida en el futuro.

Usted puede compilar los archivos fuente de LookoutDirect con el comando Open, o
manualmente, con una ventana DOS.

Para abrir y para compilar un archivo fuente dentro de LookoutDirect seleccione File>Open.  Se
abre el cuadro de diálogo siguiente.

Configure File of Type (archivos del tipo)  a LookoutDirect Source Files (*.lks)  y seleccione el
archivo fuente que usted desea compilar.
Para compilar un archivo fuente  de LookoutDirect manualmente, consulte las instrucciones en
el apéndice B, el compilador CBL, en el Manual de Desarrollo de LookoutDirect.
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El archivo de estados
El archivo de estados contiene los valores corrientes de los miembros de datos de objetos. Estos
valores incluyen referencias y otros datos importantes mantenidos dentro y usados por los
objetos. 

Usted puede pensar en el archivo de estados como una memoria permanente para las
referencias y graficos de tiempo real en LookoutDirect. LookoutDirect usa el archivo de estados
para almacenar el estado de interruptores, de potenciómetros, y de líneas de graficos de
tendencia. Cuando LookoutDirect primeramente carga una aplicación, lee el archivo apropiado
de estados para determinar en qué estado deben estar los potenciómetros, los interruptores,
gráficos de tendencia, etcétera durante la partida.

El archivo de estados se actualiza en cualquier momento que usted salva, cierra o sale del
archivo de la aplicación LookoutDirect. Puede también actualizarse periódicamente según lo
definido en el cuadro de diálogo de las propiedades de proceso o el objeto Loader (cargador).
Usted invoca este cuadro de diálogo seleccionando el comando de menú de de File>Modify
Process. Los archivos de estados tienen  una extensión de nombre del archivo  .l4t (estado
de LookoutDirect).

Archivo de seguridad 
Cada proceso LookoutDirect tiene un archivo de seguridad anexado, identificado por  la
extensión  .lka. 

Toda la información de seguridad para un proceso de LookoutDirect se mantiene en el archivo
.lka para ese proceso. Usted debe mantener el archivo . lka en el mismo directorio que el
archivo .l4p para que trabajen las configuraciones de seguridad. Si usted pierde  el archivo
.lka, todos los usuarios tendrán acceso completo a todas las partes del proceso. Para
reconstruir el archivo, usted tendría que configurar todos los permisos de seguridad
nuevemente.

Vea el capítulo 6, Seguridad, del Manual de Desarrollo de LookoutDirect para una información
más detallada sobre seguridad de LookoutDirect.



Configuración de Atajos

Atajos de mouse
Este manual hace referencia a varios atajos que se usan con el mouse.

Es fácil familiarizarse con los comandos del mouse y el ayudará a desarrollar sus aplicaciones.

Nota: Ud puede seleccionar varios items en un panel haciendo clic en un panel y arrastrando el cuadro que
aparece alrededor de los objetos que quiere seleccionar.  Los comandos que siguen afectarán el grupo
entero o puede saltar de un item al próximo, avisándole a Ud de que se necesitan nuevas instrucciones.
Ud. puede parar este proceso en cualquier momento manteniendo la tecla <SHIFT> apreatra y
seleccionando los botones OK o Cancel en el cuadro de diálogo corriente.
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Función Acción de mouse

Seleccione un objeto, símbolo gráfico,
texto, expresión o cualquier item en
un panel.

Haga clic: Seleccione el item apuntando el cursor al
item y haga clic con el botón izquierdo del mouse
(vea la nota mas abajo) 

Cree un nuevo objeto desde un
objecto existente 

Arrastre + CTRL: Seleccione el o los items con el
cursor y haga clic con el botón izquierdo del mouse.
Mantenga la tecla CTRL apretada y arrastre el item
selecionado. Esto hace una nueva instancia del
objeto:
Arrastrando Pot1 con la tecla CTRL apretada creará
un nuevo objeto nombrado Pot2.

Copie un objeto, símbolo gráfico,
texto, expresión o cualquier item en
un panel.

Arrastre + SHIFT: Seleccione el o los items con el
cursor y haga clic con el botón izquierdo del mouse.
Mantenga la tecla SHIFT apretada mientras arrastra
el item selecionado. Esto hace una copia del objeto
selecionado que es conectado al original. Ambos
objetos tienen el mismo nombre.

Modifique parámetros de objetos de
un objeto, símbolo gráfico, texto,
expresión o cualquier item en un
panel.

Haga clic en el botón derecho: Seleccione el item a
ser modificado. Apunte el cursor al item y haga clic
con el botón derecho del mouse 



Recordando nombres de Objetos 
Muchas cajas de diálogo contienen campos de expresión. Los campos de expresión son amarillos
e indican que usted puede obtener ayuda identificando o recordando un nombre de objeto y a
miembros asociados de datos presionando el botón derecho del mouse (haga clic en el botón
derecho en el campo seleccionado de la expresión).

Asuma, por ejemplo, que usted desea hacer un promedio de un cierto valor. Usted comienza a
crear una expresión para este valor, pero usted no puede recordar el nombre del miembro de
datos o del objeto del que usted desea tener un valor medio. Haga clic en el botón derecho en
el campo de la expresión (el campo en el cual usted teclea normalmente el miembro de datos
que usted desea conectar o exhibir).

Cuando usted hace clic en el botón derecho en cualquier campo de la expresión, LookoutDirect
presenta el cuadro de diálogo Revise Expression (revisión de la expresión), según lo mostrado
en el diagrama siguiente.

Figura 4-2. Redactor de expresión activado haciendo clic en el botón derecho en la zona amarilla 
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Usando el redactor de expresión, usted puede copiar fácilmente a nombres de objetos y a sus
miembros de datos directamente en el campo de la expresión. Navegue a través de procesos y de
objetos hasta que usted haya seleccionado el miembro de datos del objeto que usted desea.
Cópielos en la zona de informaciones del redactor de expresión, haciendo clic en el botón Paste
o haciendo clic doble en el miembro de datos. Haga clic en OK, y LookoutDirect escribe la
expresión en la zona de informaciones de expresión del objeto, tal como el campo Data en el
cuadro de diálogo Create Average Object (Cree el objeto del promedio) mostrada en la
ilustración siguiente.

Nombres de trayectorias en LookoutDirect
En versiones antes de LookoutDirect 4.0, usted podría solamente tener un proceso funcionando
en cualquier instancia de LookoutDirect, y no había carpetas en un proceso para organizar
objetos. La creación de una red era hecha a través de DDE, que utilizaba trayectorias específicas.

En LookoutDirect 4 y más nuevo, la relación entre los objetos que funcionan en diversos
procesos en diversas computadoras es más flexible y potencialmente más complicada. Cuando
usted insiere una expresión en un panel de LookoutDirect o hace una conexión a o entre
miembros de datos, usted puede ser que exhiba un valor que viene del proceso conteniendo ese
panel.  Puede ser que también quiera exhibir un valor que viene de otro proceso que funciona
en la misma computadora o de un proceso que funciona en otra computadora en la red.

Una trayectoria puede ser absoluta, comenzando con el nombre completamente cualificado de
una red de computadoras y conducir a través de directorios y de subdirectorios jerarquizados a
un solo objeto; o relativo, mandando a la computadora para buscar un objeto en un cierto
directorio definido no de la computadora, sino concerniente a la carpeta corrientemente activa.

Para suministrar máxima flexibilidad de programación, usted puede utilizar una gran cantidad
de niveles de relatividad, o modos de relatividad de la trayectoria, configurando la trayectoria a los
datos cuando usted crea una expresión. Estos modos funcionan en forma muy similar a otras
trayectorias relativas usadas en operaciones de DOS, células de hojas de cálculo como EXCEL,
y las direcciónes de Internet.

Manual de cómo comenzar LookOutDirect

Capítulo 4: Fundamentos básicos de LookoutDirect

4-18

1

2

4

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D



Usted puede configurar una trayectoria para cada objeto o conexión individual, usando un nivel
diferente de relatividad. Estos modos de relatividad de la trayectoria incluyen:

Relativo (por defecto  de LookoutDirect)

Relativo  al proceso 

Relativo  a la Computadora 

Absoluto 

El nivel de relatividad de la trayectoria que usted elige hace una diferencia en cómo su proceso
funciona cuando está copiado o es movido a otra computadora. Por ejemplo, suponga que usted
tiene un funcionamiento de proceso del cliente en la computadora Alfred que refiere a objetos
en un proceso del servidor también que funciona en la computadora Alfred. Si usted funciona
ese proceso del cliente en la computadora Bert, ¿se refiere a objetos en la computadora Alfred o
la computadora Bert?

Configurando el nivel de relatividad de la trayectoria es la forma cómo usted puede controlar a
qué objetos se refieren sus procesos. El punto principal a recordar sobre modos de relatividad de
la trayectoria en LookoutDirect es que los modos se distinguen por el prefijo de la trayectoria.

En modo relativo, la forma de la trayectoria es: 

object

o 

folder\object sin prefijo.

El modo relativo es el modo por defecto en LookoutDirect 4. Todas las trayectorias son relativas
a la carpeta o al proceso que contiene la expresión que usted está creando o al objeto usted está
conectándose.Use el modo relativo al conectar los objetos que deben ser agrupados juntos y que
se deben copiar o moverse como grupo.

Las conexiones entre los objetos en una carpeta deben utilizar modo relativo de modo que
puedan ser copiadas y movidas a otra parte mientras mantengan la misma  relación entre cado
uno.

El modo relativo de proceso es indicado por un solo backslash como prefijo (\) seguido por un
nombre de carpeta o del objeto, como en:

folder\......folder\object 

Use el modo relativo de proceso cuando usted desea hacer una conexión entre dos objetos en
diversas carpetas en el mismo proceso.

El modo relativo de  computadora es indicado por un prefijo que consiste en dos backslashes), un
punto y un backslash  (\\.\) seguido por un nombre de proceso, como en 

\\.\process\folder\…folder\object 

Use el modo relativo de computadora cuando usted desea referirse a otros procesos que funcionan
en la misma computadora.
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Por ejemplo, si usted tenía un proceso llamado  Station_Control que llamó una cantidad
de otros procesos por nombre en la computadora Alfred, usted podría utilizar que el mismo
proceso  Station_Control en la computadora Bert, para referirse a los procesos
idénticamente nombrados que funcionaban en la computadora Bert.

El modo absoluto es indicado por dos backslashes  (\\)  seguidos por una trayectoria completa de
la red, como en:

\\computer.place.com\process\folder\…folder\object 

El modo absoluto es, de hecho, un modo de URL. Use modo Absolute cuando usted desea
referirse a un proceso particular en una computadora particular. Cualquier referencia a un PLC,
por ejemplo, debe ser en modo absoluto para referirse siempre a la computadora conectada
físicamente con ese PLC; no importa donde está funcionando el proceso en referencia

Nota:  Aunque el modo relativo es el modo por defecto de  LookoutDirect, cuando usted utiliza un objeto fuera
de la localización inmediata de su expresión, la trayectoria llega a ser más específica. Agregando dos puntos
(..) al principio de una trayectoria, por ejemplo, se puede utilizar para especificar al parent de la primera
carpeta enumerada.

La razón de manualmente cambiar un modo de trayectoria a un nivel más allá de lo  necesario
en su caso actual es asegurarse de que su proceso trabaja correctamente si usted lo cambia,
totalmente o parcialmente.
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Descripción del ciclo de desarrollo de proceso 
El primer paso para desarrollar un archivo de proceso es crear un archivo de proceso. Después
de que se cree el archivo, se agregan los paneles de control. 

Los paneles de control son ventanas que usted utiliza para colocar otros objetos, tales como
interruptores, potenciómetros, y los gráficos de tendencias a ser mostrados. Usted puede
hacerlos parecer a los paneles de control físicos, completos con interruptores, botones, biseles,
inserciones, lámparas, instrumentos, etcétera. Su imaginación es el único límite a cómo se ven
y funcionan los paneles de control.

Después de que usted cree por lo menos un panel de control, usted puede después crear y
exhibir cualquier número de otros objetos. Recuerde que los objetos se pueden exhibir en un
solo panel de control o en paneles de control múltiples. Por ejemplo, usted puede inserir el
mismo interruptor en varios paneles. Si usted acciona el interruptor en un panel acciona
inmediatamente el interruptor en el resto de los paneles.

Los primeros objetos que desee crear podrían ser los que representan sus PLCs y RTUs
(Unidades  Terminales Remotas). Éstos tipos de clases de objetos utilizan a menudo sus puertos
de comunicación de la computadora, así que usted puede tener que configurar sus puertos para
la radio, el módem de discado manual, o una conexión hard-wired(Con cables) , como sea
adecuado. 

Vea el capítulo 3, Comunicaciones Seriales, en el Manual de Desarrollo de LookoutDirect para más
información sobre comunicaciones de configuración.

Cuando usted crea un objeto que represente un PLC, una RTU, u otro aparato de entradas y
salidas, su funcionalidad y base de datos asociadas son parte del objeto. La funcionalidad
construida en este tipo de clase de objetos incluye un driver del protocolo, permitiendo al
objeto comunicarse con el aparato físico. La base de datos nativa (por defecto) incluye todos los
registros, bits, señales de entradas y salidas, parámetros y otros valores a los cuales el aparato
físico pueda transmitir o recibir LookoutDirect.

En este punto, usted puede querer agregar a miembros de datos a las bases de datos nativas para
sus objetos. Tales nuevos miembros de datos, llamados los aliases, pueden incluir nombres
descriptivos, parámetros de escala de la señal, parámetros de alarmas, etcétera. Usted puede crear
más de un alias para un miembro nativo dado de datos, usando diversos parámetros de escala o
de alarmas para cada uno.

Mientras crea objetos, usted puede conectarlos con otros objetos. El tipo de objetos que usted
crea (por ejemplo un potenciómetro, un interruptor, Madcaps, tendencia, etcétera) y la manera
como usted los conecta determina cómo su sistema interactúa con su proceso.
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Muchas clases de objetos que usted usa se aprovechan de servicios de LookoutDirect. Por
ejemplo, usted puede asignar un nivel de seguridad a un objeto potenciómetro y la clase de
objetos de alarmas utiliza el subsistema del proceso de alarmas. Mientras usted crea los objetos
que se aprovechan de estos servicios, usted debe configurar  los servicios específicamente para los
requisitos de la aplicación.

Sugerencia  Usted puede salvar un archivo de proceso con cualquier nombre que usted elija. El nombre del
archivo de proceso escojido por Ud no tiene que ser idéntico a su nombre de proceso. Usted puede copiar
(o Save as) archivos LookoutDirect para colocar un nombre  nuevo y hacer funcionar el proceso de la misma
forma que hace funcionar los archivos originales. Usted no puede, sin embargo, hacer funcionar dos
procesos con el mismo nombre de proceso en una sola instancia de LookoutDirect. Si usted tiene un proceso
básico que usted necesite hacer varias variaciones, usted puede colocar un nuevo nombre al proceso en cada
archivo haciendo clic en el botón derecho en el nombre de proceso en el explorador de objetos LookoutDirect
y seleccionando Rename.

Creando Procesos servidor y cliente 
Según lo explicado en la sección de procesos de cliente y de servidor del capítulo 2, Cómo trabaja
LookoutDirect, los procesos del servidor LookoutDirect funcionan en las computadoras con
conexiones físicas a su hardware. Los clientes LookoutDirect funcionan con computadoras que
pueden comunicarse con computadoras que tienen funcionando los servidores LookoutDirect.
Usted construye estos clientes y servidores eligiendo objetos y haciendo conexiones.

Navegación en LookoutDirect
Muchas cajas de diálogo en LookoutDirect que usted usa para crear un objeto, mostrar una
expresión, hacer una conexión, y así sucesivamente, contienen una cierta variación del cuadro
de diálogo siguiente. Este cuadro de diálogo se usa para localizar cualquier objeto en cualquier
proceso LookoutDirect que funciona en su red.

Cada computadora registrada con LookoutDirect
funcionando en ella aparece en este cuadro de
diálogo. El hacer clic en la computadora para abrir
la exhibición completa muestra los procesos que
funcionan corrientemente en esa computadora. El
hacer clic en un proceso particular muestra todos
los objetos en ese proceso a los que usted pueda
tener acceso.

La caja en la parte superior de tales exhibiciones
indica la localización  de la raíz. Para exhibir todas
las computadoras registradas como funcionando
con LookoutDirect y también como exhibiendo su
propia computadora como local, usted configura
Universe como raíz. Usted puede configurar su
computadora local, la red de las computadoras registradas con LookoutDirect, cualquier
computadora específica en la red, o cualquier proceso como la raíz haciendo clic en el botón
derecho en ese nodo y seleccionando Make Root (haga la raíz).
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Nota:  LookoutDirect no puede corregir o editar  procesos a través de la red, de modo que lo que usted puede
hacer con  computadoras y  procesos que funcionan en una red es limitado. Para modificar un proceso, usted
debe estar en el nodo local de la red; es decir, la computadora  local (o de un proceso que funciona en él).

Usted puede distinguir entre una representación local o de red de su computadora en
LookoutDirect en la ventana de la selección de la raíz viendo el icono de la computadora. 

La representación de la red de su nombre de computadora tiene flechas rojas representando la
conexión de la red de E/S, según lo mostrado a la derecha en la ilustración siguiente.La
representación local, a la izquierda, no tiene ninguna flecha de E/S.

Vea el capítulo 4, Creación de una red, en el Manual de Desarrollo de LookoutDirect para más
información sobre la configuración de las computadoras y la navegación con procesos
LookoutDirect en su red.
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Creando Un Proceso en LookoutDirect
Lo que sigue explica el procedimiento básico para crear un archivo de proceso nuevo.

1. Seleccione File>New.

Aparece el cuadro de diálogo Create Process.

2. Teclee un nombre de proceso de LookoutDirect en el campo Process Name. Este  nombre
debe seguir a las mismas convenciones que un nombre de objetos de LookoutDirect. Vea la
sección de nombres de objetos para más información detallada sobre convenciones de
nombramiento LookoutDirect.

3. Haga las selecciones en el grupo State Information. Cada control se explica abajo.

Nota  si usted va a tener una computadora de respaldo en la red que esté en línea y haga funcionar este
proceso en caso que su computadora primaria falle, usted debe incluir una localización en esa computadora
como un lugar para salvar el archivo de estado de proceso. 
Vea el capítulo 10, Redundancia, del Manual de Desarrollo de LookoutDirect para más información sobre las
computadoras de respaldo y los procesos de  creación.

Seleccione Save State file with Process File (Salve el archivo del estado con el archivo de
proceso)  para salvar el archivo del estado en la localización en donde fue abierto el archivo
de proceso. Éste es el comportamiento por defecto.
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Seleccione  Save Standby State file para salvar una o mas copias del archivo de estado en la
carpeta de LookoutDirect su están funcionando actualmente. El nombre del archivo del
estado será igual que el nombre de proceso.Esto es útil si las computadoras múltiples están
compartiendo un archivo de proceso. En este caso, cada computadora mantiene su propio
archivo de estado localmente.

Seleccione la caja de verificación Save Standby State file para salvar unas o más copias
adicionales del archivo del estado en una localización de su escoja. Teclee una trayectoria
completa, incluyendo el nombre del archivo del estado, para cada localización que desea
salvar un archivo de estado. Si usted está salvando el archivo de estado a más de una
localización alternativa o de respaldo, separe las trayectorias con el símbolo barra vertical (|).

Para configurar la frecuencia que LookoutDirect salva el archivo de estado, marque la caja de
verificación  Save State file every y llene un valor para el número de minutos que usted desea
pasar entre cada almacenamiento. Recuerde que el salvar archivos usa  recursos del sistema ,
de modo que si usted tiene una cantidad de procesos, cada  uno o más salvando el archivo de
estado  a menudo, usted puede experimentar algunos problemas de funcionamiento.

4. Haga la selección en el grupo Citadel Database (base de datos del citadle). Cada control se
explica abajo.

Si usted marca la caja de verificación Use default Values (Use valores originales de fábrica),
LookoutDirect usa la localización por defecto configurada en el cuadro de diálogo System
Options en cualquier instancia de LookoutDirect.

Si usted entra en un nombre de computadora y una trayectoria en esa computadora a una
carpeta específica, LookoutDirect registra datos a esa localización en esa computadora, no
importa cual  computadora está haciendo funcionar el proceso.

Para señalar una computadora y una trayectoria específicas para su proceso a los datos de
registro, inscriba el nombre completamente cualificado de la red para la computadora blanco
en el campo Citadel database Computername (Nombre de comoutadora de base de datos
Citadel), y la trayectoria completa al directorio de la base de datos del blanco en el campo
Citadel database folder (carpeta de la base de datos Citadel).

Nota:  Las configuraciones de State Information (información del estado) y de Citadel database (base
de datos Citadel) que usted hace cuando crea un proceso invalida cualquier configuracion que se  pudo
haber hecho en el cuadro de diálogo de System Options (opciones del sistema).
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Creando objetos

Escogiendo Objetos
¿Cómo usted decide qué objetos usa y qué conexiones hace?

Algunas decisiones son fáciles; usted usará seguramente objetos driver para diferentes PLCs, RTUs
y otros aparatos que usted necesita supervisar y controlar. Otras decisiones son hechas por lo que
usted desea hacer.

Para solucionar problemas con LookoutDirect pregúntese qué objeto hace lo que usted necesita
hacer.
LookoutDirect tiene muchas clases de objetos con aplicaciones obvias, tales como botones,
interruptores y exhibiciones de gráficos de tendencia. Otras clases de objetos de LookoutDirect
pueden no ser inmediatamente obvias en cómo pueden ser que sean usadas. Para familiarizarse con
las clases de objetos de LookoutDirect, usted puede mirar la ayuda en linea de la Referencia de
Objetos de LookoutDirect, o del Manual de Referencia de Objetos de LookoutDirect que fue instalado
junto con LookoutDirect.

El cuadro de diálogo Select Object Classes que aparece cuando usted crea un nuevo objeto tiene
descripciones cortas de cada clase de objetos. Leyendo y estudiando estas descripciones es otra buena
manera de conocer las funciones de LookoutDirect. Usted puede encontrar una lista de estas
descripciones en el Apéndice A, Descripciones de objetos de LookoutDirect.

Después de que se haga familiar con las clases de objetos de LookoutDirect, usted tendrá una mejor
idea  de qué objeto crear o que clases de objetos puede investigar, para solucionar el problema que
usted está enfrentando en ese momento.

Creando un objeto
Complete los pasos siguientes para crear un objeto de LookoutDirect.

1. Abra o cree un nuevo proceso, si uno no está ya abierto, en LookoutDirect. Cerciórese de que
usted  esté en el  modo Edit. (seleccione  Edit>Edit  Mode o apriete < Ctrl-Shift > en
caso de necesidad.)

2. Hay dos maneras de crear nuevos objetos en LookoutDirect:
• Seleccione Object>Object Explorer desde el menú para activar al explorador de objetos

LookoutDirect. Haga clic en el botón derecho en el proceso que usted desea crear un
objeto y seleccione New Object (nuevo objeto). Para este ejemplo, seleccione la clase de
objetos potenciómetro, encontrado en la categoría de control.

• Seleccione el comando  Object>Create de la barra de menú de LookoutDirect. Para este
ejemplo, seleccione la clase de objetos potenciómetro, encontrado en la categoría de
Control .
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3. Aparece el cuadro de diálogo Select Object Class, según lo mostrado en la figura siguiente.

Figura 5-1. Cuadro de diálogo Select Object Class

La primera vez que usted crea un objeto en LookoutDirect, aparece el cuadro de diálogo Select
Object Class con la opción Categorize marcada. Algunas clases de objetos están contenidos en
más de una categoría, dependiendo de su versatilidad.

Si una categoría está abierta, usted puede saltar a la clase de objetos que usted desea teclando las
primeras letras. Para tener acceso a todas las clases de objetos con esta técnica, inhabilite la
opción Categorize haciendo clic para remover la marca en la caja de verificación de Categorize.
Cuando usted selecciona una clase de objetos, aparece un cuadro de diálogo que usted usa para
definir los parámetros para un objeto específico, según lo mostrado en el ejemplo siguiente para
crear un objeto  potenciómetro .

Figura 5-2.  Cuadro de diálogo de definición de Objetos 
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4. Asigne un nombre único al objeto. Nombres válidos se describen en la sección siguiente,
nombres de objetos.

5. Defina los parámetros del objeto. Cada clase de objetos tiene parámetros únicos, descritos en
el archivo de ayuda de LookoutDirect o el Manual de Referencia de Objetos de LookoutDirect.

Los parámetros ordinarios que se pueden configurar solamente en el cuadro de diálogo de la
definición de objetos son indicados por campos blancos.

Algunos parámetros, sin embargo, son expresiones, denotadas por un campo amarillo. Las
expresiones le dejaron configurar un valor de parámetro por programa conectando el
parámetro con un miembro de datos de otro objeto. Usted puede también manipular datos
usando las funciones de expresión, que son aproximadamente el equivalente de fórmulas de
una hoja de cálculo. 

Vea la sección de los objetos que conecta de este capítulo para una explicación básica de cómo
usar expresiones, y el capítulo 2, Expresiones, del Manual de Desarrollo de LookoutDirect para
más información detallada sobre expresiones y las funciones de expresión. El ejercicio de
enseñanza en el capítulo 3, como comenzar con LookoutDirect, también muestra expresiones.

6. Deje Position source (fuente de estado) configurada como local.

La fuente de estado determina qué valor toma el control cuando su proceso se abre, y también
afecta  la manera que el control funciona.

Seleccionando como Local configura su control para tomar su valor del archivo de estado
cuando el proceso se abre. El valor de control no cambiará a menos que usted lo configure
manualmente o en el programa con una conexión directa al miembro de datos  del valor  de
control.

Seleccionando Remote configura su control para tomar su valor inicial de un miembro de
datos de de lectura/escritura de un otro objeto de LookoutDirect. Para lograr esto usted entra
un URL al miembro de datos, dondequiera que su proceso de anfitrión pueda estar
funcionando. Esta conexión es recíproca; ajustando el control cambia el valor del miembro de
datos, y cualquier cambio en el miembro de datos por alguna causa ajusta el valor del control. 

Vea la sección Conexiones de fuentes de posición remotas de este capítulo para más información
sobre controles remotos.

Nota: La fuente de estado remota ha cambiado en LookoutDirect 4.0.Si usted está acostumbrado a desarrollar
procesos en versiones anteriores de LookoutDirect, cerciórese de leer la sección de las conexiones de fuente
de estado remotas de este capítulo para entender los cambios y hacer el mejor uso de esta característica.

Usted puede seleccionar DDE como su fuente de estado si usted desea usar redes  con DDE o
si usted necesita conectar su control con una aplicación deferente de LookoutDirect, por
ejemplo Microsoft EXCEL. 

Vea el capítulo 5, Intercambio Dinámico de Datos, del Manual de Desarrollo de LookoutDirect
para más información sobre el uso de esta característica.



Manual de cómo comenzar LookOutDirect5–10

Capítulo 5: Usando LookoutDirect

1

2

3

4

5

6

7

8

9

10

11

12

13

14

A

B

C

D

Redes que usan DDE fueron utilizadas en versiones anteriores a LookoutDirect 4.0. En general, la
creación de una red TCP/IP construída en LookoutDirect 4.0 y mas nuevo es más eficiente y más
fácil que la creación de una red con DDE. 

Si usted está manteniendo un proceso de un LookoutDirect antiguo, o tiene una cierta necesidad
especial de utilizar una red con DDE, usted puede encontrar más información detallada sobre esta
función en el apéndice A, Establecimiento de una red con DDE, del Manual de Desarrollo de
LookoutDirect.

7. Seleccione OK para crear el nuevo objeto.

Muchas clases de objetos no tienen componentes (con excepción de un valor del miembro de datos)
que usted pueda exhibir en un panel de control, tal como un driver de protocolo para un PLC
típico, o una clase de objetos tal como Neutralzone o pulso (ambas clases de objetos de
LookoutDirect con funciones especiales).

Algunos objetos, como los potenciómetros, se pueden exhibir en un panel de control. Cuando
usted crea tal objeto, LookoutDirect le presenta un cuadro de diálogo que usted usa para definir
cómo el objeto se muestra en el panel actualmente activo (si hay uno).

8. Si usted creó su objeto usando al explorador de objetos de LookoutDirect, aparecerá en la ventana
del explorador de objetos pero no en cualquier panel de control. Para exhibir el potenciómetro,
usted tendrá que arrastrarlo y soltarlo en el panel de control en que se quiere que aparezca. Si usted
creó su objeto usando el menú, el cuadro de diálogo de las propiedades de exhibición aparece al
hacer clic en OK para acabar de definir el objeto.

Figura 5-3. Cuadro de diálogo de Exhibición del Potenciómetro  
9.  En el cuadro de diálogo de exhibición, elija cómo usted quiere que el objeto sea representado

y selecciónelo y luego haga clic en  OK.
10.Coloque el objeto en el panel de control y configuración el tamaño.

Nota: Usted puede copiar objetos para pegar sobre otro panel de LookoutDirect en el mismo proceso, pero
si los paneles son de tamaños diferentes, los objetos pegados pueden no aparecer en la localización
apropiada en el panel nuevo. En general es más fácil arrastrar el objeto al panel nuevo del explorador de
objetos de LookoutDirect.

Accionador Horizontal



Nombres de Objetos 
Un nombre de objeto sirve para identificar un objeto específico. Usted debe asignar a cada
objeto un nombre único. LookoutDirect no permite que usted cree o que modifique un objeto
si el nombre no es único o si no sigue las convenciones de nombres.

Las reglas para escojer los nombres  son como sigue:

• Los nombres pueden incluir los caracteres A - Z, a - z, 0 - 9, y el carácter de subrayar (_).

• Los nombres deben comenzar con una letra.

• Los nombres pueden tener hasta 32 caracteres

• No se permiten espacios y tabs

•     LookoutDirect reconoce caracteres mayúsculos y minúsculos  como el mismo carácter, así que  SW2
y  sw2  son el mismo nombre.

• Los nombres no deben ser palabras claves de LookoutDirect (los nombres de la clase de
objetos y los nombres de funciones). Por ejemplo, usted no debe utilizar términos tales
como Switch, delayOn, STDEV, Modbus, nif, y Trend. Usted puede, sin
embargo, utilizar Switch1, Switch2, etcétera.

A continuación ejemplos de nombres válidos:

• Pump3_HOA 
• HighServicePump3_Run
• Nivelpozo11_en__Limar?
• HighServicePump3_Run

• Pushbutton1
A continuación algunos ejemplos  de nombres  inválidos:

·
  

3Pump_HOA, que comienza con un número 

·
  

_ HighServicePump3_Run, que comienza con una raya 

·
  

Nivelpozo11 en Limari , que contiene espacios 

·
  

# ShaftTempF, que comienza con # 

·
  

Pushbutton, que es una palabra reservada 

·
  

Estenombretienemasdetreintaydoscaracteres, que es demasiado largo 

·
  

and , que es una palabra reservada 
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Conectando Objetos
En LookoutDirect usted conecta objetos para pasar señales de control  entre objetos.Una vez que
estén conectados, los objetos pasan señales entre sus varios miembros de datos y parámetros.

Hay un gran cantidad de clases diferentes de conexiones en LookoutDirect y diversas maneras
de hacer esas conexiones. El método que usted utiliza depende de lo que usted está tratando de
hacer.

·
  

Usted puede conectar a un miembro de datos con otro. 

·
  

Usted puede conectar un miembro de datos con un parámetro de objeto, o un parámetro
de objeto con un miembro de datos. 

·
  

Finalmente, usted puede hacer una conexión de URL como una fuente remota de posición
para un control LookoutDirect o una conexion simbólica, o como artículo de rastreo para
un objeto HyperTrend.

Usted puede hacer estas conexiones de LookoutDirect de las siguientes maneras:

·
  

Directas- Hecho con el cuadro de diálogo Edit Connections, estas conexiones son fijas y
trabajan en una dirección solamente. Esta clase de conexión se debe hacer solamente de un
proceso del servidor al hardware instalado en la computadora de servidor, o entre los
objetos contenidos dentro del mismo proceso.

·
  

Remotas-Un conexión remota de URL es un tipo flexible de conexión completamente
recíproca entre un control de LookoutDirect y un miembro de  datos de lectura/escritura
de objetos. Cambiando el control cambia el miembro de datos, como usted esperaría, pero
si el valor de ése miembro de datos cambia por alguna otra causa, el valor de control
cambia también. Esta clase de conexión es lo que usted usa para conectar un proceso de
cliente con uno del servidor, o para unir dos procesos de cliente  a través de un servidor.

·
  

Complejas-usted puede hacer conexiones complejas usando variables y pruebas lógicas
para responder dinámicamente a necesidades y a circunstancias cambiantes. Las conexiones
complejas pueden aplicar operaciones matemáticas a los datos, procesándolas para usos por
otro objeto. Usted puede hacer conexiones complejas directas, y con el objeto de
conexiones simbólicas de LookoutDirect, hacer también conexiones complejas remotas.

Sugerencia Recuerde, cuando usted elige un objeto en el cuadro de diálogo Edit  Connections,
seleccione siempre el objeto al que usted desea conectar.
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Conectando miembros de datos a parámetros
El ejemplo siguiente utiliza a miembro (implícito) de datos de un objeto potenciómetro  como
la fuente de datos de un objeto Average (promedio) para ilustrar el tipo más simple de conexión
deLookoutDirect. Usted puede decir que Data (datos) sea un parámetro porque aparece en el
cuadro de diálogo del objeto Average.

Suponga que usted crea un objeto potenciómetro según lo mostrado en la ilustración siguiente.

Usted puede ser que cree después un objeto
Average. 

Conecte la señal numérica del potenciómetro con el
parámetro Data (datos) entrando Po

t1

como el
parámetro de datos del objeto Average.  

El objeto Average calcula el nivel promedio de Pot1
en un cierto período, según lo descrito en la
definición del objeto en la ayuda de LookoutDirect
o el Manual de Referencia de objetos de
LookoutDirect.

Éste es el caso más simple para hacer una conexión directa en LookoutDirect; conecte la entrada
de un objeto con la salida de otro objeto en el mismo proceso. En muchos casos usted tendrá
que conectar objetos en un proceso con los objetos en otro proceso en la misma computadora,
o en otra computadora en la red. Para estas conexiones usted puede hallar más conveniente usar
el redactor de expresión, a que usted tiene acceso haciendo clic en el botón derecho en el campo
amarillo de la expresión. 

Los ejemplos en el capítulo 3, Como comenzar con LookoutDirect, le guían en como hacer
conexiones detalladamente.
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Identificando a miembros de datos de Objetos
Ya que muchos objetos generan señales múltiples que usted puede usar como entradas a otros
objetos, el nombre del objeto no es siempre suficiente para identificar la señal deseada. Usted
debe identificar al nombre del objeto y al miembro apropiado de datos. Por ejemplo, un objeto
Modbus genera millares de señales, algúnas lógicas y algúnas numéricas. Para especificar
exactamente que señal desea desde un objeto particular Modbus, teclee el nombre del objeto
seguido por un punto (.) y el miembro de datos que usted desea.

Si usted tiene un objeto Modbus con un nombre  PL
C1

,  y usted desea exhibir el valor que reside
en llevar a cabo el registro 40001 y el estado de la bobina 100, refiérase a esos miembros
particulares de datos por PLC1.40001 tecleando en una expresión y PLC1.100 en otra
expresión.

Conectando miembros de datos a miembros de datos
La información siguiente es una extensión del ejemplo anterior, en el cual usted creó un
potenciómetro nombrado  Po

t1

. En este ejemplo, usted crea un objeto Modbus y conecta la
señal numérica generada por el potenciómetro  con un holding register de 16 bits en la dirección
40001 en el PLC.
1. Cree un objeto Modbus. Usted no tiene que tener un PLC real conectado con su sistema.

Solamente acepte las configuraciones del parámetro por defecto en la caja de diálogo de
Modbus y haga clic en OK.

2. Si su explorador de objetos está abierto, haga clic en el botón derecho en el objeto Modbus
que usted acaba de crear y seleccione  Edit Connections del menú pop-up. Si no,  seleccione
Object>Edit Connections desde la barra de
menú de LookoutDirect. Usted utiliza el
cuadro de diálogo Edit Connections cada vez
que esté conectandose con la base de datos de
otro objeto.

3. Si usa el comando de menú Object>Edit
Connections, aparece la caja de lista de Edit
Object Connections. Elija el objeto que
contiene el miembro de datos al que usted se
está conectando.

El campo Current location (localización
corriente) en la parte superior de este cuadro de
diálogo debe mostrar su computadora como raíz.
Vea la sección de navegación de LookoutDirect
para más información sobre cómo configurar la
raíz en un cuadro de diálogo de LookoutDirect.
Porque usted está conectando  la señal  Pot1  con
el miembro de datos 40001 en el objeto Modbus,
seleccione  el objeto Modbus1 y haga clic en OK.
Aparece el cuadro de diálogo Edit Connections.
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La parte superior de este cuadro de diálogo contiene la información sobre el objeto al que
usted se está conectando .Usted selecciona un miembro escribible de datos  de ésos
enumerados en la lista Writable members (miembros escribibles), y el miembro seleccionado
aparece a la izquierda del campo amarillo de expresión en el centro del cuadro de diálogo.

La parte más inferior del cuadro de diálogo le deja navegar al miembro de datos que usted
desea conectarse con el miembro de datos que Ud selecciona en la porción superior de la caja.
Usted puede también entrar a un miembro de datos directamente en el campo amarillo de la
expresión.

4. Teclee el miembro de datos al que usted desea conectarse en la caja de lista a la derecha del
botón Select. Usted puede teclear en miembro de datos que usted desea directamente, o usted
puede elegirlo en la lista de miembros escribibles y haciendo clic en el miembro de datos (o
el rango de los miembros de datos) que usted desea. Usted puede corregir el número que
aparece en la caja de selección.

Haga clic en  el botón Select para identificar al miembro de datos al que se escribirá. Note
que el cuadro de diálogo ahora refleja un miembro específico;  Modbus1.40001 =. También
note el signo igual (=) . Esto le pide conectar una expresión con Modbus1.40001.  En este
caso, utilice la expresión  Pot1.

5. Dentro de la sección de Signals (señales) del cuadro de diálogo, configure su computadora
local como la raíz en el campo In. Navegue a Pot1 y selecciónelo haciendo clic en él. Haga
clic en  un miembro (implícito ) de  datos en la lista  Contents (readable) y después haga clic
en el botón Paste.
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Note que el tipo de datos de los miembros de datos que usted ha seleccionado está mostrado
para ayudarle a cerciorarse de está conectando como tipo con un tipo semejante. Note
también que usted puede corregir fácilmente conexiones existentes  haciendo clic en la lista
en el campo Existig Connections.

Nota:  Exactamente sobre la lista Contents (readable) en las sección señales, usted notará una caja de lista
nombrada Path Mode. Esto es un configuración importante para desarrollar procesos de red en
LookoutDirect. Vea los nombres de la trayectoria en la sección de LookoutDirect para una información más
detallada sobre cómo utilizar esta característica. Se muestra el uso de diversas configuraciones de la
trayectoria en los ejercicios contenidos en el capítulo 3, como comenzar con LookoutDirect.

6. Haga clic en el botón Accept. Esto confirma la conexión. Usted debe ver un mensaje
confirmando la acción. Usted también verá el miembro  de datos 40001 agregado a la caja de
lista en el campo Existing Connections.

Usted ahora ha conectado un miembro de datos de un objeto con un miembro de datos de otro
objeto. Cualquier cambio en el valor (implícito)  de Pot1 es, por definición, un evento,
enviando una señal al resto de objetos al que  Pot1 está conectado. Ya que ahora está
conectado con  Modbus1.40001, la configuración  de Pot1 cambia el valor del miembro de
datos  40001 en el objeto  Modbus1.
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Conexiones de URL
Una conexión de URL (localizador universal de recursos) es distinta de una conexión hecha con una expresión
porque no puede contener ninguna condición de verificación u operaciones matemáticas. También está
diseñada para permitir un flujo recíproco de datos a través de la conexión. Un control conectado con un
registro del PLC usando una conexión de URL cambia el valor del registro cuando se ajusta. Pero si el valor
del registro cambia por alguna otra causa, el control también cambiará para igualar al valor corriente del
registro.

Usted puede hacer solamente una conexión de URL a los miembros de datos  que  son escribibles, o legibles
y escribibles. Usted no debe hacer una conexión de URL a un miembro de datos inalterable. Las conexiones
remotas de la fuente de estado, las conexiones simbólicas, y el objeto HyperTrend requieren conexiones de
URL, según lo indicado por
un campo verde.

Usted puede corregir un
URL haciendo clic en el
botón derecho en el campo
verde, que abre el cuadro de
diálogo del redactor de URL
de LookoutDirect, mostrado
en la figura adyacente.

Usted puede utilizar la lista
del árbol en la ventana
izquierda para localizar el
objeto que usted desea, y
seleccionar un miembro de
datos en la ventana derecha.
Haga clic en el botón Paste
para insertar la secuencia
completa en l campo de
URL.

Usted controla la relatividad
de la trayectoria de su URL con la caja de la selección Path Mode (modo de la trayectoria). 

Vea el capítulo 4, nombres de la trayectoria en la sección de LookoutDirect para más información sobre como
usar la selección de modo de la trayectoria.

Conexiones remotas de la fuente de estado
La conexión remota de la fuente de estado es el método preferido para conectar un control en
un proceso en una comoputadora cliente con un proceso en el servidor en LookoutDirect.

Ya que normalmente  usted desea poder tener procesos del cliente trabajando desde cualquier
computadora en su red sin tener que modificarlas, lo mejor es hacer conexiones de procesos del
cliente a los procesos del servidor, y no de los servidores a los clientes. Ya  que los procesos del
servidor necesitan funcionar generalmente de la misma computadora a cada instante, usted
puede utilizar trajectorias absolutas para cerciorarse de que sus procesos  en el cliente se
conectarán con los procesos en el servidor, no importa dónde estén funcionando los clientes.
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Conexiones de Conexión Simbólicas
Los objetos de conexion simbólica (Symbolic Link) tienen varias aplicaciones importantes en
LookoutDirect. Es la mejor forma de conectar un cliente a un servidor, son necesarias para
implementar redundancia y para usarlas en conjunto con links dinámicos para conectar
expresiones complejas  

La figura siguiente muestra el cuadro de diálogo Create Symbolic Link (crear conexión
simbólica.

Usted puede hacer una conexión de URL en el campo de la fuente Static a un proceso entero
con una conexion simbólica y después tener acceso a cualquier objeto en ese proceso con la
conexión. Ésta es una parte crucial de la redundancia  de LookoutDirect, que se describe en el
capítulo 10, Redundancia, del Manual de Desarrollo de LookoutDirect.

Usted puede incorporar una expresión compleja en el campo Dynamic de la fuente de conexión
simbólica y después hacer una conexión de URL a la conexión simbólica a sí misma, evitando la
restricción en expresiones complejas en las conexiones alejadas de la fuente de estado para  controles.

Conexiones de elementos Hypertrend
Vada elemento que se muestra en el registrador gráfico hypertrend tiene acceso a trvés de una
conexión URL , ya que los datos de hypertrend vieien desde la base de datos Citadel.

Si usted necesita colocar una expresión compleja en un registrador grafico, usted puede crear
una expresión nombrada creando un objeto (expresión). Usted puede incorporar la expresión
compleja que usted desea graficar, la registra a la base de datos histórica, y después la muestra
como artículo de HyperTrend.

Nota  Si usted convierte un proceso creado en una versión anterior a LookoutDirect 4.0, LookoutDirect
crea y registra automáticamente una expresión nombrada para que su  objeto de HyperTrend exhiba
cuando él  recompile  el archivo fuente .lks.

Ejemplo de link simbolico
Nombre

Fuente

Estático

Dinámico



Mostrando miembros de datos en paneles de control 
Siga estos pasos para exhibir a un miembro de datos en un panel de control:

1. Cerciórese de que LookoutDirect esté en modo Edit y abra el explorador de objetos
seleccionando  Object>Object Explorer.

2. Navegue al  objeto o al miembro de datos del objeto que usted desea exhibir en su panel. En
la figura siguiente, se ha seleccionado a un miembro de datos de un objeto de forma de onda
que funciona en un proceso de servidor situado en otra computadora en la red.

3. Arrastre y suelte el miembro de datos sobre el panel que usted quiere que los datos sean
mostrados. LookoutDirect coloca una expresión para exhibir los datos. Usted  puede tener
que ajustar el tamaño de la exhibición para que los datos aparezcan correctamente.

4. Haga clic en el botón derecho en la exhibición para cambiar sus características de exhibición,
para modificar la expresión, para cambiar el formato de datos, o para alterar cualquier otra
característica de exhibición.

Usted puede también insertar una expresión a los datos de exhibición eligiendo
Insert>Expression de la barra de menú LookoutDirect. Aparece el cuadro de diálogo Insert
Expression según lo mostrado en la figura siguiente.
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5. Navegue al miembro de datos que usted desea exhibir, como usted hizo con el explorador de
objetos.

6. Configure el modo de la trayectoria. En la figurA precedente se configura a absoluto porque
los datos se están exhibiendo en un panel de proceso del cliente en una computadora
(paroikos) y se origina de un proceso del servidor en una computadora diferente (tripper).

7. Seleccione el miembro de datos que usted desea exhibir en la lista Contents.

8. Haga clic en Paste y después OK.

LookoutDirect responde presentando el cuadro de diálogo Display Numeric Signal o Display
Logical Signal. El tipo de cuadro de diálogo depende del tipo de miembro de datos que es
insertado (numérico o lógico). En este caso la señal es numérica, una onda de coseno generada
por el objeto Waveform 

Seleccione los parámetros de exhibición que usted desea, y haga clic en OK.

Usted puede también arrastrar un objeto del explorador de objetos a un panel. Cuando usted lo
hace, aparece el cuadro de diálogo Insert expression, y usted puede proceder como usted lo hizo
cuando usted invocó este cuadro de diálogo del menú.
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6AA
DESCRIPCIONES DE
OBJETOS DE
LOOKOUTDIRECT
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Descripciones de objetos
Este apéndice suministra descripciones de los objetos del sistema y del objetos drivers de
LookoutDirect.

Usted construye procesos de LookoutDirect creando objetos y haciendo conexiones
seleccionadas.

LookoutDirect tiene dos clases de objetos: 

El objetos de sistema, que usted utiliza para controlar, supervisar, análizar datos, y presentar
datos, y los objetos drivers de LookoutDirect, que usted utiliza para conectar con el hardware,
tal como PLCs (controladores logicos programables), RTUs (unidad de terminal remota),
computadoras y otro hardware

Objetos del Sistema LookoutDirect
La tabla siguiente enumera los objetos directos del sistema LookoutDirect, junto con sus
categorías y una descripción de lo que cada hace.

Tabla A-1.  Objetos del Sistema LookoutDirect
Tabla A-
1 .
Objetos
d e l
Sistema

LookoutDirect
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Clase de objetos Categoría Descripción
Acumulador Cálculo, Control Acumula un total corriente agregando un valor muestreado al total anterior

cada vez que se haga una muestra. Está también disponible un reset de l
disparo de capura de muestra.

Alarma . . . . . . . . . . . . . . Registrando Defina las condiciones de alarmas específicas que pueden accionar alarmas
vía condiciones complejas, o como resultado de entradas numérica que
salen fuera del rango o basado en una tasa de cambio. Agregue  archivos
audibles (del wav ) a estas alarmas, sonidos que serán emitidos siempre que
se accionen las condiciones de alarmas.

Animator Exhibición Anima o coloca en movimeinto archivos de gráficos dinámicamente con
cualquier combinación de movimiento horizontal y vertical, cambiando
tamaño, visibilidad y cambios de color. Muestra imágenes  consecutivas de
fotos en BITMAP para simular movimientos complejos en la pantalla.

Average (Promedio) Cálculo, Control Calcula el promedio de una entrada variable en un cierto período. Controla
opcionalmente cuando hacer un promedio está activo a través de la entrada
Enable ( permiso), y reseta el promedio a la entrada corriente a través de la
entrada de reset. Están disponibles resultados de hasta 35 promedios
anteriores, y el promedio actual se actualiza aproximadamente una vez por
segundo

Counter (Contador) Control,
Registrando 

Cuenta y registra el número de veces que una señal lógica se activa.
Reseta opcionalmente el conteocon la entrada de reset. El conteo máximo
es aproximadamente 252.

DataTable Control,
Establecimiento
de una red 

Hace múltiplexing de múltiples Modems en un solo panel de control
permitiendo que el operador altere configurar del cursor de la tabla.
Importe y exporte las tablas enteras de datos entre otras apicaciones a
trravés de  DDE y NetDDE. Un DataTable consiste en una matriz de células
dispuestas en filas y columnas.

DdeLink Establecimiento
de una red 

Importe un solo valor corriente en LookoutDirect desde otra aplicaci'on vía
el DDE o NetDDE.
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Clase de objetos Categoría Descripción
DdeTable Establecimiento

de una red 
Importa una tabla de valores en LookoutDirect desde otra aplicación a través del
DDE o NetDDE. DdeTable es un subconjunto de clase de objetos de DataTable
que permite el flujo bidireccional de  datos DDE y de NetDDE.

DelayOff Control,
temporizadores 

Introduce un atraso entre el tiempo que la señal de entrada se desactiva  y este
temporizador se desactiva.

DelayOn Control,
temporizadores 

Introduce un atraso entre el tiempo que la señal de entrada se activa  y este
temporizador se activa.

Derivative Cálculo,
Control 

Calcula la tasa de cambio de una señal numérica, especificando la unidad de
tiempo.

DialGauge Exhibición Exhibe una señal numérica como dial con aguja de indicación. Especifica la
posición inicial y el ángulo en que se desplaza.

ElapsedTime Control,
Registros.
temporizadores

Calcula y registra el tiempo transcurrido acumulado que una señal particular ha
estado ON. Usa opcionalmente la entrada de reset para hacer cero el tiempo
transcurrido en cualquier momento.

Event (Acontecimiento) Registro,
Supervisión

Registra permanentemente la ocurrencia de un evento particular al registro de
eventos (event log).

Flip-flop Control Cambia el estado de este objeto de ON a OFF, o de OFF a ON cada vez que la
señal de entrada se hace ON.

Gauge Exhibición Exhibe un valor numérico como valor digital o como gráfico de barras, y cambia
el color de la barra o de los dígitos basados en un conjunto de condiciones.

HyperTrend Exhibición,
Registro 

Exhibe y lee datos históricos como registrador con gráfico en el tiempo, y
magnifica datos de interés o busca la base de datos histórica de Citadel para
determinar los valores máximos, los mínimos, y otros puntos de interés. Puede
ir para atrás en tiempo, o salta a cualquier fecha y hora específicas
inmediatamente.

Integral Cálculo,
Control 

Totaliza una señal de entrada numérica que represente una tasa con respecto a
tiempo, especificando la unidad de tiempo. Totaliza el flujo basado en un caudal
medido es un uso típico de integral.

Interval Control,
temporizadores 

Introduce un atraso entre el tiempo que la señal de entrada se activa y este
temporizador se desactiva. El temporizador se activa inmediatamente cuando la
entrada se activa, y permanece ON por la duración del temporizador o hasta que
la señal de entrada se hace OFF.

L3OPCClient Obsoleto Cliente obsoleto de LookoutDirect OPC. Utilice la versión 4.0 del cliente de OPC
en lugar del otro.Esta clase es incluída por compatibilidad.

L3Pot Obsoleto Un potenciómetro de LookoutDirect 3.8 para seguir y/o para alterar el valor de
una variable numérica. Un potenciómetro  se puede exhibir en un panel como
un resbalador, una perilla que rota, o display/input digital. Esta clase es incluida
por compatibilidad hacia atrás con LookoutDirect 3.xx.

L3Pushbutton Obsoleto Un botón de LookoutDirect 3.8 para navegar entre paneles de control dentro de
LookoutDirect , o para iniciar cualquier otra acción, tal como ejecutar una
aplicación externa, o enclavar una bomba ON u OFF. Esta clase es incluida por
compatibilidad hacia atrás con LookoutDirect 3.xx.
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Tabla A-1.  Objetos del Sistema LookoutDirect

Clase de objetos Categoría Descripción
L3Switch Obsoleto Un interruptor de LookoutDirect 3.8 para seguir y/o para alterar el valor de una

variable lógica. Un interruptor se puede exhibir en un panel en varias
maneras.Esta clase es incluida para compatibilidad hacia atrás con
LookoutDirect 3.xx.

L3TextEntry Obsoleto Un objeto de entrada de texto de LookoutDirect 3.8 para seguir  la pista y
modificar un valor de texto a través de un  panel de control, usando el teclado
de la computadora o del teclado virtual en la pantalla. Esta clase es incluida para
compatibilidad hacia atrás con LookoutDirect 3.xx.

LatchGate Control  Enclava la salida de este objeto a ON u OFF basado en una de dos señales de
entrada se hizo ON por último.

Loader (Cargador) Control Cargue o descargue un archivo de proceso cuando la entrada se hizo ON.

Maximum  (Máximo) Cálculo,
Control 

Calcula el máximo de una entrada variable en un cierto tiempo. Controle
opcionalmente cuando la supervisión del máximo es activa a través de  la
entrada Enable (permiso), y reseta el máximo al valor corriente a través de la
entrada de reset. Están disponibles  resultados de hasta 35 máximos anteriores.

Meter Exhibición Exhibe un valor numérico como un gráfico de barras vertical o velocímetro. Las
exhibiciones completas proporcionan  barras y agujas, etiquetas, escalas, y
fondo.

Minimum  (Mínimo) Cálculo,
Control 

Calcula el mínimo de una entrada variable en un cierto tiempo. Controla
opcionalmente cuando la supervisión del mínimo se hace activa a través de la
entrada Enable (permiso), y reseta el mínimo al valor corriente a través de la
entrada de reset. Están disponibles  resultados de hasta 35 máximos anteriores.

Monitor Establecimiento
de una red 

Supervisa un solo punto de E/S de la red y genera una salida TRUE
(VERDADERO) si la calidad de los datos es mala.

Neutralzone Control Controla el estado ON u OFF de una señal basada en una señal numérica de
entrada, y basada en dos límites de control superiores e inferiores s
potencialmente variables. Use un Neutralzone para controlar si una bomba está
funcionando basada en el nivel que varía en un tanque de almacenaje de agua,
por ejemplo.

OneShot Control,
temporizador 

Introduce un atraso entre el momento en que la señal de entrada se hace ON y
este temporizador se hace OFF. El temporizador se hace ON inmediatamente
cuando la entrada se activa, y permanece ON por la duración del tiempo
predefinido en el temporizador, y luego se hace OFF independiente de la señal
de entrada.

Pager Supervisión Llama un mensaje numérico o alfanumérico y entrega  automáticamente los
mensajes basados en condiciones o  alarmas especificados en el proceso..

Pipe Exhibición Exhibe rectángulos en la pantalla, y controla sus colores basados en un sistema
de hasta seis condiciones diferentes.

PlayWave Exhibición Haga sonar  un clip de audio estándar de Windows (wav ) basado en satisfacer
una condición especificada.

Pot (Potenciómetro)  Control,
Exhibición 

Cree un potenciómetro para para alterar el valor de una variable numérica. Un
potenciómetro se puede mostrar con un deslizador, una perilla  o entrada
digital. 
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Clase de objetos Categoría Descripción
Pulse Control,

temporizador
Crea un tren de pulsos de un período y de una duración especificada y variable.
El tren de pulsos puede ser  activado  basado en el estado de la señal ON/OFF.

Pushbutton (Botón) Control, . . . . . . 
Exhibición 

Crea un botón momentáneo para navegar entre los paneles de control dentro
LookoutDirect, o para iniciar cualquier otra acción, tal como ejecutar una
aplicación externa, o enclavar  una bomba ON u OFF.

RadioButtons Control, . . . . . . 
Exhibición 

Crea un sistema de botones en que solamente uno puede estar activo a la vez.
Los botones de radio se pueden exhibir de  varias maneras.

Recipe Control, . . . . . . 
Exhibición 

Crea un sistema de recetas en un uso de hoja de cálculo tal como Microsoft
EXCEL e importa una receta para permitir que el usuario seleccione una receta
particular. La receta permite cualquier cantidad de ingredientes; cada columna
en la hoja de cálculo representa un ingrediente específico.

Run Control Invoca un comando de aplicación de Windows con un conjunto variable de
parámetros de comandos, cuando se activa la señal de entrada RUN WHEN.

Sample Cálculo,
Control 

Toma una muestra de una variable numérica cuando la entrada de reset se
hace ON. Controla opcionalmente cuando el muestreo es activo a través de la
entrada Enable (permiso) y hace cero la primera muestra al valor corriente a
través de  la entrada de reset. Están disponibles resultados de hasta 35
muestras anteriores.

SampleText Cálculo,
Control 

Toma una muestra de una variable de texto cuando la entrada de reset se hace
ON. Controla opcionalmente cuando el muestreo es activo a través  la entrada
Enable ( permiso), y hace cero la primera muestra al valor corriente a través de
la entrada de reset. Están disponibles resultados de hasta 35 muestras
anteriores. 

Scale Exhibición Crea una escala dinámica donde el rango y los valores  mínimos y máximos
pueden cambiar dinámicamente de acuerdo a  entradas variables.

Sequencer Control Crea un objeto secuenciador que genera una secuencia de estados en salidas
asociadas. El secuenciador permanecerá en el estado actual hasta que se
alcanza el límite de tiempo de ese estado o  hasta una instrucción  Goto o Jump
causa que  la entrada haga una transición a otro estado.

Spinner Exhibición Exhibe un disco pequeño que gira  a una velocidad que varía según un valor
numérico de entrada. Un spinner se puede hacer girar en ambas direcciones y
puede también ser controlado  por una entrada simple lógica.

Spreadsheet Registro Registra permanentemente datos al disco duro  en archivos del tipo CSV de
hojas de cálculo con estándar del tipo valores separarados por coma (.csv).
Especifica qué variable  muestrea en cada columna e configura un disparador
lógico que registre el sistema de datos cada vez el disparador se hace ON o
registra datos en intervalos especificados de tiempo.

Switch Control,
Exhibición 

Crea un interruptor basculante (toggle) para para alterar el valor de una variable
lógica.  Se puede mostrar un switch en un panel de varias maneras.

TextEntry Control,
Exhibición 

Permite que el operador vea y modifique un valor de texto a través  un panel de
control, usando el teclado de la computadora o un teclado virtual en la pantalla.

TimeOfDay Control,
temporizador

Programa un pulso periódico de una duración especificada  que ocurre en una
cierta hora en cada día. Este tiempo se puede activar y desactivar a través de
una señal de entrada  ON/OFF.

TimeOfHour Control,
temporizador

Programa un pulso periódico de una duración especificada  que ocurre en una
cierta hora en cada hora. Este tiempo se puede activar y desactivar a través de
una señal de entrada  ON/OFF.



Tabla A-1.  Objetos del Sistema LookoutDirect

Clase de objetos Categoría Descripción
TimeOfMinute Control,

temporizador
Programa un pulso periódico de una duración especificada  que ocurre en un cierto
momento en cada minuto. Este tiempo se puede activar y desactivar a través de una
señal de entrada  ON/OFF.

TimeOfMonth Control,
temporizador

Programa un pulso periódico de una duración especificada  que ocurra en un cierto
momento en cada mes. Esto se puede acticar y desactivar  a través  la señal de
entrada ON/OFF.

TimeOfWeek Control,
temporizador

Programa un pulso periódico de una duración especificada  que ocurra en un cierto
momento en cada semana. Esto se puede acticar y desactivar  a través  la señal de
entrada ON/OFF.

TimeOfYear Control,
temporizador

Programa un pulso periódico de una duración especificada  que ocurra en un cierto
momento en cada año. Esto se puede acticar y desactivar  a través  la señal de
entrada ON/OFF.

Waveform Cálculo Crea formas de onda con seno, onda cuadrada, diente de sierra, triángulo, y formas
de onda al azar con valores especificados para período, amplitud, cambio del cero
, desfase, y tasa de muestreo.
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Objetos  drivers de LookoutDirect

La tabla siguiente enumera los objetos drivers de LookoutDirect, junto con sus categorías y una
descripción de lo que cada uno hace.

Tabla A-2.  Objetos drivers de LookoutDirect 
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Clase de objetos Categoría Descripción
AB_PLC5 Driver Se comunica con la línea de PLC5 de Allen-Bradley a través del puerto serial,

Data Highway Plus (KT, KTx, PCMK, S-s 5136SD), y Ethernet TCP/IP.

AB_SLC500 Driver Se comunica con la línea de PLCs SLC5 xx deAllen-Bradley a través del
puerto serial, Data Highway Plus (KT, KTx, PCMK, S-S 5136SD), y DH485
(AB1747-ke, AB1770-kf3, KTx, PCMK).

ASCII Driver Se comunica con cualquier aparato que transmita y acepte cadenas de
texto con formato de datos ASCII. Extrae valores numéricos, lógicos y de
texto de mensajes e los incorpora en un proceso LookoutDirect. Por
ejemplo, se puede utilizar la clase de objetos ASCII para leer la salida de un
lector de código de barras.

DeltaTau Driver Se comunica con tarjetas del regulador de movimiento Delta Tau Data
Systems de PMAC a través de tarjetas de memoria de dos puertos.

DirectLogic Driver Se comunica con todos los PLCs de AutomationDirect a través del servidor
de comunicaciones de DirectSoft32. Permite usar RS232 y Ethernet. Permite
compartir la conexión de las comunicaciones entre el programa
DirectSoft32, DSData, y LookoutDirect.

GE_Series90 Driver Se comunica con los controladores programables lógicos de la serie 90-30
y 90-70 de GE a través de RS-232 usando el protocolo serial SNPX, o a
través de Ethernet usando el módulo de comunicación GE TCP/IP.

Modbus Driver Se comunica con cualquier aparato que permita protocolos seriales Modbus,
que tenga un puerto Modbus Plus o tenga un módulo Ethernet de Quantum.
Modbus Plus necesita usar la tarjeta de red Modicon Modbus Plus y el
software adecuado que se instalará en la computadora. El protocolo serial se
comunica a través de protocolos ASCII y RTU.

ModbusMOSCAD Driver Se comunica con PLCs Motorola MOSCAD y RTUs a través  de protocolos
seriales Modbus. Permite usar la convención de datos que usa  Motorola.

ModbusSlave Driver Permite que otros aparatos o computadoras lean y escriban a variables en
el proceso por la interrogación de un puerto serial en la computadora con
el protocolo de Modbus RTU.

National Instruments
Field Point 

Driver Se comunica con el sistema distribuido de E/S modular FieldPoint de
National Instruments a través de  comunicaciones seriales RS-232 o RS-485
o Ethernet.

NIDAQDevice Driver Se comunica con las tarjetas de adquisición de datos de National
Instruments y el hardware SCXI conectados en modo paralelo. Utilice la
clase de objetos de NISCXI para comunicarse con el hardware de SCXI
conectado en modo múltiplex. Esta clase de objetos requiere tener instalado
el software NI-DAQ 5.0 o más nuevo.

NISCXI Driver Se comunica con aparatos de adquisición de datos de National Instruments
conectados en modo múltiplex con el hardware SCXI. Esta clase de objetos
requiere que se instale el software Ni-DAQ5.0 o más nuevo.



B
CREACIÓN Y MANEJO DE
CONEXIONES DE
COMUNICACIONES 7B
En este capítulo...

Creación y manejo de conexiones de comunicaciones  . . . . . . . . . . . . . . . . . . . . . .B–2

Entendiendo el servicio de comunicaciones  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B–3

Definiendo conexiones del puerto serial  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B–3

Miembros de datos de DirectLOGIC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B–7

Estableciendo conexiones a PLCs DirectLOGIC  . . . . . . . . . . . . . . . . . . . . . . . . . . .B–12

Realizando cambios al aparato y el modo de dirección  . . . . . . . . . . . . . . . . . . . .B–15

Glosario          . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B–16

APENDICEAPENDICEAPÉNDICE



Creación y  manejo de conexiones de comunicaciones 

Ciertas clases de objetos representan.drivers de protocolos y por ejemplo PLCs, RTUs, y
controladores. 
LookoutDirect utiliza el término driver para referirse  a estos tipos de clases de objeto. 

La funcionalidad construida en objetos drivers les permite comunicarse con los aparatos físicos
que representan. LookoutDirect se comunica con el mundo exterior sobre todo a través de
objetos drivers.
Los drivers no son aplicaciones separadas. Trabajan como cualquier otro objeto en el ambiente
de acción por evento de LookoutDirect, excepto que se comunican con aparatos externos.

Con los sistemas tradicionales, un driver particular se asigna a un puerto serial específico.

En estas configuraciones, múltiplos  drivers no pueden compartir un solo puerto serial.
LookoutDirect no asocia velocidad, bits de datos, paridad, o bits de parada a un puerto serial
particular. En esta configuración, los drivers que ponen en ejecución los diversos protocolos y
velocidades pueden utilizar el mismo puerto y la mismo módem o radiofrecuencia  (RF).
Esta capacidad permite que usted se mezclen PLCs, RTUs, y otros aparatos sobre un solo RF sin
conflictos de comunicaciones o hardware especial. 

Esto es posible debido al servicio de comunicación de LookoutDirect. Los objetos utilizan el
servicio de comunicaciones para acceder a los puertos seriales en una manera ordenada y
oportuna.

Nota  Algunos objetos drivers de LookoutDirect se comunican con aparatos físicos a través de hardware
dedicado. Estos objetos drivers no utilizan puertos seriales sino que por el contrario confían en sus propias
tarjetas de diseño propietario de red para interconectarse al mundo exterior. Algunos ejemplos incluyen
Modbus Plus (tarjeta SA85), Data Highway (tarjeta  KT), y DeltaTau (tarjeta PMAC). Usted no necesita
configurar los puertos seriales para estas clases de objetos.Vea  a la documentación apropiada de la clase de
objetos en ayuda en línea o el manual de referencia para verificar si una clase particular del objeto utiliza un
port.ion serial en On line Help (ayuda en línea).
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Entendiendo el servicio  de comunicaciones 
El servicio serial de comunicación de LookoutDirect asigna usos del puerto serial entre objetos
drivers. A la frecuencia del objeto Poll Rate (tasa de interrogación), un objeto driver notifica al
servicio de comunicaciones que necesita utilizar un puerto serial específico para interrogar un
aparato. Si el puerto serial solicitado no está en uso, LookoutDirect asigna el puerto serial al
objeto driver. Cuando el objeto driver toma control del puerto serial, define los parámetros de
comunicaciones del puerto tales como velocidad y protocolo e interroga  el aparato. Cuando la
interrogación es completada, el objeto driver libera el puerto de modo que el servicio de
comunicaciones sea asignado a otros objetos driver.

Usted puede configurar únivocamente cada puerto serial para hardwired, radio, o
comunicaciones por modem teléfonico a través del cuadro de diálogo de configuraciones del
puerto serial.

Nota  usted debe definir configuraciones de comunicación del puerto serial en ambos productos de
LookoutDirect  de desarrollo y runtime y de runtime solamente.

Definiendo Conexiones del puerto serial 
Esta sección le muestra los pasos necesarios para configurar el puerto serial para las
comunicaciones con conexiones físicas con cables, con radio, y  con modem telefónico.

1. De la barra de menú de LookoutDirect, seleccione Options Serial Ports...(opciones de
puertos seriales)

Aparece el cuadro de diálogo de configuraciones del puerto serial (Serial Port Settings).
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2. En el campo de datos del puerto serial, seleccione el puerto de comunicación que usted está
definiendo. En este ejemplo estamos utilizando COM 1.

3. Defina los parámetros del puerto serial para el puerto de comunicación apropiado.

4. Haga clic en Accept para salvar en el disco los cambios de parámetros para el puerto serial. 

5. Haga clic en Quit para salir del cuadro de diálogo.

Seleccionando el puerto serial 
El campo de datos del puerto serial es un menú. Utilícelo para seleccionar el puerto de
comunicación que usted está definiendo. Windows permite usar hasta nueve puertos seriales; sin
embargo, la mayoría de las computadoras tienen solamente uno o dos puertos seriales sin
hardware adicional. Si se usan tarjetas de puertos seriales, pueden haber más. 

Configurando el Receive Gap (Gap de recepción) 
La configuración del Receive Gap está disponible para todos los tipos de conexión seriales. Este
número especifica el número de bytes vacíos (o de la cantidad de tiempo) que un driver recibe
de un controlador antes de que el driver reconozca el fin de un mensaje y pida otro mensaje.
Usted debe dejar normalmente ésto en el valor por defecto de configuración de 20. Sin embargo,
si usted está recibiendo errores en la comunicación, puede tratar de aumentar este número para
permitir un plazo de tiempo muerto antes de que LookoutDirect decida que ha recibido un
mensaje completo. Por ejemplo, con una velocidad lenta de 1200 Baud, usted puede ser que
tenga que aumentar Receive Gap a aproximadamente 30.

Las conexiones seriales con cables
Las conexiones seriales con cables (hardwired) no requieren ningún handshake de hardware para
control de línea.  Use esta configuración para todos los tipos seriales de comunicación excepto
el modem telefónico y transmisores-receptores de radio remotos. Usted debe también utilizar
este configuración al conectar directamente con un repetidor principal en un sistema de radio
o a través de un módem leased-line. Ya que un repetidor principal es un aparato full duplex que
no requiere codificar y decodificar la frecuencia, actúa como una red físicamente hardwired.
Otros tipos de conexión hardwired incluyen RS-232, RS-422, RS-485, y líneas telefónicas
arrendadas.

Configuraciones de Handshake con RTS/CTS
RTS/CTS es un mecanismo local de handshake de hardware entre la computadora local y el
aparato local de comunicación. Use  la conexión serial de radio (RTS/CTS) al conectar el puerto
serial con un aparato que requiera handshake de hardware de RTS/CTS, tal como un
transmisor-receptor de radio que debe ser codificado durante la transmisión de datos y
decodificado durante la recepción de datos. Otros medios de comunicación half-duplex tales
como RS-485 pueden requerir handshake de hardware RTS/CTS.
Cuando usted selecciona handshake de hardware RTS/CTS, LookoutDirect controla el RTS, o
la clavija de Request to Send, y supervisa el CTS, la clavija de Clear to Send, durante la
transmisión de datos (clavijas 4 y 5 en conectores RS-232 de 25 clavijas). Por lo tanto, usted
debe tener por lo menos la clavija de RTS (la clavija 4) conectada por cable  a través del cable
RS-232. La clavija CTS (la clavija 5) es opcional.
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LookoutDirect inicia una transmisión serial en un puerto con RTS/CTS en el primer RTS
afirmativo para enganchar la  radio. Entonces comienza a supervisar el estado de la clavija CTS.
Cuando el radiotransmisor se afina y queda completamente listo para transmitir, la radio
reconoce CTS y comienza inmediatamente la transmisión de datos.  Si la radio no reconoce
CTS dentro de la configuración de timeout CTS (por defecto es 100 ms), LookoutDirect asume
que la radio está lista para transmitir y transmite de todos modos. 
La configuración del timeut de CTS es la cantidad de tiempo máxima que LookoutDirect espera
después de que RTS se hace verdadero y CTS lo reconoce, antes de transmitir. La mayoría de
las radios toman típicamente entre 10 y 80 milisegundos para enganchar. Consulte las
especificaciones de su radio y configuración de los DIP switches para determinar el atraso de
enganche en su radio.

Si su radio puede reconocer CTS cuando esté listo para transmitir, agregue cerca de 50
milisegundos a la especificación del timeout para enganche de la radio y utilice este valor total
para el timeout de CTS. Si su radio no reconoce CTS, usted debe comenzar agregando cerca de
20 milisegundos a su tiempo de enganche de radio. Entonces aumente este valor en incrementos
de 10 milisegundos hasta que la radio remota comience a recibir correctamente los primeros
bytes del mensaje.

Algunas radios pueden reconocer CTS antes de que estén realmente listas para transmitir. En
este caso, desconecte la línea de CTS (clavija 5 en conectores RS232 de 25 clavijas) y configure
el timeout de CTS a un valor alto suficiente para que la radio se enganche completamente antes
de la transmisión.

Después de que transmita el último byte de datos, LookoutDirect continúa manteniendo ON
RTS, manteniendo la radio afinada hasta que el período de atraso del RTS expire. Usted  debe
configurar este valor por defecto a cero milisegundos de modo que LookoutDirect desenganche
la radio cuanto antes para prepararse para recibir la respuesta.

Cuando están desenganchadas, la mayoría de las radios generan una cola de desconexión audible
de tal modo que el aparato alejado podría interpretar como bytes inesperados que no significan
nada. 

Algunos aparatos remotos rechazan el mensaje entero en vez de descifrar los datos válidos y de
no hacer caso de los bytes adicionales de ruido. Este caso, mantenga la radio enganchada por
varios milisegundos usando el valor de configuración de atraso de RTS. Este período retrasa la
cola de desconexión por un tiempo suficiente para que el aparato alejado reconozca el último
paquete de datos como válido antes de recibir los bytes de ruido causados por la cola de
desconexi162n de la radio.

Si usted configura el atraso de RTS  demasiado alto, el aparato remoto comienza a transmitir su
respuesta antes de que un-se afine la radio local, causando una alarma de  comunicación en
LookoutDirect.



Configuraciones del Módem de Dial-Up 
Use una conexión serial telefónica con discado cuando usted usa un módem conjuntamente con una
línea telefónica normal (línea no arrendada). Usted puede modificar las configuraciones para
requisitos particulares de discado manual para su módem particular y línea telefónica.

Las configuraciones prefijadas por defecto de discado se basan en el sistema de comando AT de Hayes
Corporation, que es un estándar industrial para los módems de datos. La tabla siguiente explica los
configuraciones por defecto de LookoutDirect. Para comandos adicionales, vea  a su manual de
operación del módem.

Tabla B-1 Configuraciones del Módem de Dial-Up por defecto 

Cuando usted utiliza un módem de discado manual externo con LookoutDirect, la línea DTR
en su cable entre el módem y la computadora se debe conectar con cable derecho. Esta línea es
la clavija 20 en conectores RS-232 de 25 clavijas y la clavija 4 en conectores de 9 clavijas.
LookoutDirect utiliza la línea  DTR para ordenar al módem que desconecte (cuelgue) y vuelva
al modo de comando.

Algunos módems de fábrica no se configuran para responder a la línea DTR. Después de que
LookoutDirect marque con éxito a un módem remoto y acabe el ciclo de interrogación, cae la línea
de DTR pero el módem sigue conectado. Si el módem no responde después de varios segundos de
tratar de levantar y caer la línea DTR, LookoutDirect genera una alarma que indica que no está
respondiendo el módem. Si usted recibe este mensaje de alarma, su módem no está configurado para
supervisar la línea DTR.

El comando estándar de Hayes Corporation para configurar el módem para colgar y para entrar en
modo de comando sobre la pérdida de DTR es &D2. que usted puede utilizar un programa de
simulación de terminal para hacer esta configuración permanente en la mayoría de los módems
entrando el comando del módem AT&D2&W para almacenar la configuración permanentemente
en memoria permanente del módem. O usted puede solamente agregar &D2 en el prefijo de discado.
El prefijo de discado por defecto es ATX4MVEDT, así que usted puede ser que lo cambie a
AT&D2X4MVEDT.

Retries (tentativas) especifica el número de veces que LookoutDirect disca el número de teléfono
especificado y trata de conectarse con el módem en el otro extremo de la línea. Si no puede conectar
después de las tentativas especificadas, genera una alarma y se va al número de teléfono siguiente en
la lista de interrogación (si se ha formado una lista).
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AT Código de atención que debe preceder todos los comandos

D Número de teléfono con estos modificadores: P para pulsos; T para tono 

En Modo de echo local: E para falta de echo.

Mn Altoparlante ON u OFF: M cuando el  parlante está siempre OFF

Vn Códigos de resultado verbales o numéricos: V para códigos de resultado numéricos

Xn Codigo de resultado y opciones de discado: X4 espera por el tono de discado antes
de discar y reconoce la señal de ocupado (busy)



Wait (espera) de la conexión especifica la longitud de tiempo que LookoutDirect espera para recibir
una señal de respuesta del módem que está llamando. El período comienza cuando LookoutDirect
envía el comando del prefijo de discado primeramente a través  al módem local. El tiempo debe ser
suficientemente largo para que el módem local reciba señal para discar, marque el número de
teléfono, permita que el módem remoto tome la línea, y envíe de vuelta un mensaje de conexión. Si
el tiempo especificado es demasiado corto, el sistema podría funcionar correctamente pero nunca
hacer una conexión.

Pause (pausa) entre las llamadas es la longitud del tiempo de espera después de descolgar antes de
que envíe el módem local la señal siguiente del prefijo de discado. Si el tiempo especificado es
demasiado breve, su sistema puede no descolgar la llamada existente y tratar de llamar el número
siguiente.

Nota:  los módems específicos, las radios y líneas telefónicas locales pueden funcionar más rápido o más lento
que las configuraciones por defecto. Usted puede necesitar usar varios ensayos para encontrar las mejores
configuraciones para su sistema.

Miembros de datos de DirectLogic 
Los protocolo de objetos driver contienen muchos datos. Todas las memorias V , entradas, salidas,
relevadores internos de control se incluyen dentro de este objeto. Por lo tanto, tan luego que crea un
objeto de DirectLogic usted tiene acceso inmediato al conjunto entero de los miembros de datos del
objeto. Como con todos los driveres de LookoutDirect, usted puede tener acceso a puntos de E/S y
a otros datos a través de miembros de datos. Las tablas siguientes contienen los miembros de datos
que trabajan actualmente con la clase de objetos DirectLogic.

Modificadores de datos
Para tener conversiones de datos de DSData Server cuando mueve datos para dentro y fuera del
PLC, el modificador de datos presentado en la siguiente tabla se puede agregar al extremo de un
artículo de datos.

Tabla B-2

Nota:    El rango de miembros de datos mostrados en las tablas siguientes puede estar más allá de la capacidad
del PLC específico DirectLogic o de la CPU compatible que usted está utilizando O puede no incluir a algunos de
los miembros de datos mostrados. Consulte el manual de usuario apropiado de la familia del PLC para los tipos
y rangos específicos de memoria disponibles para su CPU del PLC.
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Modificador Descripción Reconocido por qué PLCs DirectLogic 

Ningún modificador Valor decimal (16 bits) Todos 
:D Valor decimal (32 bits) Todos
:B Convertido a BCD (16 bits) Todos
:DB Convertido a BCD (32 bits) Todos
:nn Lea un bit específico en una palabra

(no disponible para escribir  bits) 
Todos

:R Convertido a real (32 bits) DL06, DL250, DL350, y DL450 
:W Palabra (16 bits) DL330, DL330P, DL340, y DL305 

:WB Palabra (16 bits), convertidos a BCD DL330, DL330P, DL340, y DL305 



Miembros de datos de los PLCs DirectLogic 05/06/105/205/350/405

Tabla B-3. Miembros de Datos  de PLCs  DirectLogic 05/06/105/205/350/405 
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Miembro de datos Tipo Lee Escribe Descripción

Activado Lógico Sí No Señal generada por un Objeto; cuando es TRUE (VERDADERO), el
estado ON significa una conexión de comunicación active5 entre el
archivo de proceso y el PLC.

C0 - C3777 Lógico Sí Relevador de control  - direccionado como octal y relacionado a
V40600 - V40777.

CT0 - CT377 Lógico Sí Bits de estado de un contador (Done bit) - direccionado como octal y
relacionado a V41140 - V41157. 

CTA0:B - CTA377:B Numérico Sí Sí Palabras del valor corriente del contador en BCD - direccionado
como octal y relacionado a V01000 - V01377. 

CTA0:DB - CTA376:DB Numérico Sí Sí Palabras del valor corriente del contador doble (dos direcciones
adyacentes) en BCD de 32 Bits - direccionado como octal y
relacionado a V01000 - V01377. V01000 - V01377 

Falla Lógico Sí No Señal generada por un Objeto; cuando es TRUE (VERDADERO), el
estado ON significa que  el archivo de proceso no se  comunica más
con el PLC.

GX0 - GX3777 Lógico Sí Si Entradas Remote I/O  - direccionado como octal y relacionado a
V40000 - V40177 

GY0- GY3777 Lógico Sí Si Salidas Remote I/O  - direccionado como octal y relacionado a
V40200 - V40277 

Pause Lógico Sí No Señal generada por un Objeto; cuando es TRUE (VERDADERO), el
estado ON significa que  se ha detenido brevemente la conexión de
comunicación pero sigue siendo activa e irá a FALSA cuando su
condición de pausa ya está satisfecha. Causado generalmente por
modificar el conexión mientras que está en uso.

S0 - S1777 Lógico Sí Sí Bits de estado de etapas - Dirección en formato octal y relacionados
a V41000 hasta V41077

SP0 - SP777 Lógico Sí No Relevadores especiales (bits de estado de sisterma) - Dirección en
formato octal y relacionados a V41200 hasta V41237 

T0 - T0377 Lógico Sí Sí Bits de estado de temporizadores ( Done bit) - Dirección en formato
octal y relacionados a V41100 hasta V41117 

TA0:B - TA377:B Numérico Sí Sí Valor corriente de temporizadores en formato de palabra simple BCD
- Dirección en formato octal y relacionados a V00000 hasta V00377 

TA0:DB - TA376:DB Numérico Sí Sí Valor corriente de temporizadores en formato de palabra doble BCD -
Dirección en formato octal y relacionados a V00000 hasta V00377 

V0 - V41237 Numérico Sí Sí Registros de memoria de 16 bits en formato decimal

V0:B - V41237:B Numérico Sí Sí Registros de memoria de 32 bits en formato decimal 0-9999

V0:DB - V41236:DB Numérico Sí Sí Memoria V de 32 Bits Doble (dos registros adyacentes;) BCD 0  -
99999999 



Tabla B-3. Miembros de Datos  de PLCs  DirectLogic 05/06/105/205/350/405
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Miembro de datos Tipo Lee Escribe Descripción

V0:R - V41236:R Numérico Sí No Registros de memoria doble reales ( Punto flotante IEEE de 32 Bits)

V0:S - V41237:S Numérico Sí Sí Registros de memoria simple de 16 bits con formato decimal con
signo en el rango de -32768 hasta 32767

VC0 - VC3760 Numérico Sí Registros de memoria simple de 16 bits con formato decimal aliases
de los relevadores de control C0 hasta C3777 

VC0:B - VC3760:B Numérico Sí Sí Registros de memoria simple de 16 bits con formato BCD aliases de
los relevadores de control C0 hasta C3777 

VCT0 - VCT360 Numérico Sí Sí Registros de memoria simple de 16 bits con formato decimal aliases
de los bis de estado de contadores CT0 hasta CT377 

VCT0:B - VCT360:B Numérico Sí No Registros de memoria simple de 16 bits con formato BCD aliases de
los bis de estado de contadores CT0 hasta CT377 .

VGX0 - VGX3760 Numérico Sí Si Registros de memoria simple de 16 bits con formato decimal aliases
de entradas Remote I/O -  GX0 hasta GX3777

VGX0:B - VGX3760:B Numérico   Sí Si Registros de memoria simple de 16 bits con formato BCD aliases de
entradas Remote I/O- GX0 hasta GX3777 

VGY0 - VGY3760 Numérico Sí No Registros de memoria simple de 16 bits con formato decimal aliases
de salidas Remote I/O   GY0 hasta GY3777

VGY0:B - VGY3760:B Numérico Sí Sí Registros de memoria simple de 16 bits con formato BCD aliases de
salidas Remote I/O   GY0 hasta GY3777

VS0 - VS1760 Numérico Sí Sí Registros de memoria simple de 16 bits con formato decimal aliases
de los bits de estado de etapas S0 hasta S1777 

VS0:B - VS1760:B Numérico Sí Sí Registros de memoria simple de 16 bits con formato BCD aliases de
los bits de estado de etapas S0 hasta S1777 

VSP0 - VSP760 Numérico Sí Sí Registros de memoria simple de 16 bits con formato decimal aliases
de los relevadores especiales SP0 hasta SP777 

VSP0:B - VSP760:B Numérico Sí Sí Registros de memoria simple de 16 bits con formato BCD aliases de
los relevadores especiales SP0 hasta SP777 

VT0 - VT360 Numérico Sí Sí Registros de memoria simple de 16 bits con formato decimal aliases
de los bits de estado de temporizadores T0 hasta T377 

VCT0:B - VCT360:B Numérico Sí Sí Registros de memoria simple de 16 bits con formato BCD aliases de
los bits de estado de temporizadores T0 hasta T377 

VX0 - VX1760 Numérico Sí Sí Registros de memoria simple de 16 bits con formato decimal aliases
de entradas -  X0 hasta X1777

VX0:B - VX1760:B Numérico Sí Sí Registros de memoria simple de 16 bits con formato BCD aliases de
entradas -  X0 hasta X1777

VY0 - VY1760 Numérico Sí Sí Registros de memoria simple de 16 bits con formato decimal aliases
de salidas-  Y0 hasta Y1777

VY0:B - VY1760:B Numérico Sí Sí Registros de memoria simple de 16 bits con formato BCD aliases de
salidas-  Y0 hasta Y1777

X0-X1777 Lógico Sí Si Entradas - Dirección en octal y relacionados a V40400 hasta V40477
Y0-Y1777 Lógico Sí Si Salidas - Dirección en octal y relacionados a V40500 hasta V40577



Miembros de datos de la familia del PLC 305/305S .
Tabla B-4.  Miembros de datos de PLCs 305/305S 

Ud encontrará tablas para este  PLC  en la version en Inglés.  No es recomendado para nuevas
aplicaciones. 
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Miembros de datos de la familia del PLC 305/305S .
Tabla B-4.  Miembros de datos de PLCs 305/305S 

Ud encontrará tablas para este  PLC  en la version en Inglés.  No es recomendado para nuevas
aplicaciones. 
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Estableciendo conexiones a PLCs DirectLogic 
LookoutDirect utilizará "links" para construir y para almacenar fácilmente las configuraciones
de comunicación para conectar un PLC DirectLogic.  Links son archivos de parámetros de
comunicación  que reciben un nombre particular para conjunto de parámetros. Esto también
reduce el trabajo de tratar configuraciones de comunicación. 

Hay tres tipos diferentes de conexiones que usted puede crear.
Una conexión serial estándar que utiliza COM1 hasta COM4 directamente al puerto del PLC 

Una conexión serial que se conectará con un par de módems con uno de los puertos del PLC 

Una conexión que se conectará a través de una tarjeta de red con un módulo Hx-ECOM. 

La mayoría de puentes de comunicaciones puede ser establecida rápidamente usando el
LinkWizard de DirectSOFT32. El LinkWizard busca automáticamente a puentes de
comunicaciones establecidos.

Nota  si usted tiene una red de PLCs, usted debe construir un puente de comunicaciones para cada PLC. Por
ejemplo, es posible que todos los PLCs en una red tengan las mismos configuraciones de comunicaciones
(protocolo, velocidad, etc.). Sin embargo, cada uno debe tener una dirección de estación única, por lo tanto
usted debe construir una conexión separada para cada PLC.

Estableciendo  un puente de comunicaciones usando el LinkWizard 

1. Seleccione Object>Create Drivers, escoja DirectLogic como la clase de objetos, y después
haga clic en OK.

Aparece el cuadro de diálogo Create DirectLogic sin Comm Connection seleccionado.

2. Haga clic en  el botón de conexión (…). 

Aparece el diálogo Select Link. Los puentes de comunicaciones existentes que son conexiones
encontradas por  el LinkWizard (mago de conexión)  se muestran en la lista de Links.

Nota: Si no aparece ninguna conexión en la lista de Links, vea  el mago de conexión para agregar
un puente de comunicaciones serial en la próxima página.

3. Haga clic doble en la conexión deseada.

Aparece el nombre de conexiones en el cuadro de diálogo Create DirectLogic en la caja de
texto del Comm Link.

4. Haga clic en OK para establecer la conexión
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Usando al mago de conexión para agregar  un puente de comunicaciones serial
El ejemplo siguiente muestra cómo escribir un programa para realizar la conversión a una
unidad de ingeniería desde una entrada en el rango de 0 - 4095. Este ejemplo asume que usted
tiene datos BCD cargados en las dirección V2000 en formato BCD.

El mago le dará instrucciones a través de la creación de un puente de comunicaciones entre
LookoutDirect y el PLC.

1. En el diálogo Select Link, haga clic en Add.

Se abre el mago de conexion(Link Wizard).

2. Seleccione el puerto de comunicaciones correcto, y después haga clic en Next.
3. Seleccione la familia del PLC. Haga clic en Not sure (no estoy seguro) si usted no sabe qué

familia pertenece su PLC. Haga clic en Next después de hacer la selección de la familia del
PLC.

Si usted está utilizando un PLC compatible de AutomationDirect, el mago de conexión tratará
de detectar a la familia automáticamente.

4. Seleccione el protocolo correcto. El protocolo correcto estará destacado ya si una familia del
PLC fue seleccionada en el paso anterior. Haga clic en Next después de hacer la selección del
protocolo.
LookoutDirect tratará de establecer comunicaciones con el PLC usando la dirección del nodo
y del protocolo que usted seleccionó. La primera tentativa en comunicarse con el PLC será
hecha usando 9600 Bauds y paridad impar. Si la primera tentativa fracasa, será hecha una
segunda tentativa usando una secuencia automática de búsqueda. Si ambas tentativas en
establecer la comunicación con el PLC fracasan, utilice el Link Editor para ajustar
manualmente la configuración del puerto hasta que se establecen las comunicaciones.

Nota: El criterio de como escojer el protocolo es determinado por dos factores:
•    Si el PLC apoya el protocolo en el puerto donde usted está conectándose. Vea al manual de usuario

del PLC que esté usando para una lista de protocolos disponibles para los puertos en los PLCs y
CPUs compatible. Las opciones son K-sequence o DirectNET.

•    Si usted necesita realizar operaciones de escritura a puntos discretos individuales de E/S o relevadores
de control. En este caso usted debe seleccionar el protocolo K-sequence. El protocolo DirectNET no
puede escribir a localizaciones de bit individuales.

5. Entre un nombre único para la conexión que no sea más de 16 caracteres en longitud y una
descripción con no más de 32 caracteres en longitud, y después haga clic en Finish.
Aparece el nombre de la nueva conexión en la lista de Links del cuadro de diálogo Select
Link.

6. Haga clic en Select.

El nombre abreviado para el puente de comunicaciones que usted seleccionó aparece en la
caja de texto de Comm Link en el cuadro de diálogo de Create DirectLogic.

Nota: La frecuencia de interrogación y las cajas de texto de Poll = se utilizan para los puentes de
comunicaciones de Modem/RF o para compensar redes ruidosas. Bajo circunstancias normales, no es
necesario completar estas cajas de texto. Vea  a la ayuda en línea para más información.
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Usando al mago de conexión para agregar una conexión de Ethernet 

Lo que sigue le muestra el procedimiento para configurar un puente de comunicaciones entre
una tarjeta de interface estándar de red y un módulo de comunicaciones de Ethernet.

Nota  Vea la ayuda en línea de Windows para información sobre configuración de la red y la instalación de
protocolos de red.

1. En el diálogo Select Link, haga clic en Add. Se abre el mago de conexión. 
2. Seleccione Ethernet, y después haga clic en Next.

3. Seleccione el transporte y protocolo correcto, y después haga clic en Next.

LookoutDirect busca en la red por los módulos de Ethernet.

Nota: la restricción siguiente se aplica a la capa de transporte:
•   Si el sistema operativo es Windows NT 4.0, la única opción del transporte disponible para  usted es    

Winsock. Windows 95/98 permite que usted elija ya sea  interrupción de IPX o Winsock.
•   Si usted selecciona UDP/IP como el protocolo de transporte, usted debe cambiar el IP ADDRESS  del

módulo de su valor prefijado de 255.255.255.255  antes de que usted pueda conectarse con él.

4. Seleccione el aparato y el modo de dirección.  Si usted seleccionó el protocolo UDP/IP en el
paso anterior, entre correctamente el IP ADDRESS de la tarjeta de red. Vea realizar cambios
al modo del aparato y de dirección debajo para más  información.

5. Haga clic en Next.

LookoutDirect trata de comunicarse con el módulo de Ethernet.

6. Entre un nombre único para la conexión que no sea más de 16 caracteres en longitud y una
descripción que no sea más de 32 caracteres en longitud, y después haga clic en Finish.

El nombre de la nueva conexión aparece en la lista de Links del cuadro de diálogo Select
Link.

7. Haga clic en Select.
El nombre abreviado para el puente de comunicaciones que usted seleccionó aparece en la
caja de texto Comm. Link en el cuadro de diálogo de Create DirectLogic.
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Realizando cambios al aparato  y al modo de dirección  

Grupo de lista de Módulos
Cada módulo de Ethernet es asignado con una dirección única de 12 dígitos en la fábrica,
llamada la dirección de Ethernet. Una etiqueta localizada en la parte posterior del módulo del
PC o en el lado del módulo mismo, tendrá la dirección de Ethernet impresa en ella. La lista del
módulo exhibirá cualquier módulo de Ethernet que encuentre en la red, clasificada por su
dirección de Ethernet. Si usted selecciona cualquier aparato en la lista del módulo, la
configuración actual para ese aparato se muestra en los campos en la sección del modo de la
dirección.

•    El botón Query ejecuta una pre-exploración de la red para los módulos de Ethernet usando el
mismo transporte y protocolo de transporte especificados en el diálogo anterior.

•   El botón SETUP… muestra un cuadro de diálogo que permite que usted asigne un nombre, una
descripción y un IP ADDRESS al módulo seleccionado.

•   El botón Link Editor muestra un cuadro de diálogo que le deja configurar manualmente los
parámetros de conexion para un módulo específico de Ethernet.

Grupo del modo de dirección
Cada módulo de Ethernet debe tener cierta manera única de identificarse en una red. La
dirección de Ethernet, que se asigna en la fábrica, es casi siempre única, pero no es siempre el
identificador más conveniente para recordar.

Hay afortunadamente tres identificadores, configurables por el usuario, disponibles: la
identificación del módulo, el Name (nombre), y el IP ADDRESS (la dirección de Ethernet no
es configurable por el usuario). La selección del modo de dirección determina cuál de estos
indentificadores utilizará LookoutDirect para localizar los módulos de Ethernet en la red. Lo
más importante a recordar es que cualquier identificador que usted elija para el modo de
dirección, debe ser único en la red.
Si usted desea cambiar la configuración del módulo, haga clic en  el botón de Setup y haga
cualquier configuración necesaria para la red.

El botón Setup
Al seleccionar un módulo en la sección de los aparatos, se mostrará la configuración actual para
ese módulo en la sección de configuración. Antes de usted cambie cualesquiera de los valores,
vea cada una de las opciones más detalladamente.

•   La identificación del módulo (Module ID) es un identificador numérico único dado a cada
módulo en la red. Este número puede ser la configuración del dipswitch del módulo,  o una
dirección configurada del usuario (si los dipswitches son configurados como 0). Vea al
manual de usuario del módulo de Ethernet, número de artículo HX-ECOM-M,  para más
información sobre como asignar una dirección.

•   El campo Name puede contener una secuencia alfanumérica de 32 caracteres. El valor
asignado en la fábrica es "Name". Si usted pretende utilizar el campo Name como el
método de identificación, usted debe cambiar el valor prefijado "Name"  a uno mas
distintivo para hacerlo único en la red.



El campo de descripción puede contener una secuencia alfanumérica de 32 caracteres 
•   El campo del IP ADDRESS debe contener un IP ADDRESS válido que sea único en su

red.Usted debe tener cuidado de no duplicar direcciones del IP en una red (usted no podrá
terminar la configuración del conexion si el IP ADDRESS no es único).
Su administrador de la red debe poder decirle qué direcciones están disponibles para
utilizar. Si usted se prepone utilizar IP ADDRESS, usted debe cambiar el valor de su valor
prefijado.

Nota  usted debe tener cuidado de no duplicar la información en estos campos usuario-configurables en
cualquier módulo en la red.Usted no podrá terminar el proceso de la creación del conexion si usted elige un
identificador que se ha duplicado en otro módulo.

Si usted entra los nuevos valores para un campo, haga clic en el botón Update Module
(actualización del módulo) para escribir estos nuevos valores al EEPROM en el módulo
de Ethernet. 

El botón Query Network ( pregunte a la red) iniciará una pre-exploración de la red usando
el transporte y el protocolo del transporte especificados previamente.
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Glosario 

Ack 
Reconocimiento de una alarma o un evento.

Active notification
Una característica de los sistemas de software activados por eventos en los cuales la  aplicación es avisada
de un cambio de valor cuando ocurre en vez de verificación continua, en PLCs por ejemplo.

Address space
Un término de OPC para el área que usted navega para encontrar qué artículos están disponibles en  un
servidor OPC. Esto es parte de la interface estándar OPC y este espacio puede ordenar artículos
jerárquicamente.

Alarmas 
Notificación de software de una condición en un proceso. Esta alarma puede llamar la atención de un
valor que se ha excedido o ha caído debajo de ciertos niveles, en la base de datos del objeto o en un
objeto de alarma.

Alias
Nombre dado a un miembro de datos usando el cuadro de diálogo Edit Database (modificación la base
de datos). Este nombre puede ser descriptivo o mnemónico, y se puede asociar a otras configuraciones
de miembro de datos tales como escala, registro, y alarmas.Un miembro de datos puede tener más de
un alias, cada uno con diversas configuraciones asociadas.

CBL compiler
LookoutDirect utiliza el compilador CBL (control block language) para compilar un archivo de fuente
de LookoutDirect (lks)  en un archivo binario  (l4p).

.cbx 
Un archivo de LookoutDirect que contiene una clase de objetos de LookoutDirect . Un archivo  cbx
(extensión del bloque de control) puede tener unas o más clases de objetos en él.

Base de datos
Recolección de datos almacenados para recuperación, para mostrar, o para análisis mas tarde.

Baud rate 
Medida de la velocidad de transmisión de datos, definida formalmente como el número de cambios de
estado electrónicos por segundo. Ya que la mayoría de los módems transmiten  cuatro bits de datos por
cambio del estado, se emplea mal  a veces o es mal entendido - un módem de 300 Baud está moviendo
1200 bits por segundo.  Vea BPS.

.7bmp
Archivos gráficos en formato bitmap.Si usted está utilizando  un archivo  del bmp en LookoutDirect , usted
no puede volverlo a clasificar según el tamaño en la pantalla.  Vea el metafile de Windows.
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BPS
bits por segundo-medida de tasa de transferencia de datos.

Checksum
Un método de verificar que el número de bits recibidos sea igual que el número de bits
transmitidos.Utilizado por TCP/IP y protocolos seriales.

Citadel
Base de datos histórica de LookoutDirect que almacena datos para acceso más tarde.

clases 

Vea las clases de objetos.

Cliente
Un proceso de LookoutDirect que supervisa un proceso del servidor de LookoutDirect. Los clientes de
LookoutDirect deben ser independientes de la computadora de modo que puedan funcionar desde
cualquier computadora en la red. Los procesos de servidor de LookoutDirect funcionan en computadoras
conectadas realmente con el hardware del control.

Comm port
término usado a veces para un puerto serial.

Conexión
Entrada a los miembros escribibles de los datos de un objeto de LookoutDirect .Para más información, Vea
al capítulo 4, usando LookoutDirect.

Objetos de control
Objetos de LookoutDirect que usted utiliza para controlar un proceso, cambiar un valor de datos, ajustar
un registro, etcétera.

Objetos controlables
Objetos de LookoutDirect que usted puede controlar con un objeto de control de LookoutDirect .

CTS (Clear to send). 
Parte de un protocolo de confirmación de ciertos aparatos que  conectan el puerto serial de una
computadora. Vea  la sección de configuraciones de handshake de RTS/CTS del capítulo 3,
Comunicaciones del puerto serial, en el Manual de Desarrollo de LookoutDirect para más información
detallada.

Cursor (data table)
La tabla de datos de LookoutDirect puede activar una fila de datos a la vez usando el cursor de la tabla de
datos.Vea la referencia de tabla de datos en la ayuda en línea de LookoutDirect o el Manual de Referencia
de objetos de LookoutDirect .

CVS
Archivo de valor separado por coma, un formato aceptado extensamente por hojas de cálculo y  otros
programas de tratamiento de datos.
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DAQ
Abreviatura para los adquisición de datos.

Dat member (Miembro de datos) 
Fuente o receptor de datos asociado a un objeto de LookoutDirect. Un miembro legible de datos, o fuente,
puede ser utilizado en expresiones o como entradas a otros objetos. Un miembro escribible de datos, o
receptor, puede tener como máximo una conexión, creado usando el cuadro de diálogo de  conexiones de
Object>Edit Connections. Un miembro de datos puede ser legible y escribible. Vea también a la definición
de miembro nativo de datos y alias.

Data type
Tipo de valor (numérico, lógico o texto) que un parámetro o miembro de datos puede contener.

Datagram
Mensaje enviado entre objetos en LookoutDirect. Un datagrama contiene una ruta y un valor.

DCOM/COM
Un estándar de Microsoft (Distributed Compoment Object Model) en el cual  objetos del programa del
cliente piden servicios del objetos del programa del servidor .

El modelo componente del objeto (COM) es un sistema de interfaces, de clientes, y de servidores usados
para comunicarse dentro de la misma computadora (Windows 98/95 o Windows NT).

DDE 
Intercambio de datos dinámico, usado corrientemente en LookoutDirect para intercambiar  datos por otros
programas (tales como Microsoft sobresalga) que funcionan en su  red.

Deadband (banda muerta)
Un valor que se debe exceder para  para sonar una alarma o un cambio en el estado que se registrará. Por
ejemplo, si usted tiene un alarma baja fijado en 5 con un deadband (banda muertas) de 2, la alarma no
accionará hasta que el valor que es supervisadas baje hasta 5. La alarma entonces permanecerá activa hasta
que el valor que es supervisado vaya sobre 7. Un deadband evita que oscilaciones pequeñas del valor
accionen una alarma y luego cancelarlo muy frecuentemente.

prefijo que marca de la desviación 

Deviation
Esto significa Desvío. Coloque un desvío para filtrar cambios pequeños en valor cuando se registran datos.
Antes de ser registrada a una base de datos, un valor debe cambiar por lo menos en la cantidad de desvío
desde el  valor anterior registrado.

Dialing prefix
Parte del Hayes EN el sistema de comando para el uso con los módems.Vea la sección de Configuración
del módem del dial-Up del capítulo 3, comunicaciones del puerto serial, en el Manual de Desarrollo de
LookoutDirect para más información detallada.
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Displayable objets (objetos mostrables) 
Una clase de objetos de LokoutDirect que tiene un componente mostrable, tal como un
potenciómetro , un interruptor, o un botón.

DLL
Una biblioteca de conexion dinámica, que es una colección de programas pequeños, especiales con el
propósito de que se puede llamar por un programa más grande que funciona en la computadora. A veces
llamada Biblioteca dinámicamente ligada.

Driver Objets (objetos drivers)
Objetos de LookoutDirect para  comunicarse con PLCs, RTUs, y otros aparatos de E/S.

Edit mode
Modo de LookoutDirect en el cual usted puede alterar y crear objetos dentro  de un proceso.  Vaya dentro
o salga del  modo Edit presionando las teclas < Ctrl-espacio > o seleccionando en el menú el modo
Edit>Edit Mode .

Engineering Units (Unidades de ingeniería)
En LookoutDirect, usado para referirse a datos convertidos o a escala. Los datos de termopar, por ejemplo,
llegan en miliVolt como la unidad cruda, y se deben convertir a grados, una unidad de ingeniería.

Environment services (servicios de ambiente)
Tareas de LookoutDirect que se realizan como una parte de hacer su trabajo de SCADA/HMI más fácil.
Los servicios de ambiente de LookoutDirect incluyen comunicaciones, base de datos y registro de datos,
seguridad , creación de una red, alarmas, etcétera.

Ethernet 
Una tecnología local extensamente usada, estandardizada del establecimiento de una red  del área,
especificada en el estándar de IEEE 802.3.

Event (evento)
Cualquier cosa que sucede puede ser un evento. En LookoutDirect los eventos incluyen cosas tales como
ajustar un valor de control, entrar o salir del modo Edit, abrir o cerrar un panel de control, y entrar o
registrarse en del sistema.

Expression functions 
Funciones matemáticas, lógicas, y otras usadas por las expresiones de LookoutDirect.

Expressions
Expresiones de LookoutDirect son a menudo trayectorias a un miembro de datos.Pueden también
funcionar como variables que, usando un tipo de fórmula de célula de hoja de cálculo,  llegan a ser capaces
de realizar operaciones matemáticas flexibles, en tiempo real,  prueba de condiciones y otras funciones  de
operaciones complejas.
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Vea el capítulo  1,  Expresiones,  en el Manual de Desarrollo  LookoutDirect para más información sobre
expresiones.

Failover
Un failover es la toma de posesión de un proceso por una computadora redundante cuando la
computadora primaria falla por cualquier razón.

Fecha absoluta
LookoutDirect usa un sistema numérico para no perder de vista la fecha y la hora, tal qué la medianoche
(0 horas), del 1o. de Enero de 1900 es representado por 1, el 2 de Enero de 1900 es representado por
2, etcétera. El el número de tiempo absoluto 36234.47222250 representa 11:20, del 15 de Marzo de
1999.

El valor numérico para 1 segundo en LookoutDirect es 0,000011574, el valor numérico para 1 minuto
es 0,000694444, y el valor numérico para 1 hora es 0,041666667.

FieldBus
Una red de comunicaciones digitales usada para conectar sistemas de procesos de instrumentación y de
control.

FieldPoint
Una línea de productos de hardware de National Instruments para la automatización, el control, la
supervisión, y la divulgación industriales.

Frame (marco)
Secuencia de bytes enviados de una computadora a un aparato o viceversa. La sintaxis del “frame”depende
del protocolo que es utilizado.Un frame leído contiene bastante información para especificar un sistema
de variables cuyos valores el aparato deben ser devolvidos.Un “write frame” especifica una variable en el
aparato y un nuevo valor a ser escrito en esa variable. Algunos protocolos permiten la escritura de variables
múltiples en un solo frame.Un response frame (de respuesta) vuelve del aparato a la computadora,
indicando si el frame recientemente enviado a él fue recibido con éxito. Si el frame recientemente recibido
era un write frame, el response frame contiene un o un conjunto de valores solicitados.

Funcionality ( Funicionalidad)
La manera que un objeto trabaja, que opera o realiza una tarea. La funcionalidad es un concepto general
que se aplica de la misma manera a todos los objetos en una clase dada  del objeto. Los parámetros definen
la funcionalidad específica de un objeto individual.

Funciones
Vea las funciones de expresión.
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Gray Proximilty (proximidad gris)
Un término usado en la animación de color de LookoutDirect. Esto define qué porcentaje del gris será
substituido por un color dado cunado cambian las condiciones en un valor o un sistema supervisado de
valores.

Handshake
El conjunto de confirmaciones en un sistema de comunicaciones, para asegurase que dos aparatos se están
comunicando continuamente.

Hardware
El conjunto de equipos físicos en un sistema de control, para diferenciarlos del software.

Hi e HiHi
Configuraciones de alarmas. Ambos advierten que un valor haya pasado por encima un cierto valor de
alarma. Una alarma Hi se utiliza generalmente para alertar a un operador de una necesidad de
intervención. Una alarma HiHi se utiliza generalmente para alertar a un operador que el valor ha sido
excedido por un margen incluso mayor que una alarma Hi indica y se utiliza generalmente para indicar una
necesidad  de  acción urgente.

Historical logging (registro histórico)
El proceso de almacenar datos en una base de datos para uso en otro momento o en otra localización.

HOA
Control Manual-OFF-Automatico, usado para configurar si un valor se debe cambiar manualmente, está
totalmente OFF, o funciona automáticamente. Usted puede utilizar un objeto potenciómetro y una
expresión compleja para crear esta clase de control en LookoutDirect, o usted puede utilizar un objeto de
RadioButton, dependiendo de los requisitos particulares de la tarea que usted necesita ejecutar.

I/O point (Punto de E/S)
Cada conexión write-only (sólo de escritura) o read-write (lectura y escritura) de LookoutDirect que se hace
al hardware externo se cuenta como un punto de E/S. LookoutDirect se licencia para  usar con una
cantidad de 500 puntos de E/S. Si usted excede la cantidad a utilizar con su copia de LookoutDirect,
aparece un mensaje de alerta  en la pantalla de computadora advirtiéndole para cerrar uno de sus procesos
dentro de un tiempo especificado antes de que LookoutDirect corte el uso de E/S.

(Implicit) data member (miembro (implícito) de datos) 
Un miembro de datos de LookoutDirect que contiene datos fundamentales para cierto clase de objetos.
Cuando usted hace una conexión a un miembro (implícito) de datos, usted utiliza solamente el nombre
del objeto, no el nombre del objeto seguido por el nombre del miembro de datos.
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l4p  (archivo de proceso)
Extensión de archivo de los archivos de proceso de LookoutDirect. Éstos son los archivos compilados de
LookoutDirect que funcionan cuando un proceso está operando.

l4t   (archivo de estado)
Extensión de archivo de un archivo de estado de LookoutDirect, que almacena valores para los controles
de LookoutDirect y otros objetos con la información del estado de cada objeto.

lka   (archivo de seguridad)
Extensión de archivo de los archivos de seguridad de LookoutDirect.

lkp   (archivo de proceso para versiones anteriores a version 4)
Extensión de archivo de los archivos de proceso de LookoutDirect en versiones de LookoutDirect anterior
que LookoutDirect 4.

lks   (archivo fuente)
Extensión de archivo de un archivo fuente de LookoutDirect, que LookoutDirect compila para hacer que
un archivo de proceso funcione. Éste es el archivo que usted debe asegurarse de que lo tien con un respaldo
(o backup) en caso de que usted necesite reconstruir un archivo de proceso corrupto, o en caso de que una
cierta versión futura de LookoutDirect no pueda hacer funcionar un archivo de proceso compilado en una
versión anterior de LookoutDirect.

Logging (registro)
El proceso de almacenar datos en un archivo de base de datos de la computadora.
Vea el capítulo 7, Datos de registro y eventos, en el Manual de Desarrollo de LookoutDirect para más
información sobre datos de registración.

Logical data member (miembro  de datos lógico)
Un miembro de datos de LookoutDirect del tipo de datos lógico.

lst  (archivo de estado de versiones anteriores a versión 4))
Extensión para el archivo del estado de LookoutDirect en versiones de LookoutDirect anterior que
LookoutDirect 4.

Multiplex (multiplexación)
Un método de trabajo con más de una secuencia de datos usando solamente un canal de comunicaciones.
Hay una gran cantidad de métodos diferentes de multiplexación, dependiendo del hardware y software que
son utilizados. Varios objetos driver de LookoutDirect permiten usan hardware de multiplexación.
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Native data member (miembro nativo de datos)
Miembros de datos construidos en una clase de objetos de LookoutDirect , en comparación con miembros
de datos que usted crea usando alias.

NetDDE
Una manera de creación de una red usando DDE (intercambio de datos dinámico), conservada en
LookoutDirect versión 4 y más adelante para compatibilidad con versiones anteriores de LookoutDirect.

Numeric data member (miembro  de datos numérico)
Un miembro de datos de LookoutDirect del tipo de datos numérico.

Object (objeto)
Un caso específico creado de una clase de objetos.

Object class ( clase de objetos)
Módulos de software que usted usa para crear objetos individuales para realizar tareas en LookoutDirect.

Object connections (conexiones de objetos)
Conexiones en software entre objetos usadas para transmitir datos y comandos a partir de un objeto a otro.

ODBC
Open Database Connectivity , una interface de programación de uso estándar (API) para tener acceso a
una base de datos. Usted puede usar declaraciones ODBC para tener acceso a archivos en una gran
cantidad de bases de datos diferentes, incluyendo Access, dBase, DB2, y EXCEL.

ODBC es compatible con la interface estructurada (SQL). SQL administra las reuqisiones de ODBC
convirtiéndolos en peticiones que puede utilizar una base de datos de ODBC .

OPC
OLE para el control de proceso, una interface estándar de la industria que suministra interoperabilidad
entre aparatos diferentes de campo, sistemas de automatización y control y sistemas de negocios. Se base
en ActiveX,  OLE, modelo componente de objeto (COM), y tecnologías distribuidas de COM (DCOM).

Parameter(Parámetro)
Entrada a un objeto, similar a un miembro escribible de datos, cuyo valor se especifica en la lista de
parámetros del objeto en un archivo fuente  de LookoutDirect (lks ).Típicamente, los valores de parámetros
se configuran en la caja de diálog del objeto Object>Create o  Object>Modify.

Ping
Programa utilitario pequeño en Windows y DOS que verifica si una computadora funciona en una red.
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También usado para indicar el funcionamiento de ese programa.

Pixel
Elemento de imagen, el pedazo más pequeño de una figura en la pantalla de una computradora.Tiene un
color o matiz de gris. El número de pixels por pulgada determina la resolución de una imagen.

PLC
Controlador Programable Lógico.

Poll
Un evento de software en el cual una computadora comprueba un cierto valor en un aparato o un registro.
En LookoutDirect, un comando lógico que fuerza una encuesta del aparato para comprobar valores de
miembros de datos.

Poll Rate (tasa de encuesta)
Cuan a menudo es consultado un aparato.

Pop-up panel
Una variedad de panel de control en LookoutDirect que se pueden exhibir solamente en el tamaño
determinado por el programador del proceso, y que no se puede maximizar. Cuando está abierto, un panel
popup permanece encima de otros paneles hasta que sea  minimizado.

Process
En LookoutDirect, proceso se refiere a un "programa" de  LookoutDirect,  utilizado para automatización,
control, supervisión o reportaje de datos industriales.

Process file
El archivo binario de LookoutDirect que se ejecuta al funcionar un proceso.Lleva  la extensión  de .l4p.

Raw unit (unidad cruda)
Datos como llegan a su proceso, tal como voltaje o corriente. Los datos de termopar, por ejemplo, llegan
en milivolt como unidad cruda, y se deben convertir a  grados, una unidad de ingeniería.

Receive gap
La configuración de comunicaciones seriales que determina el número de bytes vacíos (o de la cantidad de
tiempo) que recibe un driver antes de reconocer el extremo de un frame de mensaje y de solicitar otro
mensaje. Vea la sección  Receive Gap del capítulo 3, Comunicaciones seriales, en el Manual de Desarrollo de
LookoutDirect para más información sobre el Receive Gap.

Redundancy
Un sistema para cerciorarse de que un sistema de computadres pueda mantener en línea y hacer funcionar
un proceso de LookoutDirect si la computadora que funciona corrientemente ese proceso falla por una
cierta razón.

Remote
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En el contexto de LookoutDirect, el telecontrol es una localización de la fuente del estado para un control.
Vea la sección Conexiones de fuente de posición remota del capítulo 4, usando LookoutDirect, para más
información detallada sobre este asunto.

Resolution
El incremento más pequeño de una señal que se puede detectar por un sistema de medición. También, el
número de pixels por pulgada en una pantalla del monitor de la computadora o puntos por pulgada en una
impresión de impresora.

RTS
Request to Send (petición de enviar), parte de un protocolo del handshake para ciertos aparatos que
conectan el puerto serial de una computadora. Vea la sección de Configuraciones de handshake de RTS/CTS
del capítulo 3, Comunicaciones Seriales, en el Manual de Desarrollo de LookoutDirect para más información
detallada.

RTU
Unidad de terminal remoto, un aparato similar a un PLC para uso en una localización remota,
comunicándose con un sistema huesped a través de conexiones de radio o telefónicas.

Run Mode 
Modo de LookoutDirect en el cual los procesos funcionan solamente pero no se puede realizar ningúna
modificación. Cambie desde el modo RUN al modoEdit  presionando las teclas <Ctrl-espacio > o
seleccionando en el menú el modo  Edit>Edit Mode.

SCXI
Una línea de productos de condicionamiento de señales de  National Instruments para condicionar señales
de bajo nivel.

Security accounts (cuentas de seguridad)
Cuentas también llamadas de usuario y de grupo, LookoutDirect utiliza cuentas de seguridad para definir
qué usuarios o grupo de usuarios tiene diversos privilegios de operación en LookoutDirect.  Vea el capítulo
6, Seguridad, en el Manual de Desarrollo de LookoutDirect para más información detallada sobre la
seguridad.

Server (servidor)
Un proceso que suministra datos (servicios) a los procesos clientes. En LookoutDirect, los procesos del
servidor debe ser diseñados para funcionar en una computadora solamente, con conexiones directas al
hardware de campo. Los procesos en el cliente operan con hardware de campo a través de procesos del
servidor.

Source file (archivo fuente)
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Archivo de LookoutDirect que se puede compilar para producir un archivo de proceso binario de
LookoutDirect que haga funcionar un proceso. Usa una extensión  de archivo  lks.

SQL
Structured Query language (lenguaje de interrogación estructurado), usado para obtener información
desde y actualizar información en una base de datos.

Standby
Una computadora que está como respaldo para asumir el control del funcionamiento de un proceso si la
computadora primaria falla o cae fuera de línea.

Startup file
Un archivo de proceso de LookoutDirect (l4p) designado en el cuadro de diálogo de System Options
(opciones del sistema) que LookoutDirect abrirá y hará funcionar cada vez que LookoutDirect es abierto.

State file (archivo de estados)
Archivo de LookoutDirect que almacena el valor de todos los parámetros de control y de los miembros de
datos de objetos de LookoutDirect  en uso en un proceso.Utiliza  la extensión  de archivo  l4t.

System Objects
Objetos de LookoutDirect usados para controlar otros objetos o para procesar y para analizar datos.

Trajectoria 
También usado como directorio, es el conjunto de nombres que indican jerárquicamente donde se
encuentra un archivo en la computadora.

TCP
Transmission Control Protocol, un método (protocolo) para enviar datos entre computadoras.Utilizado
con el  Internet Protocol IP,

TCP/IP
TCP/IP envía datos a través  de paquetes, con IP manejando la entrega de los datos y  TCP manteniendo
en vista los paquetes individuales.

Text data member (miembro de datos de texto)
Miembro de datos de LookoutDirect usado para datos de texto.

Trace
Un término para los datos de una sola fuente sobre un cierto período del tiempo, almacenado en una base
de datos ODBC-obediente.

Trace table
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Las bases de datos ODBC presentan datos en forma de “trace tables”(tabla de rastros). Una tabla de
rastros contiene un campo o una columna de datos para cada miembro de datos que es registrado, junto
con un campo que usted puede utilizar para interrogar la base de datos.

Trend (tendencia)
Datos históricos que muestran el cambio de un valor de una señal en un cierto plazo. Usado a menudo en
conexión con la representación gráfica de datos como registrador gráfico virtual.

WAV  (archivo)

Extensión de archivo dada a archivos de sonidos. Usted puede hacer tocar un archivo wav en
LookoutDirect para agregar sonidos o voz a alarmas o a eventos
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¿Ideas? Comentarios? Sugestiones?

Por favor concédanos un poco de su tiempo para saber como podemos servirles mejor. 

Tratamos continuamente de mejorar nuestro servicio, nuestros productos y nuestra documentación. 

Le pedimos enviarnos sus comentarios.

Ud puede devolver este formulario a nuestro correo electrónico

informacion@automationdirect.com

o por fax a                             770-889-7876 en USA

Gracias

Nombre    :…………………………………………………………………………………………………….....

Companía :……………………………………………………………………………………………………….

Dirección :..……………………………………………………………………………………………………...

Ciudad     :……………………………………………………………………………………………………….

Estado      :……………………………………………………………………………………………………….

País          :………..……………………………………………………………………………………………..

Código postal:……………………………………………………………………………………………………

Teléfono   : (incluya códigos del país):………………………………………………………………………...

Fax          :…………………………………………………………………………………………………….….

Correo electrónico………………………………………...……………………………………………………..

¿Que productos ha comprado? .………………………………………………………………………………..

¿ Como obtuvo los productos? Comprado directamente………………………………………………….…..

Parte de una máquina ………………Otra forma:……………………………………………………………...

¿Cuales son sus proveedores para PLCs?....................................……………………….................................

....................................................................................................……………………….................................

¿Cumplió el producto sus  expectativas? ………………………………………………………………………

Si no, ¿que debemos hacer para mejorarlo?..............................………………………..................................

Manuales:

¿Ayudó este manual a usar este producto?.................................……………………….................................

¿Pudo encontrar fácilmente la información?..............................……………………….................................

¿Que podemos hacer para mejorar los manuales…………………………………………………………….

Comentarios generales

…………………………………………………………………………………………………………………….

…………………………………………………………………………………………………………………….

…………………………………………………………………………………………………………………….

…………………………………………………………………………………………………………………….

…………………………………………………………………………………………………………………….

…………………………………………………………………………………………………………………….

…………………………………………………………………………………………………………………….

…………………………………………………………………………………………………………………….

…………………………………………………………………………………………………………………….

…………………………………………………………………………………………………………………….

…………………………………………………………………………………………………………………….

…………………………………………………………………………………………………………………….


